


■■ editorial

It is amazing how quickly computers have moved from 3 MHz to 3 GHz processors.
Yet, in terms of capability they have mostly moved to prettier looking ways of doing
the same old things. 

A computer is your primary filing cabinet, and as the repository and medium of a
large part of your business communication, it must move up to being a better tool to
manage, infer, draw inter-connections and retrieve that information. What are now called
‘Personal Information Management’ software, are like what Notepad is to Word—much
needs to improve. The good news is that the technology for all of this already exists, and
stand-alone tools are currently accomplishing some of these.  But to be truly useful, these
functions must be part of a whole system:

Search: Why does looking for information you know you have on your PC take so much
longer than finding information online? Because your PC isn’t spending any of its idle
time indexing your data. Search technologies to solve this issue have existed for decades,
but it is not something we have expected from our desktops yet. Standalone tools such
as X1 help, and this is likely to be the first task that is integrated well.

Organise: The battle with spam has demonstrated the power of Bayesian processing.
Tools such as Popfile can learn to auto-magically sort your incoming e-mail into as many
categories as you like, based on your feedback. Why do we still need to think about which
folder to save a file in? Just drop it into ‘My Documents’ and it should become part of
your self-organising filing system.

Remember: How often have you realised you know when you have seen some informa-
tion, but you don’t know where? Like a history for browsing, there should be a history for
files and folders usage, for chatting and so on, all accessible in one place—the System
History. Tying a search of all your information repositories—be it e-mail programs, browser
history, or documents—to time, makes for a powerful tool that leads into...

Contextualise: Combine histories through all your communications and documents in a
coordinated manner. Pull up an e-mail and you see what Web pages you were seeing at the
time, what documents were open, a slice of any instant messenger conversations and a list
of all your digital communications with that individual. Sounds like a utopian goal, but the
Ximian ‘Digital Dashboard’ project proposes to do this, and has just released the first bits.

Extend: Going forward, an increasing volume of digital data that we produce and
consume will be rich media—text and audio or video interleaved. Any self-respecting
personal information management system will have to deal with this well. Indexing
sound is a possibility, as is extracting and comparing images to identify and connect the
participants of video-phone conversations or meetings. However, in the realistic nearer
term, this would involve connecting textual data to points in an audio or video clip.
Take a look at this near future with OneNote 2003 SP1.

These five are critical functions that a computer must be able to perform soon, or end
up complicating our work rather than complementing it. 

sumod_hajela@jasubhai.com
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Information
Management’
software, are
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Lookout for the exciting Tech Shack subscription

offer on page 28
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taste technology at www.thinkdigit.com

The end of Uncertainty  
Experience is the best teacher, but
not in technology, until recently.
Find out how a 250-year-old theo-
rem is being employed in today's
systems to make use of the knowl-
edge of the past.

▼▼
▼▼

Banking on technology      
Customers have never had it this
good as banks go all out to woo them.
A look at what Indian banks have
on offer.

Want to brainstorm?
Start a discussion? Share an idea?
Log on to www.thinkdigit.com/forum

SUBSCRIBE

FORUM

BY DEMAND

BigOven 1.3
Size: 7.11 MB
Mindware

Road Trip 2004  
Size: 37 MB
Playware

Expect these on the August 2004 CDs
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productivity. This month, we have smart
tips on Adobe Acrobat, dBpower Amp
music converter, Winamp, Opera and
Open Office. 
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in on all you ever needed to know about
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the latest dough on virus attacks.
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Look for these products on the CDs



Watch out perverts, cops
are patrolling Internet

chat rooms as well now! In
order to crack down on grow-
ing paedophile rings, police
from Britain, the US, Cana-
da and Australia
are forming a
global taskforce.
Web sites with
child pornogra-
phy will have
their finances
confiscated, and buyers of the
disgusting material will have
their credit cards frozen. Of
course, with laws being so var-
ied around the globe, the cops
have to identify themselves. 

They’ll keep an eye on
chat rooms, and a badge
saying ‘Virtual Global Task
Force’ will

identify them to the public.
Will this measure stop the
paedophiles from looking for
prey online? We certainly
hope so, at least someone’s
doing something, right?
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DDuuaallDDiisscc
■■  WWhhaatt  iiss  iitt??
The latest format of Audio-
DVDs, recently approved by
the DVD Forum. It will have
DVD audio on one side and
CD audio on the other.

■■  HHooww  ddooeess  iitt  wwoorrkk??
The disk will be about 1.5 mm
thick. A typical DualDisc would
feature a single-sided DVD and
a thinner CD layer on the flip
side. Right now, a DualDisc is
1.48 mm thick. And the end
result? A DVD with 5.1
surround sound and other
DVD features for high- end
music. The CD side will have
standard music sampled at
44.1 KHz for CD players.

■■  WWhhaatt  ddooeess  iitt  ddoo??
DualDiscs will give music
companies promoting DVD
audio a shot in the arm.
Meanwhile, there will be the
benefit of the flexibility of the
CD format. We are talking
about a DVD that becomes
widely compatible because it
packs in a CD. A DVD by itself
is not as compatible as a CD is.
Music companies will sell this
product as something that has
both CD and DVD, and will
expect substantial demand for
DualDiscs. In the long run,
producers will save quite a bit,
since they won’t have to ship a
DVD along with a CD in a
package. DualDiscs will come
to the rescue of the DVD-Audio
format. However, there are
limitations. The CD side will
have only 60 minutes of audio,
and the DVD side, obviously,
cannot be double- layered.

hypethesis

It’s typical, you’re in a
movie, it’s an intense scene,
you’re hanging onto the

dialogue for dear life, and off
goes a cell phone close by—
arrgh! Certain situations
require a little etiquette, but
some people take matters a
little too far.

Consider the young
woman who was banned
from flying Vietnam
Airways because she
attacked a stewardess
who asked her to stop
talking on her cell
phone. Not only did she
refuse to stop her con-
versation, she also
slapped the flight atten-
dant and threw water
in her face! So can we

expect laws that prevent this
sort of behaviour in India, or
do we get slapped every time
we object to those pesky nui-
sances? Only time will tell.
Write in and tell us what you
think about such situations!

In June 2003, one billion
music files were shared

across the world! This year, the
number is 70 per cent lower.
Why? The International Fed-
eration of the Phonographic
Industry (IFPI) is grinning
from ear to ear, citing its
tougher stance on illegal file
sharing and copyright issues as
the reason for this decline. 

Interestingly, there are
now over 100 Web sites that
you can buy music (read: legal
downloads) from. The IFPI
plans on enforcing the rules
even more strenuously in the
future—so be prepared to see
more lawsuits in the news.
The message is simple: If you
want to sing along to your
favourite tunes, cough up the
dough first!

■ Red Hat India launches Red Hat Desktop V3 in India ■  Munich's Rathaus (City Hall) migrates 16,000 desktop PCs to the Linux operating system

Of cell phones,
slaps and airplanes

➜

Cops on e-beat

The land of really clean
roads may now become the

land of really clean e-mail
boxes! If the Singapore govern-
ment has its way, that is. As
with littering the roads, the
government will impose a fine
on spammers that litter mail-
boxes. Fed up of blocking
spammers, Singapore has
decided to fine them between
10 cents and one Singapore
dollar (approximately Rs 3 to
Rs 26) per spam e-mail.

Will this deter spammers
from setting up shop in Singa-
pore? We hope so, provided
you can track these spammers!
Let’s wait till January 2005,
when this Act comes into force,
and see.

Fine that
spam!

Cough, then sing
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W32.Korgo.F
With a threat level rated at 3
by Symantec Security
Response, this virus is a
variant of the W32.Kargo.E
virus. It’s designed to exploit
the Windows LSASS Buffer
Overrun Vulnerability on TCP
port 445. Additionally, it’s
programmed to listen on
ports 113, 3067 and other
random ports. It does not
delete or modify files, but
may cause network
performance degradation due
to the increased traffic it
causes. It opens a backdoor,
compromising system and
data security. The infected PC
scans random IPs for a
vulnerable computer. On
finding one, it opens a
random port and attempts to
connect to it. After infecting,
it connects to one of the pre-
defined IRC servers on TCP
port 6667. Microsoft
describes the problem in
Microsoft Security Bulletin
MS04-011. An easy way out is
to use Windows Update to
install available patches.

Opera Favicon
Spoof
There’s a vulnerability in all
Opera browsers below v7.51,
by which visitors to a fake
Web site can be made to
believe they’re at another site.
This is because Opera does
not check the width of the
Favourites icon. A carefully
designed icon can cover the
address bar with custom
information, confusing and
perhaps misleading users.

redalert

May 2004 Spam Category Data

Top Ten Viruses of May 2004 out of 
5.7 billion analysed

Statattack

■ Japanese professor makes robot designed to help people with weakened leg muscles walk properly  ■ British courts to implement WiFi in all courtrooms

19.5%: India’s IT
spending growth
in 2004

snapshot

Source: Reuters

The number of US
services jobs
that will go 
offshore will
increase from
2.2 lakh in 2003
to 17.5 lakh in 2011
to 35 lakh in
2015.

Source:  Forrester Research, June 2004

The gender gap extends to
segregate mobile users,

too. According to the Mobile
Media Monitor survey by
Enpocket, a US-based mobile
marketing services provider,
it was found that 58 per cent
of all games downloaded to
mobiles are by males.
Women, on the other hand,
account for over half the
r ing tone s
d o w n -

loaded. As expected, over 65
per cent of 3G service users
are men. All that money
spent, all those statistics, and
we’re told what we already
know…men and women like
different things! Let’s move
on already!

A question of gender

You may soon need to pay
for online dating. The US

patent office has awarded dat-
ing company eHarmony a
patent covering online match-
making. Patent number
6,735,568 describes a comput-
er-implemented method for
“identifying people who are
likely to have a successful rela-
tionship”. In simple English,
this means that eHarmony
now owns the patent for 430
psychometric tests which con-
tain questions such as “How
much does the word ‘domi-
nant’ describe you on a list of
one through seven?” or “How
often do you feel depressed?”. 

Is love so trivial that your
answer to a few questions
can tell a computer whether
your significant other is right
for you or not?

Pay for love

➜

snapshot
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■  Napster giving away digital music players free with one-year subscription  ■  Nokia rejoins WiMAX forum; will concentrate on 802.11 and 3G instead of 802.16

heroes

HMV
HMV, the popular UK music
retailer, has begun selling
iPod players on the music
downloads section of its
site. HMV does not have a
tie-up with Apple.
However, there’s nothing
funny or surprising about
the fact that HMV is selling
iPods. What is funny is 
that the iPod cannot play
tracks downloaded from
HMV’s site!  

Tablet PCs
Tablet PCs, much-hyped,
have enjoyed only limited
success so far, and only in
specific market segments.
This is according to a new
report from In-Stat/MDR.
And research firm IDC says
that sales will go up from
500,000 in 2003 to 1
million this year, but that’s
only 0.5 per cent of the PC
market. One reason could
be—you guessed it—
current pricing.

zeroes

➜

Gmail
Everyone’s talking about
Gmail! Gmail invites are
being auctioned online.
Software such as Gmail
Loader, and Pop Goes the
Gmail have come up.
Gmail has also forced many
e-mail service providers to
expand their storage.

Anti-spyware
Legislation
A US House sub-committee
recently approved what is
an anti-spyware bill. The bill
would allow for fines of up
to $3 million for redirecting
users’ browsers, gathering
users’ personal information,
and displaying certain kinds
of pop-up ads on users’
computer screens, without
their knowledge or consent.

That is exactly what contestants in the SEO
(Search Engine Optimization) Challenge, car-

ried online via SearchGuild.com, were told to do.
Contestants had to increase their Google ranking
for the search term ‘nigritude ultramarine’.

Basically in Latin, this means ‘dark blue’,
which comes from one of the co-sponsors-Dark-
Blue, an Australian marketing company. “The
competition really gives the opportunity to
stand back and say this is what one engine does
badly and another does better,” said Chris Rid-
ings, owner of SearchGuild.com, the other co-
sponsor, in an interview to Wired.com. The

contestants were allowed any means, even
underhanded ones, to improve rankings. 

“If the point of the competition is to prove
which methods work and don’t work, then it’s
silly to place rules that say you can’t use such
and such a technique,” Ridings reckoned. “If
they really can’t use it then the assumption is
that Google would boot them out of the index,
so they wouldn’t win.”

The first round-winner was Brandon Suit,
an online community owner. Phillip Lenssen,
a blogger who writes about Google, was
placed second. 

Outsmart Google?

The Californian state senate
voted 24 to eight for a bill

to introduce safeguards to pro-
tect users from prying e-mail
services that scan mailboxes to
display advertisements. 

Though Gmail, Google’s
somewhat controversial e-mail
service, wasn’t specifically
mentioned, it’s pretty obvious
which ‘prying e-mail service’
the senate was voting against.

Drafted by Senator Liz

Figueroa, it allows e-mail
providers to go through mes-
sage text for advertising, spam
and malicious code, but bars
them from leaking this infor-
mation to third parties, or let-
ting their staff take a peek into
e-mails without consent.

The State Assembly still
needs to pass the bill before it
becomes a law, but we’re more
interested in how Google will
circumvent this setback.

Gmail in trouble

Linus accused of code-lifting
So did Linus Torvalds really

create the Linux kernel, or
was it actually Andrew Tanen-
baum’s baby? That’s the ques-
tion circulating the globe.

A 92-page booklet by a 12-
man think tank called the
Alexis de Tocqueville Institu-
tion in Washington DC, sug-
gests that most of the credit
given to Linux actually belongs
to MINIX, a UNIX-like operat-
ing system designed by Tanen-
baum. Tanenbaum is a profes-
sor of Computer Science at
Vrije University, Amsterdam.

The argument: If it took
Tanenbaum three years to
develop MINIX, despite years of
experience with OSes and
software development, how
could Torvalds, a student
with limited knowledge,
develop Linux in six months?

Both Tanenbaum and Tor-
valds contest the claims of the
study. Tanenbaum has called
Ken Brown, the president of
Alexis Foundation “extremely
evasive”, on his home page
( h t t p : / / w w w . c s . v u . n l /
~ast/brown). He thinks it pos-
sible that the Alexis Founda-
tion might be funded by ele-
ments seeking to discredit
Linux and its recent growth.

Our favourite extract from
his home page is, “But the code
was his (Torvalds'). The proof

of this is that he messed the
design up.”

You’re given a Pentium II
running GNU Linux, and

asked to put it to good use.
What’s the best thing you can
do with it? How’s this: You cre-
ate a Personal Satellite Assistant

(PSA) that will remind space sci-
entists of the correct procedure
during experiments, warning
them about the dangers, and
keeping track of the day’s jobs. 

No, this isn’t fiction, a pro-
totype PSA has been developed
by NASA’s Ames Research Cen-
ter. It took six years to do it, but
the prototype has environmen-
tal sensors that chack for oxygen
and temperature levels; its
onboard camera makes telecon-
ferencing possible with mission
control, it conveys experiment
procedures via an inbuilt LCD
panel and speaker.

Trust NASA to come up with
a good use for all those old Pen-
tium IIs lying about. Of course
it remains to be seen whether
this revolutionary development
will ever be used, or, as with a
lot of NASA’s projects, be
shelved for ‘later’ use.

Intel, Linux
and space
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■ Seagate launches 0.5 TB enterprise hard drive ■ Intel announces six new 775-pin Pentium 4 processors—from 2.8 GHz to 3.4 GHz EE

No-No to ‘Do-Not-
Spam’ 
The US Federal Trade
Commission (FTC) recently
submitted a report against
the ‘Do not e-mail’ registry
creation proposal. This
registry was intended for
spammers to stay clear of e-
mail domains of certain
participating members. The
FTC opposes the list since it
feels that the list will, in
fact, be used by spammers
to get hold of new e-mail
domains and IDs.

Spam

➜

This could be a great boost
to efforts of plugging

Internet security holes:
Yahoo! has decided to inte-
grate software into its toolbar
that will detect spyware and
malicious files or code.

The new Yahoo! toolbar
was released on 27 May,
2004—though in a test stage.
Yahoo! will evaluate user
responses to the technology,
developed by anti-spyware
company PestPatrol. It offered
the toolbar as an upgrade to
select users at http://beta.tool-
bar. yahoo.com.

The software performs a
high-level scan of a user’s sys-
tem to detect viruses and
other malicious code used to
spy on computer behaviour.
This step comes after Yahoo!
proposed the use of Bayesian
filters to check spam.

Yahoo! isn’t alone; Inter-
net Service provider EarthLink
recently introduced anti-spy-
ware technology for its sub-
scribers. Last month, Google
appealed to software pro-
grammers to use clear-cut
methods to distinguish soft-
ware that were meant to be
embedded in a user’s PC. 

They pushed for stan-
dardised rules for such pro-
grammes, and stated that
they should contain features
that would make them iden-
tifiable, provide the user
freedom to uninstall them,
and above all, ensure that
they do not leak personal
information.

A big round of applause for
all companies involved in
anti-spyware programmes!
We all want our privacy, and
finally someone is doing
something to protect us from
the big bad Internet

Yahoo!
embraces
anti-spyware

1 in 20 Britons

plans to get his
or her next
tech gadget
by insurance

fraud

snapshot

Source: silicon.com, April 2004

Your laptop makes you
look smug and profes-

sional, but it can also ruin
you or your company if you
aren’t careful. 

As part of a study, Pointsec
Mobile Technologies—a
Stockholm-based mobile

security special-

ist firm—bought 100 laptops
at Internet public auctions in
Stockholm. It set a technol-
ogy team to work on them,
and was able to recover sensi-

tive data from 70 of them.
This sensitive data included
pension plans, payroll records
and even administration
passwords for Intranet sites.

It was obvious that the
hard drives weren’t wiped
clean, though companies
usually do that before

auctioning old machines.
The company had

similar results in tests
run in the US, Germany
and Sweden. They claim

that a laptop from a
Swedish auction had all

the necessary data
needed to blackmail a
large food manufac-
turer. 

“ P o i n t s e c ’ s
research demonstrates

just how easy it is to
access information which is
not adequately protected,”
said Tony Neate from
Britain’s National Hi-Tech
Crime Squad, in an interview
to Reuters.

Lapping up secrets

Asignificant stride forward
in nanotechnology! A

team of German and US scien-
tists have created a single-elec-
tron transistor with a
gold-tipped, vibrating silicon
arm, which is 200 nanometers
long and a few tens of
nanometers across. The device
is of special interest to theo-
retical physicists for quite a
few reasons. Firstly, it is fairly
easy to manufacture. Second,
it can operate on AC voltage.
Third, it operates without
cryogenic cooling—which can
only be achieved under special
conditions using liquid Nitro-
gen at very low temperatures. 

The device was created by
Dominik Scheible at the
Ludwig-Maximilians Univer-
sity in Munich, and Robert
Blick at the University of
Wisconsin-Madison. They set
it up so that the gold tip of
the arm sits between two
electrodes-such systems, typi-
cally, operate in strong
magnetic fields.

This breakthrough puts to
rest the fears that a report by
the European Commission
created, about nanotechnol-
ogy research lagging in the
continent due to lack of fund-
ing. Perhaps this will finally
get the Euros flooding in!

Room-temperature 
nanotransistors

A study by Sandvine, a net-
work management firm,
cross referenced with Sender-
Base Email Reputation Ser-
vice, says that more than 80
per cent of spam originates
from unsuspecting systems
infected with Trojan horses
or worms. Popular backdoor
worms that accomplish this
are Migmaf and SoBig. Sand-
vine’s technology traced
home networks which were
bypassing their home e-mail
servers and using multiple
foreign mail servers within a
short span of time, thereby
indicating infection.
The study says the recent
wide-angled flood attacks of
MyDoom and Bagle were
aimed at installing spamming
Trojans on home computers.

Zombie PCs relay
the most spam
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“We are targeting
more PC
penetration and
bringing cyber
connectivity to
every citizen.”

“The 3G standard
has been evolved
but has not proved
cost-effective.”

Dayanidhi Maran, India’s
new Information
Technology minister,
referring to his aim of
switching India from the
3G to the 4G standard.

“Offshoring hasn’t
eaten jobs. It is the
dumbest argument
ever put out,
simply because it
is election time.”

Jack Welch, retired Chief
Executive, General Electric,
ridiculing suggestions that
the weak jobs market in the
US is a result of the
movement of jobs abroad.
He blamed politics for the
recent backlash against
offshoring.

“The report was
purely a
speculation.
The company
does not have
any current plans
of setting up a
chip fabrication
plant in India.”

Varghese M. Thomas,
Intel India spokesman,
responding to reports of
Intel setting up a chip
manufacturing facility in
Chennai.

quoteworthy

ASANP or Automatic
Switching of Network

Access Points is the latest
technology for mobile
phones. It allows a mobile
device to switch automati-
cally between a GSM Mobile
network and a WLAN, with-
out the user noticing it. The
new technology increases the
current bandwidth of 9.6
Kbps for wireless networks to
11 Mbps. 

ASANP facilitates voice,
data and real-time video
conferencing services. Once
the technology is imple-
mented, all Internet-ready
devices will work on a cellu-
lar network or a wireless
LAN. This would include
802.11b and Bluetooth.

An amazing feature of
ASANP is that it will enable
companies to locate its users.

A user can also be tracked
from the IP address of the
Wireless device’s connection
point. WLAN owners will
enable them to utilise WiFi
bandwidth that earlier
remained untapped.

This technology will weed
out several limitations
imposed by some of today’s
mobile networks. Upgrading
the bandwidth of existing
networks  would call for mas-
sive costs. If WiFi networks
are tapped, there’s much
more bandwidth to be had.
With higher bandwidth,
today’s voice applications are
set to get a major boost. US-
based Calypso Wireless is
promoting this technology.
It might take shorter than we
think for mobile phone mak-
ers to come up with handsets
with ASANP embedded.

ASANP

■  British Technology Group (BTG) claims software firms should pay royalties for delivering software via the Web—they own six patents involving software downloads

There are now
980 million
active e-mail
accounts around the

world, and 40
per cent of those are

corporate
accounts.

Source:The Radicati Group, Inc.

tomorrow’s technology

Who needs
a camera 
anyway? No there isn’t a war on; but

North Korea has just
banned the use of mobile
phones in the country. It was
only in 2002 that mobile
phones were introduced, and
until a few weeks ago, foreign
tourists were permitted to

carry them. The official reason
cited is the recent train explo-
sion in North Korea, but judg-
ing by the country’s track
record, one is more inclined to
believe that this is just anoth-
er excuse to control the dis-
semination of information.

North Korea immobilised

The latest camera phones
could kill the digital cam-

era market! It could happen!
With Casio now offering a 3.2
megapixel camera phone, and
almost all other brands-LG,
Samsung, etc., offering 2 or 3
megapixel camera phones,
who needs a standalone cam-
era? Not unless you’re a pro-
fessional photographer!

Camera phones sales have
shot up from 84 million in
2002, to almost five times
that in 2004. Of course not
everyone agrees: Casio
spokesman, Toshihiro Watan-
abe said, “A mobile phone is
meant to be carried with you
all the time, and its main pur-
pose is not taking pictures.
It’s more for if you want to
take a picture as a quick
memo of something, or if you
just happen to come across a
shutter chance.”

Others also argue that
camera phones don’t have
the features of a good digital
camera—storage capacity,
anti-shake protection, CCD,
etc. We agree, camera phones
just can’t match up to a good
digital camera…yet!

snapshot
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Showing Off Trends

Afew days into our Taipei visit, a fellow journalist com-
mented that Taiwan’s handloom industry must be LCD
panels. Tongue-in-cheek for sure, but there is an element

of truth in that statement. LCDs are everywhere, and in every
form. Consider a cab we hired—it had an LCD TV nestling just
above the gearbox and blaring news in Mandarin, while the rear-
view mirror sported a mini-LCD panel which served as a com-
pass. This was in a cab!

Early into our visit, we learned that Taiwan acts as a manufac-
turing hub for the IT industry. Almost everything electronic under
the sun is made between Taiwan and China. Taking the LCDs as
an example, AUO, the third largest manufacturer of the panels,
took us around its assembly plant. In went their LCD panels, and
out came Thompson LCD TVs and Dell LCD monitors.

It was no surprise that Computex 2004 is a business-to-busi-
ness show; a place for company X to show off its manufacturing
capability to OEM Y, and gain a contract to build its branded
system or to use its parts. Computex was all about components—
everything from microdrives to PC cabinets. Though there were
some finished products, they were few and far between.

The show did serve to highlight trends within the industry.
The biggest being convergence, and the oft-repeated mantra of
the digital home. It seems more obvious with each passing event,
that the PC is not going to be sidelined by consumer devices.
Indeed, WenChi Chen, VIA Technologies’ President and CEO,

was of the opinion that key PC technologies would migrate into
the heart of everything consumable—TVs, personal recorders
and handheld devices. Some of this was apparent: USB connected
plush toys which moonlighted as MP3 players, portable MPEG4
video players with microdrives, telephones with wireless LAN
support (802.11a/b/g); some sporting CCD cameras and TFT
LCDs for video-conferencing, LCD TVs which doubled up as
monitors; an MP3 player with a photo viewer that is also an
MPEG4 player with TV output, and a card reader and a bootable
drive as well—try saying that in one breath. Also, if Taipei and
the show serve as an indication, cameras—both still and video—
will soon be everywhere. Everywhere!

The concept of the digital home was also more grounded at
Computex. There were no refrigerators with built-in computers,
instead computers posed as various consumer devices. Promi-
nent amongst these were the media centers.

Small Form Factor (SFF) PCs are in-the mini-ITX motherboards,
and low-power processors make for tiny, but sufficiently powerful
PCs. Prominent amongst the SFF solutions was the MSI MEGA
180—a small cube, resembling a music deck from the pre-MP3 era-
dials and little buttons to push on its face, and the coolest colour-
LCD display with dancing lights. Oh, sweet nostalgia!

As a consumer device, it supports instant-on CD/Radio and
MP3 playback with 5.1-channel sound, powered by nVidia’s
nForce2 chipset. As a computer, it has inbuilt Wi-Fi (802.11b), an
Ethernet port, a 56K modem, dual-VGA out, two USB 2.0 ports,
two Firewire ports, a six-in-one media card reader, and the much-
salivated-after nVidia Soundstorm-Dolby Digital capable. All this
powered by an AMD Athlon XP 3000+ processor, two DIMM slots
upgradeable to 2.0 GB of DDR 333, 1 AGP 8X slot and 1 PCI slot.
The optional TV-tuner card allows for all the standard PVR func-

Digit visited Taipei, Taiwan, to attend the Computex Taipei 2004

exhibition. The biggest brands, the best products, read all

about it here...

The Revolution is a laptop that swivels into a Tablet PC, powered by an
Intel PIII processor. What sets it apart from similar solutions is a rugged
industrial design with a classy magnesium chassis and C-Span construc-
tion to protect the interior against shocks

With an 8.4-inch TFT LCD and an Intel XScale 400 MHz processor, the Weblet
offers around eight hours of normal usage and up to two weeks on standby
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tions of time-shifting, scheduled recording of programmes,
channel preview, etc. 

This unit can sit in your living room, posing as a music
system, as the heart of a powerful computer beats within.

Other systems towed VIA, Transmeta or Intel
processors. Speaking of AMD-based SFF, meet the
IWILL ZMAXdp. This little-behemoth has dual, (that’s
two!) Opterons, supported by nVidia’s nForce 3 chipset.
Designed with audio and video professionals in mind,
the 64-bit support offered by the AMD Opteron goes a
long way in alleviating file-size limits, the mini-rig
includes a proprietary form-factor motherboard, dual
3.5-inch hard disk bays, which can be arranged in RAID
0/1/0+1 configurations, and an AGP and a PCI slot.
Dear Microsoft; hurry up with the 64-bit Windows XP.

AMD, thus, had reason to be gung-ho about things, as the com-
pany’s Executive Vice President Dirk Meyer (from the Computation
Products Group) firmly planted the x86 flag on IT grounds and spoke
of AMD supremacy. “The x86 architecture is the only architecture

the world will ever need,” he boldly stated, further pre-
dicting that AMD64 will be ‘the’ standard for

the convergence wave. He
went on to add that
IBM’s Power archi-
tecture will die a
lonely death in a few
years. The thrust of
his statement
emerged from a point

of view that the x86 ISA is good enough and that the industry does
not need anything new. He backed it with a slide showing a
microphoto of an Opteron die with real-estate marked out: two per

cent of which was marked “x86 overhead” (the ISA),
40 per cent of the land was grabbed by the L2 cache,
nine per cent by the Northbridge and HyperTrans-
port, etc. Thus, he said, ISAs do not occupy much
space, and the industry ought to leave well-enough
alone. Keeping in mind IBM’s and Sony’s plans to
bring the Cell processor (which, hype assures us, can
do everything) to PC-like workstations; Meyer’s pre-
dictions seem all the more interesting.

Another thing the show brought to the fore was
the long-awaited death of legacy standards and
ports, and the emergence of technologies that aim

to level the playing field. USB, Firewire and SATA are rising stars—
especially the first two. PCI Express (PCI-E) is here, and to stay
with VIA predicting dominance of the same by next year—bye-
bye AGP, your lack of data bandwidth will not b e missed. AMD
should be moving to DDR2 in 2005. DirectX 9 has brought a stan-
dard API to the table, which everyone—ATi, nVidia, VIA and SIS—
can design products to, thus ensuring competition and better
products and prices. A word on chipsets: the PT890 will be VIA’s
first PCI-E chipset for the Intel platform, which will be followed
by the K8T890 for AMD processors. Also on the horizon are inte-
grated chipsets from VIA—the K8M890 will feature both DirectX
9 graphics and PCI-E support. Moreover, VIA promises that its
mobile chipsets will make a move over to the 0.15 micron process
(from the 0.22 micron), will support clock-speed throttling and
will draw less power at 1.2 V.

Convergence, small and sleek computers, better standards,
healthier competition—these were some of our favourite things
that Computex 2004 promised in the months to come.

AHMED SHAIKH

ahmed_shaikh@thinkdigit.com

The IWILL ZMAXdp is an
SFF PC with dual AMD
Opteron chips supported
by an nForce 3 chipset

AMD displayed its firm belief in the x86 architecture at the Taipei technology extravanganza.
Shown here is its Opteron die that just has a 2 per cent “x86” overhead 

16th century Por-
tugese sailors called
Taiwan Ilha For-
mosa—the beauti-
ful island. The capi-
tal Taipei, where
Computex 2004
was held, is built
upon a basin that
used to be a lake.

The x86 architecture
is the only architecture the
world will ever need“
DIRK MEYER, Executive Vice President,
AMD “



After its initial launch in the
North, Usha Shriram

Electronics offers the Lexus
range of cell phones to people
looking for a competitively
priced unit with a user-friendly
menu and loaded with features.
The six current models are

entry levels in their respective segments.
The basic entry level phone, model 210B,
sports a blue LCD, polyphonic ringtones,
speaker phone and cell info. All Lexus

handsets are light-weight, with phone
memory, speed dialing, multiple alarms,
ergonomical design, attractive colours,
two-year warranty and one-year theft
insurance. The company wants to
maintain the long-standing market
reputation and offers its customers value-
for-money products & reliability.

Get LEX-Appeal 
Feature-loaded Phones
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Moving and storing data
have never been so easy

before! Introducing the world's
first revolutionary portable
solid drive that is smaller than
your thumb, with a storage
capacity of a whopping 1GB!!!!
Silicon Impex, leading
distributors of Genuine
Simmtronics Memories and
Thumb Drives, introduces, for
the first time in India, the
revolutionary 1 GB Memory

Plug and Play Thumb drive with
incomparable 5Mb/sec data transfer
speeds. Supporting almost all OSes and

compatible with USB 2.0 specifications,
this P&P drive supports File/Drive
Compression and contains Password Lock
software & Secure Zoning Software with
the Drive available in CD, to keep your
precious data secure. It includes a
carrying strap and a 12-inch USB
extension cable. With low Power
Consumption of 70mA maximum for
read and write operations, it comes with a
2-year warranty. Also available in 64Mb,
128Mb, 256Mb and 512Mb variants.

Contact: Ashish Singhal, Silicon Impex.
Phone: 011-51618247
E-mail: a_silicon@rediffmail.com
Web site: www.simmtronicsmemory.com

Contact: Mr Ajay Sharma, Usha shriram 
electronics
Price: Rs 3,200 on model 210B to Rs.
5500 on model 761B
Address: 203,Kirti Deep commercial com-
plex, nangal raya, New Delhi 110046
e-mail: ajay@ushaindia.com
Web site: www.ushamobiles.com

Silicon Impex’s 1 GB Thumb Drive
Small is Big

New ArrivalsNew Arrivals

HCL Beanstalk Neo
HCL has launched a range of products,
the Neo,a high-end "digital
entertainment system" priced at Rs
99,990, a new-look Beanstalk PC
(prices starting at Rs 31,000 going up
to Rs 46,000), and the Beanstalk MP3
player for which the price and other
details are yet to be announced.
Contact:  HCL Infosystems
Phone: 011-914-520977/6518 
E-mmail:    satinder@hclinsol.com                

Zebra XML-Enabled
Thermal Printer 
Fast and simple integration of on-
demand bar code label printing is now
available for manufacturing and supply
chain system applications, following
the launch of a new printer range from
Zebra Technologies. The new
Extensible Markup Language (XML)
enabled XiIIIPlus high performance
printers from global barcoding
specialist Zebra, have been designed
to meet the increasing demand from
customers for more flexible
information identification when openly
exchanging data.  
Contact: Vasudha Jha 
24th June Public Relations
Phone: 022 28200269 
E-mmail:  24thjune@satyam.net.in

UMAX ASTRA 4100
scanner 
UMAX has unveiled the Astra 4100, the
first-of-its-kind high resolution, multi-
featured scanner for the home user &
SME, in the Indian market. Powered with
1200x2400 dpi optical actual resolution,
Astra 4100 is a high-speed scanner
available in the market with 6 sec preview
and at an unbelievably attractive price.
The product is exclusively distributed by
Neoteric Informatique Pvt. Ltd. and is
available through its distribution network
all across India.
Contact: Rajesh Thadani, Neoteric
Infomatique Pvt. Ltd.
Phone:  91-22-24172600 
E-mmail: trajesh@neoteric.co.in

‘New Arrivals’ is an advertiser-sponsored section that showcases the latest launches in the Indian market. 
All product specifications featured here have been obtained from the contacts listed, but have not been verified by

the Digit Test Centre. You can look forward to reviews of some of these products in our Test Drive section soon.

Xpress Computers, has unveiled its
new range of notebooks. The models

launched are 1200, 2100, 2300 and 2350.
Built under Intel's Built-to-order (BTO)
notebook program, these would come
with a one year carry in warranty
available through Intel Premier providers
available in 14 cities across India. All the
machines would be available with a
standard configuration, plus the option

to change any component required by
the user. Key specifications are processors
ranging from mobile Celeron, mobile
Pentium 4 and Centrino with DVD or
DVD/CD Writer combo, and a screen
option of either a 14.1 or 15-inch.

Contact: Xpress Computers Ltd
Phone: 022-23852070
Mobile: 9820139132

Xpress launches new range of notebooks
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We have seen
the PC evolve

from the humble
486 running basic
tasks to today's
mean machines
nearing the
capabilities of a

flight simulator. Miraculously the vintage
computer tables designed in the 486 era
managed to survive, just as that
wonderfully unreliable storage device, the
floppy disk did. Well no more—Antidesk
brings respite, at least with regard to the
computer furniture. Antidesk computer
trolleys are designed around the user, for
maximum comfort in minimum space.
The difference begins right from the
material of construction and goes on to
the way they are transported-in a handy
box, small enough to be carried on a bike.
The all-steel trolleys are not just colorfully
attractive, sturdy and durable. They also

are completely insulated (well above
1,000 volts) by powder coating. Not to
mention the trees that are saved. What
started as an eco-friendly alternative in
the USA is now becoming a benchmark in
computer cart design. Antidesk offers
ergonomic design varieties, from ultra
compact carts with a footprint as small as
20"x20" to more spacious options with
leg-stretching space. Several add-on
options are available to accommodate a
variety of peripherals. Shown here is
model Indicart, featuring a tangle-free
cable management system, spacious
keyboard & mouse, along with a writing
surface, good leg room, and castor wheels
for easy movement.

The popular MMOG (Massively
Multiplayer Online Game), Ragnarok

Online, has just gone wilder here by
localising in India. India Ragnarok
Online (inRO,www.ragnarok. co.in) will
open up, for free, open beta service this
summer. Now, you can adventure with
thousands of enthusiasts from all over
the country, in real-time. InRO joins 10
other countries that have localised this
fantasy role-playing game (RPG). You
have the luxury to choose from over a
dozen different job classes, including
swordsman, archer, mage, thief, acolyte
or merchant. Level up to access higher
character classes. Explore over 150
different maps. Find out all about inRO

in our online game guide. Grab the
chance to be one of the first to explore
inRO by creating a FREE account today!
To get a FREE CD sent to you, simply e-
mail a request, with your home address,
to freecd@level-up-games.co.in.

Ragnarok Online starts beta service in India 

Contact: Smartware 
Phone: 9822447414 / 9822057620
Price: Rs 2,500 (without accessories )
E-mail: sales@antidesk.com
Web site: www.antidesk.com 

Printronix, a leading integrated
supply-chain printing solutions

manufacturer, has launched an addition
to its line matrix printer family—the

Zero Tear pedestal printers.
The model (P5000ZT)
allows users to print from
the first to the last line on
every form and then tear it
off without losing any
forms in between. Built on
Printronix System
Architecture (PSA) platform,

Zero Tear printers are compatible with all
current Printronix line matrix (P5000)
applications and support a wide range of
connectivity options. The models give
users remote diagnosis and repair,
instant alerts for consumable outages
and troubled printing, and total
enterprise quality and consistency
through mass configuration.

Zero Tear line matrix printer from Printronix

Contact: Liaquat Ali Khan
Phone: 022-26733423
E-mail: lkhan@printronix.com

SEAGATE UNVEILS NEW
PORTABLE AND POCKET
EXTERNAL DRIVES

Seagate announced its line of
personal computing hard drives,
unveiling new internal and external
hard drives with 400GB capacities, a
new small footprint portable external
hard drive with up to 100GB capacity
and the world's first pocket external
hard drive. Built on the most
advanced hard drive technology
platforms in the industry, each new
hard drive is designed to make data
storage, backup and transfer more
reliable and easier than ever to meet
a variety of consumers' personal
computing needs.

The new Barracuda 7200.8 disc
drive offers PC makers and
consumers the industry's highest
areal density with 400GB on a three-
disc platform. The new Seagate
USB2 Pocket Hard Drive is the first
tiny USB-compatible 5GB drive
consumers can pop in their pocket or
backpack to carry data wherever
they go, thanks to its tough-but-cute
hard case.

Contact: Melcole Public Relation.
S.Jena, 022 28268337/38,
melcole@vsnl.in

For  any  new  product  announcements
in  this  section,  vendors  /
manufacturers  can  get  in  touch  with

BANGALORE: Bibhor Srivastava, 
E-mmail:
bibhor_srivastava@ jasubhai.com, 
Phone:  5325670/88, 37629285 
CHENNAI: Sahayaraj Prabhu, 
E-mmail:
prabhu_sahayaraj@ jasubhai.com, 
Phone: 28235186/89, 33629282 
KOLKATA: Jayanta
Bhattacharyya, 
E-mmail: jayanta_bhattacharyya@
jasubhai.com, 
Phone: 22345100, 33629284 
MUMBAI: Saurabh Pandey, 
E-mmail:
saurabh_pandey@ jasubhai.com, 
Phone: 56310515/14, 33629278 
NEW  DELHI: Arvind Prabhakar, 
E-mmail:
arvind_prabhakar@ jasubhai.com, 
Phone: 51608658/59, 33629279 
PUNE:  Vinayak Inamdar, 
E-mmail:
vinayak_inamdar@ jasubhai.com, 
Phone: 24482059
SECUNDERABAD: Vinayak
Inamdar, 
E-mmail:  vinayak_inamdar@
jasubhai.com, 
Phone: 55221051, 3362980

Sponsored Product Annoucements

Antidesk: Evolution of the humble desk    

E-mail: freecd@level-up-games.co.in
Web site: www.ragnarok. co.in



Logging blues
I logged on to your Web site, but was
unable to locate the insertion box for
the 16-digit code, as printed on page
73 of your June 2004 issue. I'm a
subscriber, and I’m 78 years old! (year
of birth 1926), but the drop down only
starts from the year 1940. I get an
“invalid user name or pass word” error.  

Would you be kind enough to tell
me what to do?

Best regards,
Fakir Hyderabadwalla
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Your vote counts
E-paper         

10.5%
8.0%

67.6%

8.4% 
Bayesian

Spam Filters 
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Which of these five technologies do you think will make it big in the next
12 months?

Dear Mr Hyderabadwalla,

Our apologies for the oversight. The

site has been fixed, and you should be able

to log in now.

Patron payback
I have signed up for your great
Digit Patron offer, and it rocks.
Keep up the good work and
keep the goodies coming! Oh,
can you please include a section
which includes the latest prices
of the latest hardware available
in the market.
Thanks a lot and keep smiling.
Abhijeet Maity  

I want to know all the details
about this nice program and
the logic behind it. I ama bit
unsure about certain details. 
With regards,
Nisar Ahmad

Thanks for the e-
mail about the
patron program.
It certainly
seems like a
great way to
reward loyal Digit
readers like me.
However, I live in
Kathmandu,
Nepal. Will I be
eligible to
participate? Your
answer will be
greatly appreciated.
Thanks and keep
up the 
good work.
Madhur Grover

Computer
Convergence

P2PVOIP

Popular e-mail services are providing up to 2 GB of storage
space. What do you plan to store in so much space?

E-mails Software applications
MP3s Nothing, I just want to be cool and 
Data backups own GBs of space

This month’s question...

Log on to w w w.thinkdigit.com and vote

Your idea of giving the entire archive of
Digit magazine in one CD was an amazing
idea for the anniversary issue. You have
delivered your readers from the dilemma

of maintaining their personal Digit
library—until now it was a case of “Can’t
live with the old Digit copies, can’t live
without them, too”.

My aim was to keep all the issues, how-
ever space was becoming a dire problem.

Thanks to your idea, we now have it all
stored on a CD.

I believe Digit can owe its success to the
team’s innovative ideas and generous give-

aways. From CDs and archives,
and a movie (Disney’s Ice Age with
the December 2003 issue) to the
1001 Tech Facts booklet—it’s stuff
like this that makes you Haute!
Yuvan

My family and I have been reading
Digit for the last 18 months; 12 of
which have been as a loyal sub-
scriber. It’s taken for granted by my
family that every issue of Digit is
packed with the kind of informa-

tion that no other Indian magazine has—
technologies, products, market informa-
tion, people, the works. Add to that the
CDs you give free with every issue, and
they become the icing on the cake. 

I just have to tell you that the CDs that

accompanied the June 2004 issue were
amazing. Even the 1001 Amazing Tech
Facts booklet was a timely one, not to
mention exhaustive. 

The presentation of all 36 issues in one
CD was superb, and was compiled beauti-
fully with great navigation. I have decided
to renew my subscription to this magazine. 
A C Mathur

The moment I laid my eyes on the June
issue, I felt a billion volts of electricity
coursing through me. Did I mention that
Preity Zinta is my favourite actress! To see
her on the cover of my favourite technol-
ogy magazine cover was a once-in-a-life-
time “Feel Good” experience.  

The ‘Haute Gear’ section was also inspir-
ingly awesome. I am still looking for the
appropriate word in the dictionary to
describe how useful the ‘Be a Smart@ss
@work’ article was. Perhaps you could have
also added tabbed browsers such as Mozilla,

Thank You Digit
Readers loved the Digit June 2004 Anniversary Issue. Here’s why in their own words…

Dear readers,

Digit Patron will pay back

more than you have bar-

gained for every time you

patronise our products. Cur-

rently, it is offered to our Indi-

an readers.

We will be updating the

Web site every month to

announce gifts that readers

can redeem.

5.5%
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E-mail: readersletters@jasubhai.com
Send your letters marked ‘Readers Letters’ to the Digit office: 

D-222/2, Om Sagar Building, MIDC, TTC Industrial Estate,  Nerul, Navi Mumbai 400 706 
Phone: 022-27629191/9200  Fax: 022-27629224

Deep
Joined:
23 Jan 2004
Posts: 450
Location: Mumbai

Ricky
Joined:
01 Feb 2004
Posts: 208

It seems that Google is maherbaan on me. Yesterday, I got 5 invitations.. 
and today 6. I gave 3 to Digit users for free and today 5. 
PM me if you need free accounts or just reply here.. 
It will be given to first 5 people... 

well.. may I know wht could be the reasons of such maherbani of Google on
you ?

me me me gimeeeeeeeeeeeeeeeee... Pleaseeeeeee......

Posted: Mon Jun 21, 2004 10:43 am  Post Subject: Free Gmail giveaways 

Posted: Mon Jun 21, 2004 1:12 pm  Post Subject: 

Posted: Mon Jun 21, 2004 4:48 pm  Post Subject: 

From the Forum (www.thinkdigit.com/forum)

Bomb
Joined:
21 June 2004
Posts: 2

JULY 2004

Digit v/s
Microsoft

The purpose of this letter
is not to praise you, but
point out my thoughts on
whether Digit follows an
anti-Microsoft attitude?
Indeed, are your writers
anti-Microsoft?

Over the years, I have
observed that Microsoft is
really disliked. Linux is
good, all right, but it does
not have as big a
commercial agenda as
Microsoft. Is it true then,
that, you prefer Linux just
because you want to
oppose Microsoft since it’s
the Big Guy?  
Kanwar Anand

Dear Kanwar

Rest assured that

Digit will not be “in favour” of

anyone. If we do seem biased

towards Linux, well, here is a

small statistic that is open to

scrutiny: Not more than 10 per

cent of our pages are devoted

to Linux-related topics. The two

things we are actually biased

in favour of are reliability and

performance.

MyIE2, etc. Install any one of
these browsers, download a
funky skin, and voila! You can
cheat your boss all the time.
David Lalsama,

The June 2004 issue of Digit
was simply superb—nearly
200 pages, two CDs with 101
Freeware and all the previous

36 issues to date, and the
amazing 1001 Amazing Tech
Facts booklet. Please accept
my heartiest congratulations.

The booklet though had
one glaring omission: There
was not a single mention of
the Amiga computer. Though

deplorable management killed
this computer as a commercial
product in the mid-90s, it was
far superior in many respects
to the IBM-clone PC. 

Two decades ago, the
Amiga A500 had 4-channel, 8-
bit sound, 4,096-colour graph-
ics, a friendly GUI and smooth
multi-tasking with a 7 MHz
processor and 0.5 MB RAM. In

1992, the A1200,
with a 
14 MHz CPU and 
2 MB RAM (includ-
ing display) had 
24-bit graphics,
games that the PC
couldn’t touch,
video and sound-
editing software that
had pros in ecstasy. 

Amiga hardware and soft-
ware played a crucial part in
milestone movies such as
Jurassic Park, Terminator 2,
Robocop, Babylon, etc. Even
today, comparing an Amiga
with a PC in multi-tasking
would be like comparing a

Ferarri with an Ambassador. 
Seasoned Amiga users rou-

tinely, without a conscious
thought, run three or four
tasks simultaneously. In tests,
I personally ran up to 
10 major processing tasks (not
just inactive app windows)
simultaneously with just a
slight drop in speed. 

As stable as Linux, but
much more user-friendly, the
OS could run from a single
880 KB floppy. Partitioning 
a fresh hard disk is done using
a GUI. 

With a Mac emulator, it
could run Mac software at full
speed, yet cost only a fraction
of the price. In short, it made
a Wintel machine look like a
tasteless joke. Since your
booklet included plenty of
information about past tech-
nologies, omitting any men-
tion of the Amiga borders on
criminal neglect!
Zotin Khuma

al.ien
Joined:
30 April 2004
Posts: 7

Posted: Mon Jun 21, 2004 6:17 pm  Post Subject:  Please gimme Gmail

Please give me one. I will be very thankful 2 u. I m dying 4 Gmail.  
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Dear minister, lend me an ear

Every
747 landing in
India can
potentially
bring in more
than 300 lap-
tops duty free

”
“
VIPUL SHAH 

Vipul Shah is a chartered accountant, and can be reached at digit@vipulshah.com

By the time you read this, the Union
Budget may just be a few days away, or
perhaps been announced. The chaos

that the Indian intelligentsia was predicting
has been mitigated, thanks to some astute
appointments by Prime Minister Manmohan
Singh in key positions.

P Chidambaram as Finance Minister and
Cable TV czar Dayanidhi Maran as minister
for information technology and telecommu-
nications are names that will create hope
among the middle class rather than despair.

I guess it is up to the Indian citizenry 
to support this team, whereas the team itself
has its work cut out—relook at the country’s
technology infrastructure, usher in a tech-
nology revolution; not by handing out lap-
tops to farmers, but by promoting
development in education. 

Having said that, may I take the liberty to
present my wish list for the finance and IT
ministers for the years ahead:

■ Dear Sirs, can you please visit a few
countries like Singapore, South Korea, Japan,
USA and Australia, and understand from
them as to how, despite their population
being a fraction of ours (some of them less
populated than our metros), manage to give
1.5 Mbps cable Internet access for $40 a
month (Singapore), and a 12 Mbps DSL
internet in Japan for $22 a month? 

In Mumbai, I pay an equivalent of $24 a
month for a measly 48 Kbps cable Internet
connection from Sify. Please find out where we
lag behind, and correct it before it’s too late.
Many ambitious people in the age group of 18
to 40 years will be able to employ themselves by
setting up a “one man BPO or a call centre”,
even while their client could be a cousin who
owns a motel out in the US. The technology to
divert calls from American numbers to India via
VoIP phones is already in place with Vonage;
only the last mile costing remains an issue.

■ PC penetration in India is pathetically
low, and it’s only a matter of time before China
catches up on us in software development.
Where will that leave us then? Right now, a
typical Indian family income earns a fraction
of its American or British counterpart. But high
import duties, octroi and sales taxes make PCs
still unaffordable. Even if they were removed,
and the PC were to cost the same as in the US,
with current Indian salaries it is a difficult job.
Perhaps you could do us simpletons a favour by
reducing tax rates for PC owners.

■ Consider cyber cafes to be a reincarna-
tion of the public telephones revolution in
the ‘80s. If we treat cyber cafes as essential
utilities, imagine the amount of employment
it would generate, and also at the same time
provide PC and Internet access to lakhs of
people for prices as low as Rs 10 per hour.

■ Treat PDAs, PDA phones, and mobile
phone as same for the sake of customs and
help create a new generation of software devel-
opers for these devices. If duties on these
devices are low or zero they will become more
accessible. If we don’t play with devices, we
don’t understand them and we don’t develop
software for the same. Also, removing arbitrary
classifications for duty may help.

Today, an individual can import a laptop by
not paying any duties, but he cannot import a
palmtop. One can bring in a laptop as part of
personal baggage, but commercial imports are
not duty free. This only helps create a huge
grey market. Every 747 landing in India can
bring in more than 300 laptops duty-free! 

Duties on mobile phones have been low-
ered to reasonable levels, but accessories that
will take it one step further are charged high
duties. This means that today, you get every
model of mobile phones with bills and war-
ranty, but Bluetooth handsets are still smug-
gled in. A PDA-phone attracts low duty as it is
considered a mobile phone, but a  device that’s
just a PDA still attracts high duty. These are
irrational duties that ought to be removed.

■ Today, one can courier anything out of
the country without any documentation.
Anything that is, except electronics. Couri-
ering electronics abroad needs all sorts of
invoices in Customs format, valuation, and
IEC registration. This is stupid; please scrap it.
No one has ever smuggled electronics out of
this country and it will never happen in fore-
seeable future. There is no need to crack
down on it. Many electronics goods are
returned by people who get them for a
review, or are being returned to the manu-
facturer because they are defective.

■ Make direct phone numbers of all
bureaucrats and government officers available
online. Citizens can then find out if a partic-
ular officer is available or not. Perhaps, you
can start with all departments under your min-
istries.

Dear Ministers, I would be happy as a 
citizen of India if you’d look into these 
issues soon.
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Transistors, processors,
circuits, interfaces, cables and
peripherals: These are essen-
tially what computers and

computing have been about for the
last few decades. Until recently, elec-
tricity and magnetism have played a
major role in all of these. Even now,
fibre-optic cables, optical storage
devices such as CD-ROMs, and optical
mice are probably the only aspects of
networking and computing where
you’re likely to see optics at work.

This scenario is set to change.
Light will play more and more of a
role in networks and computing
systems. However, calling optical
computing ‘the next wave of comput-

ing’ is not new. It was called the next
wave of computing back in the ‘80s,
but except for optical storage and
optical fibres, nothing much came out
of the research labs, until recently.

But why light? Why would we
want computers to be optical, instead
of electronic, or silicon-based?

Simply put, the need for comput-
ing at the speed of light comes from
the need for speed. Silicon-based
circuits will soon reach miniaturisa-
tion limits: Experts say this will be
sometime around 2030, when such
computing circuits will hit a funda-
mental physical roadblock on the
path to miniaturisation. Incidentally,
miniaturisation has been the key to

increased speeds.
Optics is probably one of the ways

out. However, it’s not a new field—in
fact, it’s almost ancient—and neither
is its application to computing
anything new. However, research in
optics—especially non-linear optics—
with computing as the focus has never
been pursued with the kind of vigour
we’re seeing today.

It’s said that the 20th century was
the century of electronics, and the 21st

will be that of optics.
Here, we take a look at what opto-

electronic and optical artefacts have
been churned out of the labs so far,
and what this means for fully-optical
computing.

PHOTOGRAPH: Mexy Xavier, 
IMAGING: Atul Deshmukh

Computing
at Lightspeed!

Light is all set to make
inroads a computer…
in the not-too-distant
tomorrow

features ■

JULY 2004
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The year 2003 was a landmark year in
the journey towards optical computing:
In March, Lightbit Corp, USA, came up
with an optical processor that deals with
multiple channels in fibre-optic
networks. Lenslet, an Israeli startup, also
launched one of its supercomputer-
calibre chips the same year. Lenslet said
its processor, called Enlight, would
enable “new capabilities in homeland
security and military, multimedia and
communications applications.”

Enlight can process multiple
DWDM channels in fibre-optic
networks simultaneously, without  the
intervening electronic conversion. Just
one of these processors can replace
multiple optical-electronic-optical
(OEO) transponders. The chip harnesses
the ‘parallel-processing power of light’.

Lenslet’s offering is more interesting:
It is a digital signal processor (DSP) to
which is attached an ‘optical accelerator’,
which enhances the chip’s  speed.
Aviram Sariel, founder and CEO, Lenslet,
said this chip was “an acceleration of 20
years in the development of digital
hardware,” speaking to Reuters in Israel.
There are 256 lasers—the active
computing elements—within the chip,
leading to a performance of eight trillion
operations per second. Roughly
speaking, this is equivalent to that of 
a ‘regular’ supercomputer, and a
thousand times faster than a typical
commercial processor.

So, has ‘the optical processor’
arrived? Not quite. These are not
general-purpose processors—you cannot
use them for anything other than their

intended use. So, why is there interest in
them? Well, these processors signify a
major leap into fully-optical processors,
and we are now only a small step away
from a general-purpose fully-optical
processor, as far as theory is concerned.

In a way, the logic gate is the basic
building block of a computer and
transistors are building blocks of logic
gates—at least in today’s
silicon-computer world. The
discovery of optical devices
that act as transistors is
being actively pursued, since
it could lead to new
possibilities in computer
designs. Processors and other
chips could be built using
designs that were hitherto
impossible, on the basis of
optical transistors.

So, what’s come out of
the research labs along these
lines? Plenty! A transistor is
essentially a switch, and the defining
speed parameter here is its switching
time. Evident Technologies, USA, has
come up with a ‘planar lightwave circuit
device’ that acts as a transistor with a
switching time of 1 picosecond. (Regular
transistors, such as those in a Pentium
chip, have switching times in the order
of a few picoseconds.) The switching
process takes place using light pulses.

In November 2003, Stanford and MIT
researchers brought out designs for an

optical switch and an optical transistor.
These are less than a micron in size, and
their designs can be fabricated in regular

chip-fabricating facilities.
The devices would work on
the principle of the bending,
or refracting, of light in a
photonic crystal. Researchers
said that all-optical devices
on chips can be feasible as
early as 2005-2008.

Back in March 2003,
researchers at the Georgia
Institute of Technology
developed nanoscale opto-
electronic
devices, and
demonstrated

their functioning as logic
gates. The principle of
these opto-electronic
transistors, or switches, is
simple: Instead of
measuring current to
determine device output,
one measures the light—or
electroluminescent—
output. Again here, the
researchers—Robert Dickson and Tae-Hee
Lee—emphasise that their devices will

not replace traditional silicon transistors,
but could be used in dedicated devices—
ones that do a specific task—such as
optical network switches.

This wasn’t the first optical
transistor: In May 2000, Professors
Sajeev John and Geoffrey Ozin of the
University of Toronto developed one
using silicon photonic crystal. It
trapped light waves and controlled
their path, much like a silicon
transistor manipulating the 
path of electrons through it.

John and Ozin’s transistor
highlighted one of the biggest hurdles

along the path to
the ‘photonisation’
of computers: The
search for
materials. There’s a
lot of theory out
there, but materials
that actually
support the theory
are hard to come
by. And in the case
of John and Ozin, a
major part of their

efforts focused on producing the silicon
photonic crystal.

The Optical Processor

Optical Transistors and Logic Gates
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The optical computer
There’s no race on to build a fully-opti-
cal computer. Rather, each of the
advancements that we have just
mentioned does a particular job, or
demonstrates a particular principle. The
real race, if any, is that of finding mate-
rials that do the job well—for example,
materials that are capable of storing
holograms in holographic storage, 
or those ideally suited for building opti-
cal transistors.

The question of why we’re not at an
optical computer yet might arise: With
optical processors, optical data paths,
etc, demonstrated, why not build an
optical computer right now? The answer
is that these components—for example,
the optical processor by Lenslet—are
isolated; none of them are designed to
work with each other. There’s no consor-
tium that has defined any kinds of stan-
dard for ‘optical processing’ or ‘optical
computing’. Research is scattered, and

Dr Donald Frazier, research scientist at
NASA’s Marshall Space Flight Center at
Huntsville, Alabama, says about optical
computing, “Entirely optical computers
are still some time in the future, but
electro-optical hybrids have been
possible since 1978, when it was learned
that photons can respond to electrons
through media such as lithium niobate.

“Newer advances have produced ...
thin films and optical fibres that make
optical interconnections and devices
practical. We are focusing on thin films
made of organic molecules ...

“Organics can perform functions
such as switching, and signal processing
using less power than inorganics.
Inorganics, such as silicon used with
organic materials, let us use both
photons and electrons in current hybrid
systems, which will eventually lead to

all-optical computer systems.”
This underlines the problem of the

quest for materials. Dr Frazier, Dr
Hossin Abdeldayem, a member of
Frazier’s optical technologies research
group, and the rest of the group,
demonstrated all-optical switches,
acting as logic gates, operating in the
time range of picoseconds. 

The Alliance for Non-linear Optics
(ANLO), was formed with a grant from
NASA with the goal of focusing on
materials that support optical
computing. Non-linear optics is the key
here. In its mission statement, ANLO
says that lack of good materials is an
impediment to progress, and to that
end, experiments with mostly organic
materials that may serve as the basis
for optical computing devices such as
logic gates.

The hard disk is probably the most
important component of a personal
computer. So what about the
‘opticalisation’ of storage? The answer
lies in holographic storage, which uses
the volume of a medium, rather than its
surface to record and read data. This
would result in
vastly increased
densities and read-
write speeds, while
being, at the same
time, ultra-reliable
and cost-effective.

The principle
relies on lasers: Light
from a laser beam is
split into two—a
signal beam that
carries data, and a
reference beam,
which is used to
write and read to
the holograms. A
device—the spatial light modulator
(SLM)—translates the 0s and 1s of data
into an optical two-dimensional array of
pixels that are either lit or dark. At the
point where the signal beam and the
reference beam intersect, a hologram is

formed because of a chemical reaction
between the light-sensitive recording
medium and the lit elements of the
signal beam. This hologram is then
recorded on the medium.

By varying the angle and
wavelength of the reference beam, or

the position 
of the medium,
different holograms
can be recorded—
basically,
superimposing
holograms within
the same space.
Reading is
accomplished by
flashing the
reference beam
onto the media:
The reference beam
deflects off the
stored hologram.
Data is read

parallely since the deflected beam is
projected onto a detector that reads the
aspects of the hologram in parallel.

Again, note that holographic
storage is not a new concept: It’s been
researched for nearly four decades now.

DWDM: Dense Wavelength Division
Multiplexing is a technology that lets
you transmit more data over a fibre-
optic network than is usually possible.
To do so, it sub-divides signals of a
particular frequency on a single fibre
into discrete wavelengths and
multiplexes them. These wavelengths
are recognised at the receiving end.
OEO transponder: An OEO
transponder converts light signals 
to electric ones, and then back to
light. This is necessary because 
certain operations on the signals 
can, as of now, be done only in
electronic mode.
Photonic crystals: Structures made of
an insulating medium that allows 
light to pass through them, with a
property that forbids the propagation
of a certain frequency range. This
enables comparatively very easy
control of light.
Non-linear optics: The field that deals
with the interaction of matter with
strong light fields.
Optical waveguide: Used in fibre-
optic networks, an optical waveguide
is used to control propagation of light
from a source.
Core IP router: A high-throughput
router that’s at the hub of several
interconnected networks.

Jargon BusterMaterials Needed

Holographic Storage

Holographic storage relies on the
‘etching’ of a hologram onto a medium
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different research groups are different in
their focus. Some groups focus on mate-
rials, some on interconnects, some on
components, and so on.

The Internet grows exponentially,
with users being added by the minute.
With increasing demands on band-
width, optical switching over fibre-optic
networks will undoubtedly be one of the
major focal points of research. However,

that is beside the
point: when can we
expect an optical
computer?

Time frames vary.
Holographic storage
could be commercially
available in as little as
five years. Pure-optical
processors have already
been devised and built,
and the way to a
general-purpose optical
processor has already
been paved—although
much work remains to
be done—but that is not
the issue here. What is 
at issue is the frame-
work for an optical
computer and its appli-
cations, which no single
group is 
focusing on.

No one knows what an optical
computer will be like, and what uses it
will be put to. However, we may hazard
a guess that it might not be based on the
von Neumann architecture that we’re all
so familiar with. The primary reason for
this is the speed that  is promised by
optical components, and the manner in
which devices in such a computer can
be interconnected.

As an example, with storage going
the holographic way, will there be a
distinction between main and periph-
eral memory? As of now, our concept of
a computer is centred around a fast
main memory and a slower hard disk.
Optical storage might do away with that
concept altogether.

Then there is the question of the
network being totally distinct from the
computer. With high-speed optical switch-
ing and optical processors, what might not
be possible? The same processor that
handles signals within the computer could
also directly handle those coming in from
and going out to the network, effectively
uniting processor and network. The possi-
bilities are exciting.

In sum, the picture we have 
of optical computing, as it stands 
today, is first, that the opticalisation of
computers is happening component 
by component; there is a tremendous
need for new materials that can be
deemed as being capable of 
implementing what is being done in
theory. And second: that we don’t yet
have a clear idea what a fully-optical
computer will be like, but the very 
architecture that John von 
Neumann spelt out in 1945 may be
challenged.

RAM MOHAN RAO

ram_mohan@thinkdigit.com

The missing element in the discussion
so far has been optical pathways that
can interconnect different components,
which are essential if a fully-optical
computer is to be realised. As an
example, consider the work being done
by a group in Belgium, called the IO
project (Interconnect by Optics). The
group aims at developing ‘an optical
interconnect family’ that will
interconnect ICs to ICs, boards to
boards, and more. The group aims at
demonstrating direct access to a CMOS
chip. Their approach is based on
optical waveguides that can be
integrated with boards.

The novelty here is in the optical
waveguides. These will be based on
plastic optical fibres—as opposed to
traditional glass fibres—and on layered

glass sheets with the waveguides
etched on them.

The group focuses on the
achievable channel density and
data rate. The IO project aims to
demonstrate a complete optical
interconnect family in the area of
core IP routers, which marks the
entire project as not being
something futuristic and ‘in-
theory’, but one whose results can
be used right now.

However, the point of this is
not that we now have a faster
technology in the area of core IP
routers; the point is that research
is paving the way for silicon-
optical hybrid boards that might
very well be  available a few
years from now.

Optical pathways

From the IO group, a highly magnified photograph of a
plastic optical fibre (POF). The core and the cladding
are visible

This figure seems simple and obvious, but it was not obvious until
John von Neumann devised the architecture, known since 1945
as ‘the von Neumann architecture’. Every computer you’ve ever
seen is a ‘von Neumann machine’. Parallel-processing machines
are an exception

The von Neumann architecture for
computing machines



AKG K 1000
Playing it loud
The set resembles a pair of loudspeakers strapped
together. And the output is proof enough of
that. The AKG K 1000 has its speakers fine-tuned
by a computer-optimised process that involved
meticulous time-energy distributions. This
feature makes listening a surreal experience. A
magnetised Ventilated Linear Dynamic (VLD)
system drives the diaphragm to pamper your
ears with superb acoustics.
Price: US$ 916 (approx)

Sennheiser SET 810 
Take a bow

Its ear bows bow to
adjustment, so you need not
worry about the fit. This infra-
red stethoset receiver gives you
balanced audio and makes the
finer nuances of voice audible. A
large knob lets you handle the
volume level with ease. An external
microphone lets you connect to TVs
without an audio-out socket. 
Price: US$ 229

▲
▲

AKG Hearo 999 Audiosphere II
In a sphere of its own

The noise-free reception is a marvel, and the surround
system classy. The Audiosphere II pitches in some
excellent hi-fi acoustics—even at loud volumes—using
Varimotion technology and computer-optimised
membrane geometry. You can choose between surround

and stereo modes. The set promises crystal-clear
output and lets you handle several headphones
simultaneously.  
Price:US$ 1,290 (approx)

features ■
■ droolmaal

▲ ▲

▲▲

For Your
Ears Only

Sleek, suave headsets that spell
music when you plug them in 



Sony Qualia 010
Sound realism

These high-definition headphones, with a price to match,
bring that much-sought realism to sound frequencies
exceeding 100 KHz. A porous baffle cuts down all unwanted
resonance. The broad leather headband and pressure-
dispensing sheepskin ear pads make the Qualia 010
comfortable even over long hours of play.
Price: US$ 2,600 (approx)

Sennheiser RS 110
No wire…Sounds impressive

With a range of around 100 metres, here’s a
headset that lets you listen to Mozart as you
walk about in the garden, without the hassle
of wires. This supra-aural set thrills with
detailed sound reproduction. Three
selectable RF channels, great bass response
and intuitive control elements make for a
sound picture. 
Price: US$ 89.95

JULY 2004

▲ ▲
▲▲

▲ ▲

Sony MDR-G94NC
Stylish and hassle-free
This set snuffs out outside din by a whopping 
70 per cent, and uses Neodymium magnets to 
give you ample sound output. The stylish behind-
the-neck headband leaves your hair unruffled,
while the cord is tangle-free. Truly made for the
glitzy audiophile!
Price: US$ 69.99
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Anand Bose, a commerce grad-
uate from National College,
Mumbai, puts a twist to the
“India Shining” phrase. He has

two years of work experience in sales, and
he’s now looking for recruitment adver-
tisements by IT companies. “IT shining!”
is the reason.

The IT sector was primarily the
domain of engineers and computer sci-
ence professionals. What brings Com-
merce and Humanities graduates into IT?

The dotcom bust of 2000 resulted in
pink slips, and a sluggish US economy  put
an embargo on IT professionals. But post
2002, favourable government policies,
combined with a global belief in offshore
development, resulted in Indian IT com-
panies expanding their workforce, and
increased opportunities—both in terms of
working on the technical side and cus-
tomer support. Today, most ads in 
newspapers are for the IT, and ITES (IT

Enabled Services) sector, which comprises
Business Process Outsourcing (BPOs) and
call centres.

Considering that there are approxi-
mately 2,90,000 fresh engineering gradu-
ates, and more than two million
English-speaking graduates added to the
workforce every year—according to
Nasscom (National Association of Software
and Service Companies)—what kind of
prospects does IT offer?

IT: Specialist vs Generalist
According to the Nasscom Strategic Review
this year, IT’s contribution to the nation’s
Gross Domestic Product increased from 1.4
per cent in 1998-99 to 3 per cent in 2002-
03. And recruitment is definitely on the
rise. According to A N Pruthwi, Staffing
Manager—India for Microsoft, “We are
witnessing a period peak of 1998-2000—
the dotcom phase; by 2005 we would hit
that stage and go beyond.” 

What are companies
looking
for?

All Web-based
applications are
finding takers.
Companies are lap-
ping up people
with Java/J2EE and
.Net skills. As Vijay
Mukhi, Founder,
Vijay Mukhi’s Com-
puter Institute, says,
“With the introduc-
tion of Microsoft’s

Visual Studio
2005, the
demand for .Net
expertise is on
the rise, as most
companies are
M i c r o s o f t -

based.” Asad
Kadri, Manager-

Resourcing, of
Mumbai-based Patni

The good news is

Microsoft, Wipro and

e-Serve are hiring;

the tough part is you

need to be prepared.

How do you look for

that dream job?

What skillsets are in

demand? And how

do you write the

perfect résumé?

IT’s happening!
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Computers System Pvt Ltd, informs that
their company is looking for cross-tech-
nology expertise from database manage-
ment to embedded systems, and from
mainframe to client-server applications.

There are other trends as well.
According to the Manager-HR, I-flex Solu-
tions, Mumbai, which provides IT solu-
tions to the financial sector, the shift is
also towards Unix, C and C++. Mainframe
skills are back in demand: financial and
healthcare institutions invest signifi-
cantly in data recovery management.
Another emerging area is data security,
which has the potential to grow at a rate
of 14 per cent annually by 2005,
according to Nasscom’s estimates. 

Does all this mean IT companies will
only recruit engineers?

Primarily, yes. However, non-engi-
neering graduates can and do look for IT
jobs. Top IT companies are hiring MCAs
(Master of Computer Applications) and

MCMs (Master of Computer
Management). As Ambarish
Deshpande, Assistant Vice Pres-
ident-Marketing, of Symantec
India, assures, “Being an MBA
has in no way been detrimental
to my job of selling security
solutions to companies.” Most
IT companies have realised the
importance of a strong sales
and technical support team,
and so non-engineering back-
grounders, too, can aspire to be
in the IT world—using mar-
keting skills, of course.

ITES: Service with a
smile
Last year, the Indian ITES-BPO
industry grew 54 per cent,
according to Nasscom. What began as mere
outsourcing of customer service mostly
from the US, is now becoming a niche—

finance, computing equipment, etc. 
Firms such as eServe—a part of Citi-

group—and Intelenet (a joint venture of

LOOK AT THE WORK PROFILE, NOT MERELY SHORT SALARY SPIKES

Digit: What are the reasons for the steady
increase in the field of IT and ITES?
Vipul Varma (VV): The year 2000 was a
period of recession for the IT industry, with
the economy slump and the dotcom bust.
Post 2002, many MNCs have set up their
delivery and offshore centres around the
world, India being one of the beneficiaries.
This has resulted in more offshore projects
and support activities. 

Digit: Can you highlight the major trends
in IT recruitment over the last couple of
years?
VV: There is a great demand for technically
qualified personnel with a work experience of
two to five years. One sees a shift to package
software skillsets such as ERP, Siebel CRM
solutions, Oracle APS, Baan ERP, etc.
Previously, there was a lot of demand for the
vanilla skills of mainframes and client/server,
but now, Web-based application skills such as
.Net and Java/J2EE face a supply constraint.
Newer technologies demand more and more
professional skills. Also, IT infrastructure and
security are newer areas, which would see
more recruitment in the coming years.

Digit: How have placement consultants
influenced the IT recruitment process?
VV: Consultants save the company the

trouble of scanning through hundreds of
résumés; a pre-screening is done by the
consultants in terms of finding the relevant
résumés, and the candidates are pre-screened
too. So with a consultant, the shortlisting to
final offers is high, unlike job Web sites. 

Many consultants offer third-party
validation to a candidate vis-à-vis a
company’s advertisements that are often
publicity vehicles. Today, consultants counsel
the candidates, and also advise the company
on matters of rational salary structure.

Digit: Ten years in the placement industry,
and you must have seen innumerable

résumés; what are the most
common errors?
VV: From an employer’s point of
view, a résumé is the first
introduction to an applicant’s
personality. An ideal résumé should
not be more than three pages. The
common errors that occur are:
■ No one ever writes a summary,
when the fact is that a summary
gives an employer a fair idea of
what the candidate is like.
■ Applicants tend to describe
projects more than their
contribution to it.
■ They hide uncomfortable truths

like pink slips.
■ An applicant should, by the design of his
résumé, be able to drive the interview
towards his strengths.

Digit: What kinds of pointers would you
give Digit Readers aspiring to make it big
in IT?
VV: ■ Build a career, not a job.
■ IT is a knowledge-based industry, so get
into continuous learning.
■ Develop good interaction skills. Employers
also look at Emotional Quotient.
■ When joining a company, look at the work
profile, not merely short salary spikes.

VIPUL VARMA, 
CEO, Focus Consultants

Focus Consultants is one of India’s top IT placement consultants.
Vipul Varma, CEO, talks about trends in IT recruiting in India

Source: N
asscom
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TCS and HDFC) hire around 500 people a
month, and so do others such as Daksh
and Wipro Spectramind. 

As Jaipal Verma, Manager-HR, eServe,
says, “Four years ago, there was hardly a
call centre around worth its name. Today...
the demand for them has increased.” The
numbers are large—but do the companies
get the right candidates?

An HR Executive from 3 Global Ser-
vices Pvt Ltd, a call centre division of
Hutchison Whampoa Limited, confirms,
“We get the quantity, not the quality, and
so recruitment numbers seem large.”
Verma lists the skills that a call centre or
BPO would look for: “Good communica-
tion skills, fluency in English, diction and
the most important attribute—customer
oriented behaviour.” Raamann Kumar,
Senior Manager-HR, Intelenet, says, “It is
a misconception that call centres look for
accented English; in fact, we look for
people with a neutral accent.” These jobs
let undergraduates augment their pocket
money and get work experience. So, is a
call centre ideal to begin one’s career?

Kumar gives an example of an
employee who began with Intelenet as a
Customer Service Executive, and three
years down, she is Manager-Training. But
she might belong to a small tribe who look
at a call centre as a career option. For the
majority, call centres are a temporary halt.

Looking in the right places
Most IT and ITES companies have 
a recruitment strategy encompassing
press advertisements, online job sites,
placement consultants and employee
referrals. The company Web site is an
important tool for any recruiter,
according to Microsoft’s Pruthwi. He says
25 per cent of applicants to Microsoft
used the company’s Web site to apply and
expects this to go up by 25 per cent in the
coming years.

Though the best way to create com-
pany awareness, press ads are expensive.
Here’s where job sites come in. For the last
five years, a number of them—naukri.com,
timesjobs.com etc, have become the pre-
ferred option for job seekers. Arijit Sen,
Manager-Marketing, Customer Care and
Operations, Jobstreet.com India, says, “The
IT sector has adapted to e-recruitment the
most. It’s use in this sector is the highest.
Over 50 per cent of jobs on such Web sites
in India come from this sector.” Hitesh

Bhartia, Manager, Mumbai Operations,
also confirms that for a job seeker as well
as for an employer, the reach is wider. Sen
says the most popular ones are from the
one to eight years experience category.

However, both IT companies and call
centres exercise caution. For a call centre, a
walk-in is far better than an online résumé,
as soft skills need to be checked; while an
IT company always runs the danger of
being swamped with junk résumés. 

Placement consultants are an impor-
tant link for e-recruitment. Kavita Iyer, a
senior consultant with CAPNTEL Execu-
tive Search says, “A placement consultant
helps in assessing the candidate prima
facie.” A manager with a leading software
company also agrees that placement con-
sultants are better because they are able
to pitch for the candidate, to get him or
her the best deal possible, and also look at
cross-industry options. A placement con-
sultant is your best bet when looking for
a suitable change after a certain number
of years of experience.

And Finally…
“There is no substitute for preparation; set
your goals and work towards them,” says
Pruthwi, when asked about pointers for
those who want to make it big in IT. Yes,
there is a boom in both the IT and ITES
sector, and recruitments would continue
for more than two years at the least. For
those who want to do well, accept that IT
is a field of continuous learning—keep
yourself updated because, like technology,
knowledge, too, can become obsolete.

APARNA KRISHNAKUMAR

aparna_krishnakumar@thinkdigit.com

■ Always state a job objective: Decide on a
job objective that can be expressed in about
five or six lines.
■ Stick to a certain chronology: Preferably,
begin from the most recent.
■ Educational qualifications: In case of
experienced candidates, educational
qualifications can be mentioned at the end,
but for a fresher, this section is paramount
and so should be on top.
■ Use strong verbs to highlight your

achievements: Use verbs such as ‘handled’,
‘headed’, ‘co-ordinated’ and adjectives such
as ‘responsible’, ‘in-charge’. Be honest about
your claims—all of what you write should be
verifiable with your former employer. 
■ Include hobbies and interests: Things
you really like doing. Just saying ‘reading’
would be very general; be more specific
about such things so you can answer
questions better during the interview stage.
■ References: Give references only if asked.

Tips on writing a good résumé

I graduated in MCA in the ill-fated year
of 2001. Campus placements did not
materialise. Now, when the industry is
looking up, companies either want freshers
or experience. People like me have to
struggle  to get jobs.

S VANITHA

SOFTWARE DEVELOPER SOFTLAND

SOFTWARE SOLUTIONS PVT LTD, BANGALORE

Despite clearing interviews, I am rejected
for my background; they (IT companies)
assume I am not a technical guy.

KARAN CHAUHAN, 
BIO-MEDICAL ENGINEERING GRADUATE 2002

MUMBAI

Is IT or Not?

We are witnessing
a period peak of
1998-2000—the
dotcom phase; by
2005 we would
hit that stage
and go beyond

““
A N PRUTHWI, 
Staffing Manager, India
Microsoft

“
”

“
”
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To ensure that our readers have all the infor-
mation they need to make an informed buy-
ing decision, reviewers at the Digit Test Cen-

tre conduct comprehensive tests to evaluate the lat-
est hardware, software and technology services in
accordance with international standard evaluation
processes and methodologies. 

Our test results may be presented either as
Comparison Tests, or as individual reviews in the
Bazaar section. The representation of the results is
different for each in the interests of clarity, but the
test process for both is identical in all respects. 

Of all the products we test, only the best make
it to the A-List.

Comparison Tests
In the comparison tests, we compare the perform-
ance of products within a particular category. Each
product is evaluated under different parameters
such as performance, value for money, features,
ergonomics, etc. 

Weightages are then applied to the various test
parameters according to their importance for that
particular category of products. These weightages
are then used to arrive at scores for features,
ergonomics and performance for each individual
product. A detailed test process is included with
each comparison test, and explains the parameters
that were taken into consideration, along with
weightage allocation and reasons for the same.

In Bazaar
The evaluation of products in Bazaar also covers the
same parameters such as performance, ease of use,
value for money, build quality and features of the
product. 

Here, each of these parameters is rated on a
scale of 5, which is represented by arrows (->). 

The greater the number of arrows, the better
the product. This simple five-point rating system is
designed to give you an easy-to-interpret assess-
ment of a product. For example, a product that

receives a value for money score of five arrows 
signifies an outstanding buy. 

The Awards
Digit awards outstanding products by selecting 
a Best Performance and Best Value winner in 
each comparison test. The winner of the Best 
Performance Award will be the product that scored
the highest in the performance segment combined
with rest of the package including features,
ergonomics, bundled accessories etc. This award
represents the best performing product in our tests
in terms of the complete package that is offered to
a customer. The winner of the Best Value Award will
be the product that scores the highest in our value
for money parameter which is derived taking into
account the ratio of a product's ergonomics, per-
formance and features to its price. The product
winning this award offers a good combination of
performance and features at a great price. Since
value for money takes into account all scores for all
parameters including the price, this score will be
used to arrive at a grade (e.g. A+) for each product.

How we Test
It looks good and the technology is glitzy, but does it do the job?

Excellent: A brilliant combination of price, performance and features—far beyond 
expectations
Good: A good buy, better than most products in its category
Average: Reasonably competent but nothing spectacular about the product
Mediocre: Does not live up to expectations, needs improvement in many areas
Poor: has serious drawbacks and needs improvement before it can be used for its target
application

The 5-point Rating System used in Bazaar
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Mobile
Madness
Mobile
Madness
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If all you ever need to do is talk on your phone, or play Snake, you don’t

need a Sony Ericsson P900. Then again, you might want one for simple

flaunt value. Whatever your need, there’s a phone in this article that will be

perfect for your needs…

PHOTOGRAPH: Jiten Gandhi
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We categorised the cell phones based on two factors—
price and features. In order of price, these categories
are: Basic phones, Mid-range phones, Camera

phones, Smart phones and PDA phones. 
The essential features we looked for in the PDA phones

category, evolved around PDA functionality, along with the
usual mobile phone features. Major weightage was given to
stylus-based input. A Large colour screen, an expandable
memory, an integrated camera and other features added to
the tally. 

Smart phones were defined as the phones that allowed you to
instal applications, games, screen savers, themes, ringtones etc.

Other features such as presence of camera were noted down, but
they did not form the basis of distinguishing features between the
models. Amount of memory, pre-installed applications, usability
of the installed applications, etc were given more weightages.   

The Camera phones category looked at those mobile phones
that offered camera functionality, but lack application installation
support. Here, the camera features were stressed upon. Though
there were many phones in the Smart phone category that had
the camera integrated, they deferred from the camera phone in
their flexibility of installing applications. 

Mid-range phones consisted of cell phones that did not fit into
any of these categories. This category essentially comprised
mobile phones that were a cut above the ones in the Basic
phones category. As an added bonus, some of them even offered
coloured screens as well.

The last category, Basic phones, was for phone which are
just that, phones—nothing special. These are the highest
selling models, and everyone and his uncle has owned one at
some point. The standard features we looked for were: A
compact size, light weight,good build quality and ruggedness,
a decent capacity to store addresses and a good battery life of
at least two days. The additional features we considered were
a calculator function, inbuilt ringtones, the number of games,
etc. Of course, the price is the most important factor in this

category, so we only considered phones that cost Rs 5,000 or
less here. 

Testing and benchmarking procedure
We evaluated the cell phones based on the following criteria:

Style and design:
■ Usability refers to the practical ergonomics of the phone. We
took into account the keypad layout, the phone grip and the
readability of the buttons with the backlight on. We also looked
for any individual buttons that made browsing through the
menu simple—the five-way joystick type button, for example.

■ We evaluated the software used in the
phone, and concentrated on the ease of
use of the interface, the customisation
offered and other features in the software
itself, such as one-touch SMS.

Features
The features were assessed after we
allotted them to 14 different categories.
■ The first category represented the basic
phone features. They included weight,
length and dimensions of the phone, and
also battery type. 
■ The second category was memory. We
studied the dynamic and static memory of
the phones. We also took a close look at
the phone’s support for external memory.
■ Other important and upcoming features
such as MMS, inbuilt cameras, etc., were

also delved into. 
■ We evaluated PIM functionality, profiles, connectivity
standards, Internet capability and ringtones in the respective
categories.
■ The weightages were assigned in accordance to how
important a particular feature of a phone was, based on the
category it was placed in.

Performance
The performance of a cell phone depends directly on the network.
So, we took into account various important factors while evaluating
the performance. We tested the performance of the phones at
three different times, and at three different places within our
building. The idea was to weed out any ambiguity in the tests,
which could be caused by network loads while the tests were done.
Since every phone we tested, across all categories, was still
primarily a cell phone, the weightage of voice performance and
network strength did not differ across categories.

For phones with inbuilt cameras, we scrutinised the image
quality and the video frame rate—we checked for jerkiness in
the captured viseo. 

All Java enabled phones were tested for the amount of time
taken to load applications, and switch back to the main screen
from the application. We also studied the time taken for a

How We Tested
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Phones priced below Rs 5,000 formed the basic phone cate-
gory. We had phones from Alcatel, LG, Bird, Nokia, Benq and
Philips. BenQ had three phones in the category, while Alca-

tel came up with two compact little contenders. Nokia could only
manage to get its 1100 phones in this category. Philips sent in its

stylish-looking 330 phone for the masses.
Alcatel’s Onetouch 331 is very compact—it’s

no bigger than a Cadbury’s Five-star chocolate
bar, and looks great in its ivory white cover with
a light orange backlight. However, the
Onetouch 320 sports dated looks akin to the
earlier 3 series of phones from Nokia, such as
the Nokia 3320.

BenQ’s S620i sports a pearl-finished
plastic body, whereas the S630i is all silvery.
Of the two, the S630i stands out as a better
finished product. Both are quite bulky as
compared to the Philips 330, which
despite being a flip-phone is quite slim.

BenQ does have a slick contender in
the form of the M560G. It’s feature-rich,
and is much better than its other two

siblings in terms of design and
overall appeal. 

The Philips 330 offers good
functionality and probably was
the best looking flip phone of the

lot—its chrome finish sets it apart from the rest.
The 1100 from Nokia made quite an impression with its design

and super slick usability. It packs in a variety of accessories rang-
ing from hard plastic for the casing, rubber keys and rubber inserts
on the side that provide a firm grip. 

Bird, a little known Chinese manufacturer, had the S1160
in the Basic phones category. It’s a flip model, treated in silver
and intelligently designed. However, it does not evoke the
rugged feel associated with phones  in this category, neither
is it aesthetic in its appeal.

LG, with its G1500, is another Nokia clone with a
Korean touch. This compact little phone combines good
functionality with a decent design. 

Nokia’s 1100 takes the lead when it comes to usability. Its
rubber keys are a little hard to press but their placement is
perfect. The tried and tested navigation from the 3310 also

makes its way to the 1100, but with a small difference—the buttons
are rearranged. Its menu is easy to use, and menu items are logically
grouped—something the rest of the competition hasn’t given a
thought to. 

Alcatel’s Onetouch 331 comes a close second, but lacks Nokia’s
menu-structuring finesse. It employs a two-dimensional joystick to
browse the menu. On the other hand, the Alcatel 320 is quite
cumbersome and uses rubber keys similar to those on the Nokia
3350, which are not so user-friendly.  

Philips uses a slim design and small form factor to make the 330
a pleasure to use. In fact, it was the second lightest phone in this
category—the lightest being Alcatel’s 331. However, it may be some
time before you get used to the Philips 330’s  menu structure. 

A good keypad, small form factor, and a weight of 80 gm placed
BenQ’s M560G third in the usability department. The other two
BenQ models lack that very feel that goes into the making of a good
phone. 

LG’s 1500 also scored high on the usability aspect. People
making the switch from Nokia will find its menu easy to navigate.
Its button placement, however, takes some getting used to.

On the messaging front, the Nokia 1100 still rules the roost—
with a straightforward messaging system. The T9

predictive input is also superior to others—
the models from Nokia and LG give you

the most relevant words first, whereas the
Alcatels throw up all sorts of combina-
tions, and ask you to ‘help’ choose the
words. The other phone that equals

Nokia’s messaging ability is the LG G1500.
BenQ’s messaging interface also shouldn’t

pose a problem. Alcatel’s messaging system,
though, is a complete mess. 

All these phones use monochrome
displays, but not all of them have a resolution

to match. Then there’s the backlight to
consider, which also makes a difference in

monochrome displays. A green backlight does
not put much strain on your eyes, while a blue

backlight makes it difficult to read text. A white
backlight is the coolest and makes reading the
screen a much better job. The Nokia 1100,
BenQ S620i and 630i, Bird S1160 and Alcatel
320 all use green backlights. The Philips 330

B A S I C PHONES

Alcatel Onetouch 331
Rating: A    
Price: Rs 2,990

NOKIA 1100 
Rating: C+   
Price: Rs 4,699
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comes with a white backlight, and the LG G1500 was the only
phone with a mild blue backlight. The Alcatel 331 uses an orange
backlight. BenQ’s M560G gives you the added advantage of chang-
ing the backlight to suit your mood. The
Philips 330’s screen was the best in terms of
legibility. 

Personal information managers in all
phones are a basic affair. However, the Alcatel
331 and the LG 1500 have some additional
features that set them apart from the rest. 

Nokia’s 1100, LG’s 1500, and the BenQ
620i and 630i were the only phones that
lacked polyphonic ringtones. 

Almost all the models had their connec-
tivity options limited to WAP. However,
BenQ’s M560G offers GPRS capability. It does
not support PC connectivity though. 

As for the extra frills, Nokia’s 1100 is the
only phone to have an inbuilt torch, which
though handy, is not powerful enough. All BenQ phones have a
handsfree speaker. A calculator with a currency or metric converter
is common to almost all the phones—what differs is its imple-
mentation. The same applies for alarms—you can now set alarms
differently for different days. 

Nokia showed its mettle when it came to signal reception and

voice clarity. Its signal reception stayed put even in low signal areas
and the voice didn’t crackle. Almost all the models from BenQ were
on par with Nokia’s performance in this department. Close on their

heels were the models from Philips, LG and
Alcatel. Expect a minimum battery life of 3
days on these phones if you use them for
around an hour a day, with a few gaming
sessions thrown in. 

All said and done, BenQ’s M560G is the
phone you should look out for if features is
your major concern. Its practical usability,
small compact body and good set of features
are strong points in its favour. However, you
can also consider the Nokia 1100, which is
equally impressive in its usability aspect. The
small difference that lends Nokia an upper
hand is the slick and easy-to-use interface that
most people are familiar with. 

The Philips 330 should appeal to people
on a shoe string budget with a flip-phone fetish. The S1160 from
Bird is buyable, but the problem is that its competitors have a better
product to market. 

As for the BenQ mobile gentry, the S620i and S630i look like
retired gentlemen. We would rather suggest the M650G—it looks
better and has loads of features to play around with.
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BBrraanndd
MMooddeell

BBaassiicc  ffeeaattuurreess
Antenna
Weight (gms)
Dimensions (mm)
Netwrok Band support
Rated standby time (hours) 
Rated talk time (hours) 
DDiissppllaayy  ssccrreeeenn
Type/Resolution (pixels)/No of lines
RingtonesType (built-in)/Number 
No of Contacts in Phone/Fields
Call records (received/Dialled/Missed)
CCaalleennddaarr
Type of view 
Scheduler 
Send note
MMiicceellllaanneeoouuss  ffeeaattuurreess
Alarm/World Clock 
Calculator/Converter
FM Radio/Flashlight 
WAP/GPRS
Games provided/Number

Pocketability
Ergonomics 
Typing speed and ease of use
Signal reception 
Voice clarity 

Grand Total
Price
VFM
Grade

O
VE

RA
LL

 S
CO

RE
U

SA
B

IL
IT

Y

AAllccaatteell
OOnneeTToouucchh  332200

Internal
80

106x45x20
Dual band

120
6

Mono/112x64/2
polyphonic/15

100/3
20/20/20

Monthly
✔

✔

✔/NA
✔/✔
✖/ ✖
✔/✖
✔/3

3
3

2.5
2.5
2.5

58.75
3450

1.7

BBeennqq
MM556600GG

Internal
79

99x42x18
Dual band

210
3

Mono/NA/3
Polyphonic/NA

500/5
10/10/10

Montlhy
✔

✔

✔/✖
✔/✖
✖/ ✖
✔/✔
✔/2

3.5
4
3

3.5
3.5

70.57
4450

1.5

AAllccaatteell
OOnneeTToouucchh  333311

Internal
77

98x42x20
Dual band

280
6

Mono/96X65 /3 
Polyphonic/35

250/3 
10 / 10 / 10

None
✔

✖

✔/✖
✔/✔
✖/✖
✔/✖
✔/3

4
4

3.5
3

3.5

67.51
2990
2.3

BBeennqq
SS663300ii

External 
81

84.9x46x19.3
Dual band

210
3.5

Mono/98x65/3
Standard/NA

100/1 
10/10/10

None
None
None

✔/✖
✔/✖
✖✖

✔/✖
✔/4

2.5
3
3

3.5
3.5

58.82
4990

1.2

LLGG  
GG11550000

Internal 
85

107x43x22
Dual band

250
4

Mono/128x64/2
polyphonic/15

200/5
20/20/20

Monthly
✔

✖

✔/✔
✔/✔
✖/✖
✔/✖
✔/3

3.5
3
4
3
3

63.1
4800

1.3

BBeennqq
SS662200ii

External 
80

84.9x46x19.2
Dual band

210
3.5

Mono/98x65/2
Standard/NA

100/1 
10/10/10

None
None
None

✔/✖
✔/✖
✖/✖
✔/✖
✔/4

2.5
3
3

3.5
3.5

58.82
4990

1.2

BBiirrdd
SS11116600

External 
83

85x44x19.6
Dual band

100
2

Mono/112x64 /2 
Polyphonic/NA

NA
NA

Monthly
✔

✖

✔/✔
✔/✔
✖/✖
✔/✖
✔/3

3
3
4
3

2.5

58.05
4299
1.4

PPhhiilliippss
333300

External
78

83x43x22
Dual band

400
4.5

Mono/101x80/6 
Polyphonic/30

300/8 
10/10/10

Monthly, weekly
✔

✖

✔/✖
✔/✔
✖/✖
✔/✖
✔/1

3
3.5
3
3
3

63.86
4660

1.4

NNookkiiaa
11110000

Internal 
86

107x46x20
Dual band

400
4.5

Mono/96x65/3
Standard/35

50/1
10/10/10

None
None
None

✔/✖
✔/✖
✖/✔
✔/✖
✔/2

3.5
4

4.5
4
4

68.81
4699

1.5

BASIC PHONES
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With cell phones becoming part of everyday life, let us
take a closer look now at some widely used mid-
range phones, and identify the model with the right

balance of style, features, usability and performance. After all,
who doesn’t long for that perfect phone.

We will discuss cell phones that comprise the mid-range
category. Priced at Rs 5,000 and above, these phones offer
more than just mere basic features. They are essentially visu-
ally appealing, and not meant for just calling and messaging.
People obsessed with colour screens, and managing personal
information on their cell phones opt for these handsets.
However, camera phones and Java-enabled sets don’t fall into
this category.

Mid-range phones come with a variety of interesting
options—ranging from simple monochrome screens to the
exquisite and lively 270K coloured ones. Despite the craze over
rich 270K colour screens, most of today’s mid-range cell
phones are still in the modest 4K colour domain, with features
that are, after all, decent enough for the average user.  

Users of mid-range phones experience much better
connectivity while travelling. There are obviously several other

features that make these phones handy while on 
the go.

The table clearly shows that mid-range phones
throw open lot of options when it comes to the
number of brands available. Top brands, such as
Nokia, Samsung, LG, Sony-Ericsson and
Motorola, all thrive on the category of mid-
range sets. Even lesser known names in the
market, such as BenQ and Pantech, offer at
least one mid-range model. Already, Philips,
Sagem and Panasonic are fighting for a
foothold in the mid-range domain with
some really good models. 

The Koreans stand taller than the
others (no, we’re not being sarcastic or
punning here) when it comes to style and
class. Korean manufacturers have invari-
ably come up with the best-looking

compact flip
phones. Samsung’s
SGH-X430 and
SGH-S500, LG’s

G7030 and Pantech’s
G300, are real beauties.
The Pantech G300 is
exceptionally striking—
with its splendid,
contoured body, stylish
looks and compact size, it
will definitely appeal to the
fairer sex. Following closely
on the heels of these flip
phones was the elegant look-
ing Philips 630.

Nothing beats the Nokia
2300 when it comes to the candy
bar look. Exhibiting a complete new
design by playing on the keys, The
2300, with a brand new design and
spectacular layout
of keys, can make
you forget that it is,
after all, a mere

phone. Bird’s S288 is easily the slimmest cell phone we have
come across, and it actually looks like a colourful candy bar. 

The impressive aluminium finish of the
Phillips 9@9++ sets it apart from other
contemporary models. Phones from Sagem,
though, are modelled to resemble the
popular Nokia sets, without any distinct
design or style of their own. BenQ, Alcatel
and Siemens models are not too impres-
sive in terms of looks. Some are too dull
looking, while others are way too flashy
to be impressive—many of them resem-
ble other phones from the past. Sony-
Ericsson’s T230 at least sports a unique
look, though its rectangular body with
chiselled edges can hardly be called eye-
candy. 

Panasonic, the all-time specialist in
Bonsai models, has done it yet again
with the smart EB-G51. But for the
jutting antenna, the G51 really fits
perfectly into your palm. Motorola

LG G7030
Rating: C–   
Price: Rs 13,000

Nokia2300
Rating: B+    
Price: Rs 6,919

PHONES

Samsung SGH-S500
Rating: C    
Price: Rs 11,499

M I D - R A N G E



also packs some impressive features into the C350E. The small
screen aside, coloured buttons, white backlight and the
matching body, give this cell phone an overall great
look.

Coming to ergonomics and usability, the
Koreans have tasted success by emulating Finnish
phone makers Nokia. In the range of flip phones,
LG’s G7030 is easily the model with the perfect
layout of buttons, a great tactile feel and a splen-
did menu interface that is simple to navigate.
Closely following this model are both the phones
from Samsung. They have an equally good menu
interface—totally different from the LG set, but still
simple to operate. The grouping of menus is simply
immaculate. Nokia switchers will find it easy to relate
to them.

On the other hand, Pantech dons a more colourful
and lively menu that is very appealing. However, using
this model over a sustained period of time might make
you feel that the colourful animation is overdone.
The Philips 630 has a simple and straight forward
approach to menu interface and button layout. The
simplicity of the interface makes up for the lack of

a flashy look.
Despite the odd shape and layout of the keypad,

Nokia’s 2300 works without any hiccups. The BenQ
M555C boasts of a great five-way rocker key and an
easy-to-use menu interface. Sagem phones use the
same approach that Nokia uses—a combination of a
four-way rocker key with two soft keys. Sony-Erics-
son’s T230, Motorola’s C350E, Siemens’ A60 and
Philips’ 9@9++, all work on the same approach of
four-way rocker and two soft buttons for browsing
the menu. In fact, Bird’s S288 is the only phone
that uses a two-way rocker for menu browsing,
which is really cumbersome. 

Those on the lookout for feather-light hand-
sets should know that the S288 from Bird is the
lightest and slimmest phone available today—
it weighs just 65 grams. The sleek Samsung
SGH-X430 follows closely with 73 grams. The
additional weight is solely due to the flip form

factor, which makes the set bulkier. EB-G51, the
light Panasonic model, is the ideal for people
who are choosy about phones that are light and
fit perfectly in the smallest of places. Even

test drive ■
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Bird S288
Rating: B+    
Price: Rs 5,499

CATEGORY CELL PHONE MID-RANGE

FE
A

T
U

R
ES

BBrraanndd
MMooddeell
Basic features
Antenna
Weight (gm)
Dimensions (mm)
Network band support
Rated standby time (hours)
Rated talk time (hours)
Display screen
Number of colours
Resolution 
No of lines of text
In-built ringtones type 
No of contacts in Phone / Fields
Call records ( received / dialled / missed)
Calendaring
Type of view 
Scheduler 
Send note
Micellaneous features
Alarm / World clock 
Calculator / Converter
Handsfree / Voice recorder
FM Radio 
WAP / GPRS
Number of games

Pocketability
Ergonomics 
Typing speed and ease of use
Signal reception 
Voice clarity 

Grand Total
Price
VFM
GradeFI

NA
L 

SC
O

RE
U

SA
B

IL
IT

Y

AAllccaatteell
OOnneettoouucchh  553355

Internal 
88

106 x 47 x 20
Dual Band

260
6

4096
128 x 128

4
Polyphonic 

800 / 10
10 / 10 / 10

Monthly, Weekly
✔

✔

✔/✔
✔/✔
✔/✔

✖

✔/✔
✔/ 2

3.25
4

2.5
3.5
3.5

71.26
6450
1.10

BBeennqq
MM555555CC  

Internal 
80

99 x 42 x 18
Dual Band

210
4

4096
128 x 128

4
Polyphonic 

NA
10 / 10 / 10

Monthly, Weekly
✔

✔

✔/✖
✔/✖
✖/✖
✖

✔/✔
✔/ 2

4
3.75

3
3.5
3.5

68.52
5990
1.14

BBiirrdd
SS11119900

External
78

85.3 x 44.2 x 20.8
Dual Band

150
5

4096
128 x 128

4
Polyphonic 

200
10 / 10 / 10

None
None
None

✔/✖
✔/✔
✖/✖
✖

✖/✖
✔/ 3

3.5
3
2
3
3

48.95
5999
0.82

LLGG  
GG33110000

Internal 
85

84x44x20.5
Dual Band

200
2

4096
128 x 128

4
Polyphonic 

150
10 / 10 / 10

Monthly, Weekly
✔

✔

✔/✔
✔/✖
✖/✖
✖

✔/✔
✔/ 1

3.25
3.5
3.75

3
3

63.85
6900
0.93

LLGG  
GG77003300

External 
88

85 x 45 x 23
Dual Band

200
2.5

65,000
128 x 128

5
Polyphonic 

255 / 3 
10 / 10 / 10

Monthly , Weekly
✔

✔

✔/✔
✔/✔
✔/✔

✖

✔/✔
✔/ 1

3.25
4
4

3.5
3.5

72.45
13000
0.56

MMoottoorroollaa
CC335500EE

Internal 
85
NA

Dual Band
215
4.5

4096
128 x 128

4
Polyphonic 

100
10 / 10 / 10

Monthly , Weekly
✔

✔

✔/✔
✔/✔
✖/✖
✖

✔/✔
✔/ 2

3.5
3.25
2.5
3.5
3.5

67.06
5545
1.21

NNookkiiaa
22330000

Internal 
92

107 x 46 x 21
Dual Band

400
4.5

Mono
128 x 128

4
Polyphonic 

50
10 / 10 / 10

None
None
✔

✔/✖
✔/✖
✔/✖
✔

✖/✖
✔/ 2

3.5
3.75
4.5
4
4

72.77
6919
1.05

BBiirrdd  
SS228888

Internal 
65

103 x 44 x12
Dual Band

220
2.5

Mono
128 x 128

4
Polyphonic 

300
10 / 10 / 10

None
None
None

✔/✔
✔/✔
✔/✖

✖

✔/✖
✔/ 3

4.5
3.5
2
2
2

54.97
5499
1.00



BenQ’s M555C is a remarkably compact model. 
Now, coming to display screens, most of the phones sport

a 4,000-colour screen. Nokia 2300, Bird S288 and Philips
9@9++ sport mono-chromatic screens. While Nokia 2300 and
Philips 9@9++ use white backlight, the S288 from Bird has a
very rich blue backlight. Of all these, the
Nokia 2300 gets the nod. 

The Sagem phones are next in line,
with both the My X-2 and My X-5 sport-
ing 256-colour screens. Though the colour
screen offers a slightly better resolution,
the colours themselves aren’t lively—they
lack in depth and saturation. Of course,
these 256-colour screens still look way
better than monochrome ones. 

Amongst the 4,000-colour (4K-colour)
screen phones, the Bird S1190 is just a
sorry sight—it lacks colour depth and
richness. In fact, the model can be
mistaken for a 256-colour screen set. Alca-
tel’s Onetouch 535 comes with a large colour screen that
makes reading messages not just easy, but a pleasure. The Pana-
sonic EB-G51 and Motorola C350E have decent colour screens,

but the screens are way too small. Sagem’s My X-3-2 comes
with a 4K-colour screen and is definitely better than the other
two Sagem models. The Philips 630, LG 3100 and Siemens
A60, all have good colour screens. One practical problem that
all these phones have in common, is the fact that they’re all

quite unreadable in direct sunlight.
Siemens models, in particular, draw a lot
of flak for this problem.  

For colour screens, the top honours go,
once again, to the Koreans. The G300 from
Pantech with its 270K colour screen makes
the screen really come alive with colours
that are vibrant and true-to-life. Even
though the screen is quite small, the reso-
lution is wonderful, and you can read four
lines of text perfectly. With animated
menus and sharp colours, these handsets
are certainly bound to grab everybody’s
attention. 

Samsung has introduced the 65K-
colour screen in two of its models—the SGH-X430 and SGH-
S500 have excellent colour screens that are several notches
better than lower-end phones in this category. 
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PPaannaassoonniicc
EEBB-GG5511

External 
78

80 x 43 x 19
Dual Band

200
6

4096
128 x 128

5
Polyphonic

255
10 / 10 / 10

Monthly , weekly
✔

✔

✔/✖
✔/✔
✔/✖

✖

✔/✔
✔/ 2

4.5
2.5
2
3
3

61.9
6990
0.89

PPaanntteecchh
GG330000

External
75

76 x 40 x 23.5
Dual Band

150
3

256, 000
128 x 128

4
Polyphonic

800
10 / 10 / 10

Monthly , weekly
✔

✔

✔/✖
✔/✔
✖/✔

✖

✔/✔
✔/ 2

4
3.5
3

3.5
3.5

74.86
13995
0.53

PPhhiilliippss
663300

External
78

83 x 43 x 22
Dual Band

200
2.5

4096
128 x 128

5
Polyphonic

300 / 3
10 / 10 / 10

Monthly , weekly
✔

✔

✔/✔
✔/✖
✔/✖
✔

✔/✔
✔/ 2

3.5
3.25

3
3.5
3.5

69.36
8890
0.78

SSoonnyy-EErriiccssssoonn
TT223300

Internal 
79

101 x 44 x 19
Dual Band

275
7

4096
101 x 80

5
Polyphonic

250
10 / 10 / 10

None
✔

✔

✔/✖
✔/✖
✖/✔

✖

✔/✔
✔/ 2

3.75
3.5
3.75
3.25
3.25

68.21
5495
1.24

PPhhiilliippss
XXeennuuiimm  99@@99++++

Internal 
93

108 x 44 x 20
Dual Band
30 days
14 days

Mono
128 x 128

5
Polyphonic

500 / 5
10 / 10 / 10

Monthly , weekly
✔

✔

✔/✔
✔/✖
✔/✔

✖

✔/✔
✔/ 2

3
3.25

3
3.5
3

65.36
5320
1.23

SSaammssuunngg
SSGGHH-XX443300

External 
73

80 x 42 x 20
Dual Band

260
3.5

65,000
128 x 128

4
Polyphonic

500
10 / 10 / 10

Monthly , weekly
✔

✔

✔/✔
✔/✔
✖/✖
✖

✔/✔
✔/ 2

3
3.75
3.5
4
4

73.91
9649
0.77

SSaammssuunngg
SSGGHH-SS550000

External
80

83 x 43 x 22
Dual Band

550
5

65,000
128 * 160

4
Polyphonic

500
10 / 10 / 10

Monthly , weekly
✔

✔

✔/✔
✔/✔
✖/✖
✖

✔/✔
✔/ 3

3
3.75
3.5
4
4

74.91
11499
0.65

SSaaggeemm
MMYY  XX-22

Internal
89

99 x 45 x 21
Dual Band

340
5

256
101 x 80

4
Polyphonic

250
NA

None
None
None

✔/✖
✔/✔
✖/✖
✖

✔/✖
✔/ 2

3.5
3
3

3.5
3.5

54.75
5199
1.05

SSaaggeemm
MMYY  XX-33-22  

Internal
89

100 x 45 x 21
Dual Band

340
5

4096
101 x 80

4
Polyphonic

500
20 / 20 / 20

None
None
None

✔/✖
✔/✔
✔/✖

✖

✔/✔
✔/ 2

3.5
3.5
3.5
3.5
3.5

59.3
6199
0.96

SSaaggeemm
MMYY  XX-55mm

Internal
92

105 x 46 x 20
Dual Band

240
4

256
NA
3

Polyphonic
300

10 / 10 / 10

None
None
None

✔/✔
✔/✔
✖/✖
✖

✔/✔
✔/ 2

2.5
4

3.5
3.5
3.5

63.76
6699
0.95

SSiieemmeennss
AA6600

Internal
85

110 x 47 x 23
Tri-band

250
5

4096
101 x 80

3
Polyphonic

100
10 / 10 / 10

None
None
None

✔/✖
✔/✔
✔/✔

✖

✔/✔
✔/ 2

3
3.5
4
4
4

71.96
7000
1.03



The messaging system varies greatly from one
set to another. While messaging is pure fun on
some phones, it can be a really miserable experi-
ence on others. Predictive text input, or T9, plays
a big role in the messaging experience of 
a phone. 

Motorola and BenQ phones use the iTap
method of input, where you have to hit enter
after typing each and every word. Obviously
this is a cumbersome process, and Nokia,
Samsung and LG have a much more user-
friendly technique.

The messaging system on Nokia phones
is not just extremely easy to use, but also a
pleasurable experience. On these sets, the
predictive input works perfectly, and the
interface is intuitive enough to predict the
word correctly at the first go. Samsung and
LG, instead of reinventing the wheel, took
a feather off the Finnish maker and intro-
duced its messaging system in their own
models. 

The SGH-X430 and SGH-S500 from Samsung, and LG
G3100 and G7030, have a wonderful messaging system that is
very simple to use. Since most Korean sets are flip phones,
they have a well spaced keypad layout that comes in handy
when typing a message. Another thing about the flip phones
is that the colour screens are large, and can easily display four
lines of text. In fact, Samsung is way ahead of the others, as
the fonts on the Samsung screen are large and exceptionally
clear. 

On the Bird S1190, the fonts are way too small. Even the
keypad is not comfortable to type messages with. The 9@9++
from Philips has a messaging interface that can be described
as decent and usable. There’s no doubt about the fact that
messaging is easy with the Nokia 2300, but does take a while
to get used to the wacky keypad.

Sagem’s My X-2 offers a good interface, but a major glitch
is that the rubber keys lack
tactile feedback. Thankfully,

the other two models from
Sagem don’t have this problem.

The Onetouch 535 from
Alcatel has great buttons, but
the messaging system on this
model is a complete let down.
Blame this on the poor accuracy
of its predictive input method. 

The BenQ M555C’s cumber-
some iTap method is painful to use,
despite having a decent interface. 

Panasonic pays the price for its
small buttons heavily. The keys on its
model—the EB-G51—don’t have
markings on them. Instead, they are
printed on the body itself. As a result,

the backlight pretty much does not
serve its purpose when it comes to
typing in the dark.

Barring the Philips Xenium
9@9++, all the other cell phones in

this category have polyphonic ringtones. The higher-end
phones—the Samsung, LG and Pantech models—have
the luxury of loading melodies using the sync soft-
ware. On the rest, you can download ringtones via
GPRS.   

Coming to personal information management
(PIM), the higher-end phones have the right variety
and number of features. The PIM functions are much
better than those on basic phones. But these functions
are way behind smart phones or, for that matter, PDA
phones. The Samsung, Pantech and some of the phones
from LG have a useful calendar option. This feature
entails scheduling and fields for events. In addition to
that, these handsets also feature ‘To do’ lists, reminders
and alarms. 

Samsung offers almost 9 MB of memory on its cell
phone. This memory is shared for messages, events and PIM

functions. Alcatel’s Onetouch 535 also boasts of a decent
PIM. The M555C from BenQ closely follows the high
end phones, if the handful of
features it packs are any indi-
cation.

The Philips 9@9++ comes with
one of the best PIM features. The
My X-2 and My X-5 from Sagem are
quite disappointing, as they don’t
have proper PIM functions. The
Siemens A60 has exactly the same
problem. 

Sadly, connectivity options are
quite limited in these mid-range
phones. Most have infrared connec-
tivity or serial connectivity. Samsung’s
S500, LG’s G7030 and the Pantech
G300, are all infrared enabled.

Except for the Nokia 2300, all the
other handsets in this category are WAP-
enabled. GPRS is also a common feature
with most of the phones, except for the
Bird and Nokia sets.

The Nokia 2300 and Philips 630,
both boast of an FM receiver that
allows you to tune into radio stations.
Even headsets are bundled with these
two models, so you can tune in to
your favourite radio stations immediately. The Nokia model
also allows you to listen to the radio using the handsfree
speaker. All you need to do is to plug in the headset. 

With the scrutiny over, two phones emerge as the
contenders for the winner’s tag. Both the Samsung SGH-S500
and the Pantech G300 stand out as the cell phones with the
right balance of cool features and exceptional performance.
And both these models are on par in the race for the perfect
cell phone.

Of course, there are a few differences. While Pantech
boasts of a 270K colour screen, the Samsung model dons a 65K
colour screen. And when it comes to better ergonomics,
wonderful keypad layout, exquisite display screen and smooth
signal reception, the Samsung S500 definitely edges past the
Pantech G300. We recommend both phones, the final choice
is yours!
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Sagem MyX-3-2
Rating: B    
Price: Rs 6,199

Philips 630
Rating: B–    
Price: Rs 8,890

Pantech G300
Rating: C–    
Price: Rs 13,995
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Designed with an eye for detail, the Panasonic X70 looks more
like a piece of jewellery than a phone. 

Priced at Rs 17,000, it’s a good buy. It’s competition for the
equally well-balanced SE-Z600, which costs the same and

offers the same features.
Although its dimensions don’t really make it

compact, the phone is sleek and comfortable to hold.
The external black and white LCD is long, and

displays time in analogue and digital formats
in idle mode. The TFT display is large and
bright. The keys are of transparent smoked
plastic with white legends etched on—all this

illuminated by a white backlight. The keys are
a little too flat, though—they should be raised a
little for comfortable typing. A recessed four-direc-
tional jog-dial makes for easy menu browsing.

The grouping of functions in the menu is
counter-intuitive. As an example, the Bluetooth

settings were in some odd menu, and we had to
browse through a whole bunch of sub-menus to find it.

The integrated camera comes with a photo-light that doubles
up as a torch. Camera resolution is severely limited, though, and the
snaps were no bigger than standard thumbnails in Windows XP. 

The X70 comes with infrared and Bluetooth. Other salient
features include tri-band compatibility and voice recording.
However, this phone does not support Java applications. 

The games provided are superb, especially Skater, which will
keep you engrossed for hours. 

Panasonic X70 B-B-Price: Rs 17,000

Priced sensibly at Rs 11,360, the 535 integrates the Philips
sound system. A successor to the 530 mobile phone, the new

535 comes with some additional frills. The design is unusual, so
you’ll like the phone if you want to break free of the Nokia and

Sony Ericsson mould.
The model we reviewed was finished in

deep scarlet with matte silver touches. It has
a unisex appeal. 

Its keypad is reasonably good. The keys
offer the right tactile feedback, and the
joystick is fun to use, though at times it gets
a bit jittery and jumps to the wrong menu.
Dedicated buttons make life easy when
browsing the menu.

Its small 128 x 128 screen looks quite
blurry, too. In daylight, the screen goes
pale, but is still readable. 

The 535 comes with an integrated VGA
camera supporting a maximum resolution of

640 x 480 and a minimum of 128 x128. Images are
saved as JPEGs. The settings offered are colour modes, quality,
resolutions and night shots. Images don’t look that great on the
phone’s screen. They looked much better when they were trans-

Philips 535 A-A-Price: Rs 11,360

The OneTouch 735 is priced at Rs 9,995, which is good given its
feature set: Java support, WAP, GPRS and infrared, and a camera. 
The brushed metal front with the chrome plated edge gives it

a zingy look that should appeal to the younger generation. 
The keys feel a little hard on the fingers, and because of the

narrower lower body, the keys are small, too.
Menu navigation is via a joystick-key in the middle. This makes

for very easy handling, as one button performs most of the navi-
gation tasks. The key implementation is further complemented by
a Windows-like menu approach—its main sections are arranged
horizontally and the sub-sections vertically. 

You can switch from standard menu icons to the ‘mosaic’ style,

where all icons are displayed in a single window.
SMSing is fast and accurate, and predictive

typing is good. The only problem is the small keys,
which makes the typing tiresome. 

The phonebook has predefined folders such as
personal, general, etc, which let you save contacts
accordingly. You can assign a melody to a direc-
tory, or an image to a contact. However, if a
contact is stored on the SIM, you can’t assign an
image to it. Voice recognition, too, will not work with
contacts on the SIM. 

The phone has a great game feature—once you get
into Game mode, the screen changes from portrait to
landscape mode. The camera is decent. The screen however, is just
a 4K colour screen.

The One Touch 735 can be connected to a PC via infrared,
for which the PC Software Suite is provided. But strangely
enough, there’s no data cable bundled, so we couldn’t transfer
data from or sync the phone with a PC.

Alcatel OneTouch 735 AAPrice: Rs 9,995

PHONESC A M E R A
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The Motorola E365 comes for Rs 12,995, which is good for a
handset that has a camera and five preloaded games, and

supports GPRS and WAP.
The screen is very hard to read when the backlight is not on.

This is the case even in a sufficiently lit room.
This phone sports an ‘industrial’ type

of design with a dual-tone body colour,
making it more appealing 

to those who prefer some-
thing sober. Women might
not like the design. The
128 x 160, 65K screen is
sufficiently large for 
most tasks.

The phone has a
rather cramped keypad
with round,
contoured keys that
make it difficult to
type. They also
don’t offer smooth tactile feel, and so
typing long messages can be tiring.

The camera at the back is 640 x 480.
It’s intelligently shielded from damage,

because it’s located in a small cavity. A lens
cover is also provided.

Two shortcut keys are provided on the screen for messages
and WAP. However, the menu structure is such that getting to the
Phonebook requires a total of five clicks. To avoid these five
clicks, the phone has a function called Turbo Dial. It lets you
access numbers by pressing a digit from 0 to 9 for more than two
seconds. You can store ten numbers this way.

Motorola E365 BBPrice: Rs 12,995

in the dark, but the keys are not finger-
friendly—typing text messages is a
headache. 

Its menu is not difficult to use. Also,
you can use the four-way key and 2
function buttons to invoke commonly
used features, but sadly these shortcuts
cannot be customised.

The camera is another interesting
add-on. It’s placed at the bottom-left
corner and has a single, multiple (9-
images) option and a video-shoot
option. Video recordings can only be 10
seconds—sound not included. 

Coming to messaging, the T9 is not
that good and automatic capitalisation is nowhere in sight. This
means more clicks to switch between capital and small letters.

Owing to its small size, and different design, the GEO
GV880 is more of a life style product
rather than a productivity tool, which is
perhaps the reason behind the lack of
features such as Bluetooth, IR, etc. At Rs
24,999, it appears to be a phone for the
Page 3 glitterati!

The G500’s clamshell design coupled with
its silver body will appeal to the fairer sex

instantly. Its external LCD is one of the
biggest to be found on any flip phone.
Supporting  262K-colours, the 128x128-pixel

screen comes in handy to click self-portrait photos, read SMSes
and peruse the call list. 

The keypad offers good tactile feel, but the button layout fails
to evoke interest. There’s hardly any space between the naviga-
tion keys and a function key. 

Its messaging system is in a mess. The T9
input is not very effective and capital letters are
not detected automatically. This means you have
to change the letters from lowercase to upper-
case manually.

The internal LCD is 128 x 160 pixels in size,
and supports 262K colours as well.  

The VGA camera is placed at the top of
the flip. A flash light is also bundled along.
The only sore point is its protruding antenna
which makes it a bit cumbersome to carry
around.

The Pantech G500 does have a voice-
recording facility, but sadly, the recording can
only be 30 seconds long. There’s just one
game bundled along. 

The accompanying CD-ROM has addi-
tional ringtones and images. Also in the
bundle were a serial data cable, handsfree
set and an extra battery. At Rs 25,995, it’s
just too costly, considering the fact that it lacks
connectivity options such as Bluetooth.

Pantech G500 C-C-Price: Rs 25,995

If you are looking for a phone with an unusual look, then the
GV880 might appeal to you. It’s very untraditionally square

and is coupled with a pearly white clamshell design that’s quite
aesthetic in its appeal. Had it not been for its antenna, it could
have been easily passed off as a vanity box. It also has a mirror-
like surface on the flip (to check if the lips are done well
perhaps!). Behind this is the 256-colour OLED screen that
shows signal strength, battery life, etc. 

Open the flip and you are greeted with a 128x160-pixel
65K-colour TFT screen that occupies the place most. 

The keypads spread themselves all over the other flip. The
blue backlight makes the keypad look very soothing especially

Geo GV880 C-C-Price: Rs 24,999

ferred onto a Palmtop. A small mirror for a self portrait is also
provided. 

The menu is quite intuitive. One unique feature of the 535
is the Be DJ mixer functionality, which allows editing of pre-
existing tunes, and composing of new tunes for your phone.
We tried our hands at it, and found that it’s too limited to
warrant the ‘DJ’ label. Still, it’s a welcome change. Connectiv-
ity comes in the form of infrared and GPRS.
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The Geo G1 is a dualband flip-phone that features two LCD
displays and an integrated digital camera—a flash and 4X

digital zoom included. Weighing just about 90 gm, it’s flat and
wide, and fits in your pocket easily. The external antenna may
deter you from carrying it in your jeans though.

The chrome bordered external LCD is flanked by two bars that
integrate thin LED that light up when you close the phone flap. 

The external LCD measures 21 x 14 mm and displays battery
status, signal strength, alarm and profile indicators, as well as
incoming calls or messages. It plays assistant when taking self-
portraits using the camera button located on the side of the
phone. Supporting 260K colours, the main LCD TFT screen
comes alive when you open the phone. It stores 300 contacts,
complete with different numbers for home, cellular, and office

along with data such as e-mail and anniversary.
You can assign contacts to four preset, or three
customisable groups and set different ringtones
for a specific contact, or a whole group. 

The self-timer can be set from 5 to 15
seconds, while the camera can be set to auto,
sunny, cloudy, fluorescent or tungsten mode.
Choose from resolutions that range from 64
x 96, 160 x 120 and 640 x 480 for the image
size. The multi-shot feature can be used to
capture multiple shots at one go. You can
set it to snap 3 to 9 frames at a time. You
can also capture video clips limited to a
10-second duration. These can have a
resolution of 64 x 96, 120x 160 or 176 x
144. You cannot record audio though.

Messaging features include predic-
tive text input, 10 inbuilt templates and
MMS. You can also schedule the phone

to switch on or off automatically. The Geo
G1 also includes two games and ‘Avatar’, an application that
offers you a menu of different face types, eyes, hair, etc, to create
digital personas. These can then be associated to your contacts,
set as backgrounds for the main screen or sent as MMS. 

On the flip side, the phone finds it difficult to detect the
network in areas where the signal strength is weak, and hence
goes into search mode, thus affecting battery life. SMS junkies
may not like the keypad as its keys lack depth—you need to press
them with the tip of your thumb. The Geo G1 is spring-loaded
and hence, is not much of a hassle to use single-handedly. 

The captured images and video clips are fairly decent. The
phone connects to a PC via the serial port using the bundled
cable. The GEOsync software provided lets you synchronise
phone contacts, messages, schedule, memo, To do, images and
melodies stored on the phone. You can also synchronise its
contacts and schedules with Microsoft Outlook. 

The bundled lithium-ion battery that’s thicker (and heav-
ier) by usual standards, lasts for about double the time. An
external desktop charger, a travel charger and a manual that
does not provide any information regarding PC connectivity
are also bundled.

The Geo G1 is a great phone if looks matter the most.
However, considering its network detection problems, poor
application support, lack of support for JAVA applications,
combined with the high price tag, it’s not worth buying. 

Geo G1 C-C-Price: Rs 24,995
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Decision Maker

Minimal features: If you are looking for a basic phone
that’s light on your pocket, say in the range of 
Rs 3,000 to Rs 10,000, and one that can help you with
your routine work, then the phones mentioned here
are the ones for you. 

Mid-range: If you are on the hunt for a phone that has
a good balance of features and performance and does
not cost a bomb (Rs 6,000 to 20,000), choose one of
these models. They have the best balance of feartures
you’ll ever find possible.  

High-end: If you are ready to pay for the best phone in
the market that is packed to the hilt with features,
allows lots of personalisation, then shop around for any
one of these models mentioned here. They are sleek,
suave and are the best in town! 

Basic phone
BenQ M560G,
Nokia 1100,
Philips 330

Nokia 2300,
Philips Xenium
9@9++, BenQ
M555C, Alcatel
OneTouch 535

NA

Colour  phone 
Sony-Ericsson T230,
Alcatel OneTouch
535, Motorola
C350E, Philips 630,
Panasonic EB-G51m

Siemens A60, Philips
630, LG G3100,
Samsung X430

Samsung S500,
Pantech 
G300, LG G7030,
Samsung X430

Camera phone
Alcatel 735,
Siemens C60 

Philips 535,
Siemens M55 

Samsung X600,
Panasonic X70,
Pantech G500,
LG G7100,
Samsung E700

Smart phone
LG G5300i,
Motorola C650

Nokia 6610,
Nokia 6100,
Samsung X600,
LG G5400,
Panasonic EB-X66

Nokia 6600, SE-
T610, SE-Z600,
Nokia 7600

PDA phone
NA

Motorola A760

Sony-Ericsson
P900, AnexTek
SP230
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Nothing can be a more blissful feeling for a game freak than to
vanquish a friend in a 3D encounter at a gaming parlour. If only he
could repeat the same feat on his mobile phone. Well, this is
possible today, if the game on your Bluetooth handset supports a
feature which allows you to play with a friend who also has a
Bluetooth handset.

While Bluetooth is rapidly gaining popularity, IR (Infra Red) has
been standard for a while now, with mobile devices—Bluetooth and
IR modules are flooding the market these days. With these modules,
you can actually transfer data from your cell phone to the PC. They
make life very easy for those who regularly synchronise contacts,
and transfer notes and To Do lists from their phones to their
computers. 

Bluetooth stands out with some great advantages. It doesn’t
have any hassles of line-of-sight. In simple words, it works on radio
frequencies, and not on light waves, as IR does. This means
Bluetooth connectivity will not be disrupted by obstructions.
Contrarily, IR transmission works only on line-of-sight’, and halts
with any obstruction. 

Bluetooth has a much faster data transfer rate of 721 Kbps, as
compared to 115.2 Kbps for IR. Bluetooth’s transfer rate might
seem slow compared to the speedy rates we experience on our PCs.
But given that the device is, after all, just a handset, its rate of
transfer is good enough, with each image being just 40 to 50 KB in
size.

With IR or Bluetooth, you can even transfer notes to your PDA or
laptop. You have the luxury to click images on your camera phone
and immediately transfer it to the PC, or to another handset for
touch-ups.

This comes in handy for groups of people with similar
connectivity options on their handsets. It provides a new dimension
to sharing information, and even lighter moments with friends. This
technology actually saves you a lot of cash, since it cuts down the
need to exchange SMS or MMS images and notes. 

IR-capable printers have been around for a while. Their
popularity is really taking off these days. Canon recently launched a
printer with an IR port that prints any image it receives, directly
from the cell phone—all in a few minutes.

what you need to do, normally, is connect the phone to the PC
using the data cable. The image is then copied to the computer,
viewed, and printed. So, the IR port here saves a lot of time and
trouble—and also eliminates the need for a PC. 

Interestingly, these are just a preview of the devices that are
being made. Many more devices are planned in the future, and all
will communicate with your mobile device to complete almost any
function. Imagine how trendy it would be to be able to use your
PDA-phone to control almost anything you need to do in your
house? Just wait a few years!

Kudos to connectivity
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Conclusion
The sheer number of features, great looks, great LCD display and
good usability saw the Panasonic X70 race ahead of other camera
phones in this category. Despite the fact that other phones have
slightly better cameras, they lost to the X70 on the grounds
mentioned above. The Alcatel Onetouch 735 offers the right
balance between features, performance and price to get the Best
Value recommendation. The Philip's 535 offers good features, and
decent performance to be considered as a good alternative. 



At  an estimated street price of Rs 12,349, the Nokia 6610 offers
the perfect balance of features, looks and price. Its signal recep-

tion is excellent and voice clarity superb. 
Its keypad  is the best we’ve seen on any Nokia phone—it offers

the right amount of tactile feedback. The four-way keypad com-
bined with a super-slick menu interface offers usability that’s best

in its class. There are 12 main menus to choose from.
The radio offers crystal-clear reception, but you

need to plug in the headset even when you’re lis-
tening through the speakerphone, since the set
doubles up as the antenna. The inbuilt ringtones
are audible enough to alert you to incoming calls
—even in noisy areas. 

Introduced a year ago, the Nokia 6610 still
manages to captivate, due to its ample feature set
and clean business looks that should appeal to
most executives. Its candybar design is elegant
and the colours accentuate the ‘executive’ look,
without being too flashy. Weighing 83 gm, the
phone is light and pocketable, though some
might find it a bit stretched out. Though its looks
and features are very similar to those of the 

6100, there are a few minor differences that set 
them apart: For example, this one—the 6610—comes with a stereo
FM receiver.

Its feature set includes a colour display, tri-band compatibility,
wireless Java and MMS, apart from the stereo FM receiver. The 4K
colour screen is a let-down when compared to the dazzling screens
on the new phones from Samsung and LG. The screen also shows
some amount of banding and flicker when playing games. 

Battery life shouldn’t be a concern, since it can last at least three
days with normal usage—up to a maximum of five days.

Nokia 6610 B+B+Price: Rs 12,349

Nokia’s finally come up with a
clamshell-design phone. The

unique thing about this phone is
the cloth-textured ‘Xpress-on’ cov-
ers, which add an element of dash to
the phone. 

Reception is good, and there should
be no problems with voice clarity. The
battery lasts for three to four days with
normal use. Priced at Rs 25,919 the 7200 is
on the higher side compared to rival models.

The two rectangular halves of the phone are
joined by an outward-protruding hinge, giving
the phone a chunky look. While most of the men
in our office weren't impressed, the fairer sex just loved
the idea of having matching textile covers for phones. 

The keypad is nice and big, and the white backlight

Nokia 7200 CCPrice: Rs 25,919

Priced at Rs 18,759, the 7250i stands out for
its feature package and good looks. The

7250i succeeds the beautiful 7210. While the
new phone looks like an exact copy of the
7210, it has improved considerably over its
predecessor.

The new look is accentuated by the use
of plastic cases that look like brushed alu-
minium, giving the phone an element of
distinctness. You can snap on covers of
your choice, too. The 7250i comes with a
very ergonomic keypad.

Owing to better brightness and con-
trast features, its 4K colour screen is bet-
ter than the ones on its cousins, the 6610
and 6100. One feature that sets this
phone apart is the integrated camera,
which supports a maximum resolution of 352
x 288. Options include portrait mode and a self-timer, and the
option to choose between three photo qualities. The phone has 4
MB of memory, so there’s enough space to save photos and install
new applications and games. 

The menu interface is the same old Nokia story—slick and easy-
to-use is how we’d sum it up. Good features include tri-band GSM,
a stereo FM receiver, MMS, GPRS and IrDA. Call quality is good, too,
and the battery lasts for 4 to 5 days if you’re on the phone for a total
of an hour a day. 

Nokia 7250i C+C+Price: Rs 18,759

Priced at Rs 13,039, the Nokia 6100 is the phone
for you if you lust after slim phones (and this

one’s got decent features to boot). This is, in
fact, the slimmest phone Nokia has come up
with so far. Voice is clear and signal reception
quite good. Design-wise, the phone is identi-
cal to Nokia’s 6610—minor tweaks have
reduced its size. The 6100 comes with a new
battery design that slims down the form fac-
tor and gives it a four-day operating range
with normal use.

Usability-wise, the 6100 offers the usual
Nokia menu interface, which is widely
accepted as the best and easiest to use. 
Its small 4K colour screen offers decent vibrancy
and does not pose any readability problems in direct sunlight. You
can read five lines of text in a crisp font on this little screen. Other
features such as tri-band compatibility, MMS, polyphonic ring-
tones, GPRS and Java enhance the usability of  the phone. 

The body sports a good colour combination that gives this

phone the business exec look. However, unlike on other Nokia
phones, it can’t be changed. The keypad offers decent styling, and
the keys respond in a crisp business-like manner and offer good 
tactile feel.

Applications provided are limited, but the 180 KB of free mem-
ory is more than enough for downloading extra applications.

Nokia 6100 B+B+Price: Rs 13,039

PHONES
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does a great job in highlighting the keypad. It looks great, espe-
cially in the dark. The feel of the plastic keys, however, leaves a
lot to be desired.

The screen supports 65K colours, but in contrast to several
Samsung and LG phones, the screen is dull and has poor colour
vibrancy. Also, the screen is extremely small despite the fact that
there is more than enough space for a large screen. The integrated
VGA camera can click at 640 x 480. The pictures we got were
sharp and bright.

Connectivity options include infrared, GPRS and WAP 2.0. An
FM receiver with a stereo headset is bundled along for added fun.

The user interface is classic Nokia. The menu is responsive
and fast compared to other Nokia phones. It’s only when open-
ing media files that you experience some lag. The camera can
also be used to record clips up to 50 seconds long. The voice
recorder allows for a three-minute long recording, and recordings
can be set as ringtones.  

Ringtone volume is quite low, and you’re sure to miss a cou-
ple of calls in noisy environs. However, the vibrator is powerful
enough to make up for the low ring volume. Games such as Bowl-
ing should keep you busy while you’re travelling.

All these features and the original look, however, does not
come cheap, and the phone will set you back by Rs 26,939. If
you're the type that likes to portray individuality and doesn't
care about the money, the Nokia 7600 fits the bill perfectly.

The wackiest design ever on a phone to hit the market comes
in the form of Nokia’s 7600. Love it or hate it, the Nokia

7600 sports the most original design of them all and is a real
attention-grabber.

The design is largely square, with the two opposite ends each
tapered into a smooth curve that gives this phone what they call
a ‘leaf design’. The screen comes
in exactly at the centre, flanked
by buttons on either side. You
need to hold the phone diago-
nally when speaking. The
phone is unusually wide—
this rules out one-handed
operation. 

The keys are arranged in a
linear fashion along the
screen, and it's hard to find the
right key at the first go. More-
over, the keys are quite hard,
and completely lack tactile feed-
back. The four-directional pad and the
soft-keys are better though messaging is a pain on this phone.

The menu structure is borrowed from the series 40 phones—
the 6610, 6100 etc. However, the icons are a complete let-down,
given the fact that the phone has a 65K colour screen capable of
delivering vibrant images. 

The 7600 can play MP3, AAC and MIDI sounds formats, and
you can also set such files as ringtones. Files can be transferred
via Bluetooth or infrared. The phone has 29 MB of internal mem-
ory that cannot be supplemented by MMC cards. 

The integrated camera is quite good by cell phone standards,
and lets you capture clips as well as still images. Clips can be as
long as two and half minutes. One other unique feature of this
phone is that it is WCDMA-capable, meaning that in the near
future, as networks begin supporting such high bandwidth, you
can access services at faster data rates. 

Nokia 7600 CCPrice: Rs 26,939

Weighing just 85 gm, the S55 marks Siemens’ entry into the
business category of mobile phones. The S55 replaces the

S45, and comes with new features such as tri-band GSM, MMS,
Bluetooth, Java, polyphonic ringtones, and a full-fea-
tured PIM. 

Priced at Rs 12,700, the S55 is a great phone
with solid features, but it’s a primitive 256-colour
display is a letdown. The screen severely limits
the usability of the phone and does not do a bit
of justice to the otherwise perfectly-balanced
feature set. 

The subtle use of chrome on select keys
adds a touch of style and contrasts well with
the grey keypad. In fact, it’s the keypad that
gives the S55 its uniqueness. The keys are
arranged in layers that form ridges as you go
down, each layer perfectly separated from the
other. The only gripe we had was with the low-
est layer, where the keys are too small. 

The camera is an external snap-on. It is capable of a resolution
of 640 x 480, but the pictures we captured looked dull and of low
quality on the phone's display. The camera features a flash.

The provided cable comes as a great help when using the
phone as a GPRS modem. Bluetooth works seamlessly. The voice
recorder is good, and the voice command feature works well. Mes-
saging is simple and fast. The menu interface is classic Siemens,
with coloured icons, and make no mistake: the interface is as sim-
ple and easy to use as a Nokia.

Siemens S55 A-A-Price: Rs 12,700

Siemens, with its M55, has come out with a hip
phone that should appeal to the younger gen-

eration. Priced at Rs 9,900, the M55 offers a youth-
ful, dynamic design with good features bundled.

The tone for the looks is set by flashy orange
buttons on a silver-grey background cover. The
earpiece also gets some orange treatment in an
‘X’ shape, with silver grille inserts that pop out
and literally grab attention. To accentuate the
trendy look, you have red LEDs blinking on
both sides of the phone.

Functionality is, however, not compro-
mised upon. The keys are responsive and have
reasonable tactile feedback. The only gripe is
the tiny power on/off button and the answer
button. The menu rocker and the soft-keys
are usable, but may not be as comfortable as
other phones in this category. 

The outer body shell provides shock pro-
tection; on the inside, the M55 is very much
like its brethren—the screen is again 4K

Siemens M55 AAPrice: Rs 9,900
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colours. Also, the phone is quite slow when working with 
images and loading games. However, the messaging system is
quite quick. 

Java application support brings a host of options to install
and try out. Inbuilt games are addictive and should provide
enough fun. Other interesting features include voice commands,
an alarm clock, a calendar and PIM functionality.

The Cubasis ringtone-mixing software offers some limited
DJ-ing capabilities. The external snap-on camera does a good job
at taking photos and comes with a flash. However, the pics you
click don’t look too good on the phone's screen.

We had no problems with voice clarity or signal reception,
and the battery runs the better part of three and half days at nor-
mal usage.

The X600 closely follows its low-market model, the X100, with
some minor changes. It comes with a superb integrated cam-

era, infrared capabilities and an irritating external stub antenna.
Priced at Rs 12,999, the X600 is a good buy, especially because of
the good display and camera. The only thing that can go against
it is the protruding antenna. 

The blue-silver colour combina-
tion makes it to the X600, as with
all Samsung phones. The dimen-
sions are compact, and despite the
presence of the external antenna,
the phone fits comfortably in one’s
hand or pocket. This is one solidly
put together, rugged phone. 

Samsung has done the menu
structure the smart way, bringing
together the better aspects of other
manufacturers’ models. The interface
is simple to understand and fast to
browse. Messaging has also gone the
Nokia way, and predictive texting 
is good.

The most interesting part of this
phone is the rotating camera. This VGA

camera is probably the best we’ve seen on
a cell phone in terms of features offered and

speed of operation. Zooming is superfast—
but avoid zooming too much if you want a

great-quality picture. To complement the camera, Samsung has
put in a good 64K display. The screen is much brighter and more
colourful than those seen on Nokia’s and Siemens’ phones in this
category. The backlight is necessary for viewing the screen in
direct sunlight. 

There are plenty of options for customisation of sound. The
polyphonic ringtones are sufficiently loud, and more melodious
than other models. They don’t sound as good as those on the
E700, though.

The phone comes with nearly 9 MB of memory—enough for
storing your pictures and Java applications. The only gripe we
have is the lack of Bluetooth capability for transferring images.

The phone gives good voice clarity, and signal reception is
above par. The battery lasts four days with normal use.

Samsung SGH-X600 BBPrice: Rs 12,999

The SGH-E700 is arguably the best-looking clamshell phone to
hit the market in recent times. The phone takes a complete new

direction in the design implementation, and
no cues from the older generation are vis-
ible here.  

The E700 sports the most compact
dimensions in its class. Though the
phone is a clamshell, there are hardly any
protruding edges—even the antenna is
inbuilt. The upper flap has a small OLED
display that shows the time and caller ID.
Just above the display is the lens for the
integrated camera. 

Priced at Rs 22,599, the phone is quite
expensive, considering the lack of tri-band sup-
port and Bluetooth. 

The keypad is flat, black and reasonably
large. A small chrome stud separates the keys,
which are tactile, responsive and great for typing
messages. The four way rocker works great, and
also has pre-defined shortcuts. 

The screen on the E700 is the best we’ve seen
on any phone in this category, barring the Nokia
6600. The screen is bright enough to be used as a
torch and colourful to the extent that you might imag-
ine watching movies on it; it’s sad you can’t do that as yet. 

The menu interface is the same, tried and tested one used on
all other Samsung phones. Animated wallpapers and screensavers
make good use of the colourful screen.  The messaging system is fast
and easy to use. The T9 text prediction is accurate.

The E700 comes with a fairly good integrated camera. There
are a host of options such as multi-shot, night mode, self-shot etc.
You can even change the exposure settings, which allows you to
make the picture more bright.

The phone comes with around 9 MB of memory—large enough
for storing lots of pictures and other applications. Bluetooth some-
how doesn’t make it to this phone; connectivity options include
infrared and GPRS. 

The E700 has decent signal reception and the voice clarity 
is good. The battery works for three days before dying, with 
normal usage.

Samsung SGH-E700 CCPrice: Rs 22,599

The G5400 is a modest-looking, understated phone. It has
all the essentials and the functionality is good. On the

whole, however, at Rs 13,000 this phone is priced normally
for the features it offers.

The design is elegant with nothing flashy about it. We reviewed
the phone with an all-silver body; it looks monotonous—look out
for the blue-silver combination, which looks much better. An LCD
on the top cover works as the caller ID-cum-watch.

The keypad is one of the best-laid out keypads we’ve seen. There
is ample space between the buttons, which are flat but highly
responsive. The four-direction rocker and the soft-keys are a bit too
closely placed.

The menu interface is similar on all LG phones, and we liked
it. It is arranged vertically, and as you go down, icons pop up telling

LG G5400 B-B-Price: Rs 13,000
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you about the functions. This kind of menu is
visually appealing, and Nokia loyalty-
switchers shouldn’t find it hard to get 
accustomed to.

The screen is one more aspect of this
phone that should appeal to many. The 64K
colour screen is fantastic in terms of colour
saturation, and images look vivid and life-
like. The animated wallpapers make great
use of the screen.

Connectivity options are via infra-red
and serial cable. The cable is provided with
the set. The sync software is simple and
elegant, but could be better. Java games
can also be installed using the provided
software. Some are provided on the CD-
ROM. 

The reception quality was reasonably
okay and voice was clear, but at times
there was noticeable cracking of speech. The bat-
tery lasts around two and half days, which we think is a bit low.

The X66 is a cute, chubby, visually toned-down version of the
X70. It is quite compact, but not sleek. Despite its size, the X66

packs in a camera and a very good colour display. Priced at
Rs 13,400, the X66 is quite a good buy.       

This blue X66 that we reviewed does not look as good as the
X70, but is reasonably attractive. It lacks an external LCD display,
but to compensate, it has a multi-colour LED integrated, which

blinks in different colours: it blinks red for voice
calls, goes blue for SMS, turns red again if there are
unread messages, and so on.

The keys sport a blue backlight that does a
decent job of highlighting the keys. A four-direc-
tion jog-dial helps browse the menu. The keys
are super-responsive, and the ergonomics are
perfect; typing messages on this phone is pure
delight. In fact, it’s the keys that make this
phone a pleasure to use.

The 64K colour screen is relatively small,
but colour saturation and vividness is perfect.
The screen looks great indoors, but gets dark
outdoors, making it difficult to read. 

Menu grouping takes some time to get
used to especially if you are a Nokia user, but
once you’re used to it, things are a breeze.
Icons are self-explanatory. One particular
feature that is unique to Panasonic is that

you can set the phone to switch on or off auto-
matically after a specific period.

The integrated camera has a small mirror for a self-portrait.
Basic functionality is what you get with this camera, but it does
include a ‘night’ mode. The pics we got were okay, but not any-
where near the ones we shot using the Samsung X600. Ringtones
are pretty standard, but they aren’t loud enough to be audible in
noisy places. You transfer images via infrared. 

The games provided should keep you busy. There’s an inbuilt
Slots game. Signal reception is fairly good, voice clarity is okay, and
so is the battery life—three days with normal use.

Panasonic X66 BBPrice: Rs 13,400

The sheer looks of the Z600 with its changeable covers are
enough to make you want to hold it! The mirror-finish cover

sports attractive colours and catchy patterns, which makes this
phone stand out from the crowd. The keys 
are well laid-out, sufficiently big, and 
have enough space between them to 
facilitate error-free phone number and mes-
sage typing. 

This phone is, however, bigger than
other flip phones and feels bulky. It’s uncom-
fortable to carry in your shirt pocket, and it’s
more comfortable using it hands-free.

The menu of the phone is not different
from other Sony Ericsson phones. It has self-
explanatory icons and a user-friendly, linear
menu style. There are a total of 16 icons dis-
played on the 65K colour screen, which are
crisp and visible in daylight as well. 

The camera on this phone is better than
those of others in its class. The camera lens is on
the edge of the flip, which helps you click snaps.
You can click at 288 x 352 or 120 x 160. Images
are stored in the JPEG format. They can be trans-
ferred to a PC using the cable or Bluetooth, or to
other phones using infrared. The phone has 1,851
KB of space for photos and Java applications. 

A big minus on this phone is that you first need to copy
contacts from the SIM to the Phonebook before you can search
for contacts.

The Z600 is priced at Rs 17,000, and on the whole, provides
good features for the price.

Sony Ericsson Z600 B-B-Price: Rs 17,000

The V878 is priced at Rs 20,495, which is a little too high for this
phone, as it doesn’t have upgradeable memory, nor does it have

infrared or Bluetooth.
The phone sports a dual-tone body with a strong flip. The 

keys offers good tactile feel, but because of the box design, you
might want to hold the phone in one hand and dial numbers with
the other.

Typing SMSes using the iTap method is a little different with
this phone, as it needs you to select the word from a list. It doesn’t
automatically predict it. As an example, when we typed ‘have’, we
were presented with ‘gave’. Here ‘have’ was the second option; we
had to select it from the list before proceeding further. 

The Voice Note feature allows for 30 seconds of recording.
Recording quality was decent. Menu navigation is simple. The 
animated icons are self explanatory, but the placement of icons is 
not great.

The phone is Java-enabled, and the bundled software is inter-
active and helpful. Once the phone is detected on a PC and
installed, it can be used as a GPRS modem. Using software, you can
send and receive e-mails, and send and view messages. You can also
download images and short movies from the phone to the com-
puter. However, the reverse is not possible.

The camera on this phone isn’t too good. Pictures were dark
and unclear. However it allows for four resolution settings—

Motorola V878 CCPrice: Rs 20,495
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readability is affected in the Sun, but is still quite readable. Planning
to buy a new colour phone with loads of features at a reasonable
price? Look no further!

With respect to voice quality, even at the weakest signal
strength, voice was astoundingly clear. While on the move, espe-
cially in trains, the voice does drop, but this could be related to the
network.

The address book allows you to store 510
numbers with 8 different entries each.
This phone doesn’t allow you to view
SIM and phone data simultaneously,
unlike the newer set of phones.

The text messages can be printed
via a Bluetooth connection, and also
saved to the SIM. Support for long mes-
sages is also provided, so you’re not stuck
with a limit of 160 characters. However,
the ‘send To many’ feature is missing. 

The MMS editor is one of the better-
implemented tools we’ve seen across several
phones. It also allows blocking of content such
as advertisements and anonymous users. 

The image quality of the camera is 
no great shakes, obviously due to the low resolu-
tion. A tiny mirror in the back panel allows you to
take your own picture. The phone allows you to store a little over
2 MB of data, if you remove the predefined set of items. Most peo-
ple consider this to be too less, but then, there are already a couple
of games bundled; Sony Ericsson allows you to store images on
their servers; there’s static memory for the phone; and there are
SMS and voice tags. So, 2 MB should be enough for most users.

Battery life is about three days, or not more than 5 days with
minimal use. 

About all the talk about ‘Quick Share’—this is nothing but a
marketing gimmick, based upon the idea that the phone provides
connectivity options such as Bluetooth, infrared and cable.

640 x 480, 320 x 240, 160 x 120 and 128 x 160.
There are also three quality settings—fine,
normal and basic. Other features include
three  white balance settings, and the
capability to click a self-portrait using the
external screen.

Strangely enough, both the internal
and external screens are in use with the

backlight on. This means that battery
power gets drained faster—there is no

option in the menu to switch off the exter-
nal screen.

While talking on the phone, calls get ter-
minated once the signal gets weak. This is prob-

ably the biggest shortcoming on this phone. In
addition, the phone, in our tests, kept losing sig-
nal strength in areas where other phones 
were working.

The ring volume is very low, even when set to
maximum. The vibrator is decent but not effective if

the phone is being carried in a loose pocket or in a purse. This will
probably result in many a missed call, especially while travelling.

Weighing just 91grams and boasting of features such as
MPEG4 playback, WAP, GPRS, Java games and a VGA cam-

era, the price of Rs 10,495 for the Motorola C650 is justified. 
The C650 sports a comfortable keypad layout. Typing mes-

sages is fast using the T9 method. There’s also the
Cut, Copy and Paste feature, so there’s no need
to re-type recurring words in a message.

The screen offers four lines of text. How-
ever, it can only accommodate two words per
line; and if a word is 12 letters or longer, it
displays just one word per line. To add to the
problem, the screen is not readable in day-
light, even with the backlight on. 

The VGA camera offers 4X digital zoom.
The screen size is 128 x 128, and supports
65K colours. The images, however, don't
look all that great, and you get the feeling
you’re looking at a 4K colour screen.

You can assign photos to phonebook
contacts, and also have an MP3 track as
a ringtone.

The phone has a USB interface, which makes
connecting the phone to a system and installing it as simple as
installing any other USB-based peripheral. Once installation is
done, the phone is detected as a USB modem. You can then dial
a number, send and receive e-mail, read messages from the Inbox,
etc, from and on the PC.

Motorola C650 A-A-Price: Rs 10,495

This little beauty, exclusively crafted by Erik Ahlgren, a senior
industrial designer of Sony Ericsson, is targeted at those who

want to make a fashion statement. The crystal-clear 64K colour
screen ensures perfect readability. Since this is not a TFT screen,

Sony Ericsson T610 C+C+Price: Rs 19,900

The clamshell BenQ S670C is good value for money at Rs
13,490. Advertised as a phone with morphing features, the

S670C comes with more than just that.
The upper flap is coated with a jazzy-looking material

that breaks out of the monotonous plastic-look mould. A
small OLED display on the upper flap rotates the time with
a nice scrolling wallpaper. The body has a
chiselled look, except for the jutting
antenna.

Flipping open the phone reveals a
65K colour screen that is relatively sharp
compared to other BenQ models. Menu
browsing is via a jog dial and two soft-
keys. The buttons offer the right tactile
feedback and are fun to use. The dial
pad is well spaced. SMSing does leave
your fingers tired, since the keys are
arranged in a curve. 

The menu is simple to navigate, and
is intuitive enough to get hold of in the
first go. The VGA camera is placed at the

BenQ S670C B-B-Price: Rs 13,490
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rear of the phone at the extreme top left end—this placement is
quite cumbersome, since you need to tilt the phone upwards to
compose a perfect frame. The quality of the photos we took was
decent. The face-morphing application provided with the phone
is easy to use—you need to select four points on a face to be mor-
phed, and then you just press a button.  There are twelve effects
such as ‘happy’, ‘angry’, etc, that can be applied, with five inten-
sities to choose from. 

The S670C supports WAP and GPRS for Internet connectiv-
ity, but lacks infrared or Bluetooth support. The package pro-
vides a serial cable for PC connectivity.

For many cell phone users today, especially among the
younger lot, the display is as important as the phone itself.
Unil as recently as last year, cell phones with colour screens
were very expensive, with most of them offering not more
than 4K colours, a paltry feature compared to what we have
today. With the prices of colour phones taking a nosedive, you
can easily afford one today for less than Rs 10,000.

But the question is, do you really need a colour phone, or
should you stick to a regular model? Since there are several
handsets in the market that still have mono screens with a
variety of backlight options, one should be cautious instead of
blindly jumping for a colour phone. 

If you decide to buy a basic mono screen phone, make
sure that the backlight doesn’t hurt the eyes, and that the
text is easily readable. Your best bet is to opt for a handset
with a white backlight. A white backlight doesn’t put much
stress on your eyes when you read text. Many users are
comfortable using a green backlight, but strictly avoid a blue
backlight—the text hardly stands out against the blue
background of the screen.

For colour phones, 4K colour screens are an option. Phones
with 4K colour are good enough for normal usage and playing
games as well. Though it is a pleasant change from bland
mono screens, don’t expect great-looking, articulate images
on these cell phones.

For a person who is into MMS and e-mail, and is obsessed
with flashy wallpapers and themes, 65K colours is the bare 
minimum. A 65K colour screen supports multi-coloured 
wallpapers, themes and images that you receive from friends, 
or click with your own inbuilt camera.

There are a few models in the market, such as the Pantech
G500, which go a big step further for the screen-freak, providing
262K colour screens. Images on such screens are nothing less
than a feast for the eyes. The exquisite colour saturation and
vivid details can be a captivating experience. 262K colour screens
make games look much more lively and colourful.

Samsung and Motorola have come up with models with
65K OLED screens. Though this technology has been around
for quite some time, OLED (Organic LED) has only recently
been taking to the mainstream. These screens run on much
lesser power (two to ten volts, depending on the size) than
the more widely used TFT LCD screens. OLED screens improve
readability considerably in daylight. Cell phones with this
feature are particularly handy for users who’re looking for,
both, great usability as well as long battery life. 

Do I need a colour phone?

LG’s G5300i is priced at Rs 8,500. It offers a good balance of
features and performance. It will probably see stiff compe-

tition from Nokia’s older 6610, which has
nearly the same feature set, save 64K
colour support.

This phone is compact enough to
easily fit into your pocket. Build quali-
ty is great and the phone feels
rugged—comparable to Nokia’s 3310,
in this respect..

The phone’s looks are somewhat
controversial, in the sense that there
can be contrasting views—some
may like it, some may not. The sil-
ver body has bits of chrome lining
the edges. Blue, smoked translu-
cent plastic runs down the middle
of the keypad, and creates some
contrast with the silver. The menu-
navigation keys are quite hard, but
provide good audible feedback. The key-
pad is slightly cramped and the last line is hard to reach.

The display on this phone is quite small, but the 64K
colour screen offers good colour depth. Watching the wallpa-
pers in their full glory is fun. The 16 polyphonic ringtones are
loud, but not loud enough for noisy areas. The vibrator is
good, though.

The menu interface is good, too, but we’d like to see LG
implementing a four-way directional keypad instead of the
two-way button, which is difficult to use. 

What we liked most about this phone is the Java support.
You can install applications, melodies and games. The G5300i
comes with GPRS and WAP support. Browsing the Net on the
colour screen is fun.

LG G5300i AAPrice: Rs 8,500

The G7100 is the top-of-the-line phone from LG which LG
markets as the ‘rotating camera’ phone. It is very similar

in size and shape to the G7030. At Rs 19,000, the G7100 is a
good product for the price.

There are several good things about
this clamshell phone—Java support,
PC synchronisation using the provided
cable, infrared, GPRS, and very good
wallpapers and screensavers. The
accompanying CD-ROM comes
loaded with melodies, games and
applications that can be installed
via a PC.

The phone comes in a variety
of colours. The keys are large and
fun to use, and the response
offered is perfect in every sense,
making messaging a delight. The
four-way keypad also accesses pre-
defined shortcuts. 

On the upper flip, you have a

LG G7100 CCPrice: Rs 19,000
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round mirrored surface that acts as a mirror in idle mode. The
OLED display under the screen comes live to show the time
and caller ID when you get a call. You can also set pictures to
be displayed on the external screen.

Flipping open the phone reveals a 64K UBF (ultra bright
and fine) LCD display, capable of displaying coloured graph-
ics superbly. However, in direct sunlight, the screen becomes
dark, but is still readable. The flap can be rotated 180 degrees
in the vertical plane and 90 degrees in the horizontal plane.
The VGA camera is on the hinge of the phone, and a small
flashlight assembly is just beneath the lens. The shutter

release button is on one side on the phone. Hence, you need
to hold the phone appropriately when clicking a photograph.
It takes some time to get used to this.

There's considerable tweaking you can do with the cam-
era, and images are decent. The flash can be effective at close
distances, but use it only when necessary—it tends to drain
the battery fast. 

The menu interface is similar to that on other LG phones
such as the G5400 and G7030. The icons are large and self
explanatory, making the interface quite intuitive. The pre-
dictive input method is accurate.
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NA
NA
NA

1.6 MB
✖ 

✖ 

✖ 

✔/✖
✔

✔/✔
✔/✔
✖/✖
✖ 

✔/✔
1

3
3.75

3
3.5
3.5
NA
3

51
8500
0.60

LLGG
G5400

External
85

86 x 46 x22
Dual band

230
3

65,000
128 x 160 

7
Polyphonic

200
20 in all

Monthly
✔

✖ 

NA
NA
NA
NA
NA
NA

1.3 MB
✖ 

✔

✖ 

✔/✔
✔

✔/✔
✔/✔
✖/✔

✖ 

✔/✔
3

3.5
4

4.5
3.5
3.5
NA
3

53.4
13000
0.41

LLGG
G7100

External
101

90 x 48 x 24
Dual band

200
2

65,000
128 x 160 

7
Polyphonic

255
20 in all

Monthly
✔

✖ 

640 x 480
✔

✔

✔

✖ 

✔

1.3 MB
✖ 

✔

✖ 

✔/✔
✔

✔/✔
✔/✔
✖/✔

✖ 

✔/✔
3

3
3.25

4
2
2
2
3

53.3
19000
0.28

MMoottoorroollaa
C650

Internal
85

103 x 44 x 20
Tri-band

215
6

65,000
128x128

6
Polyphonic

1000
10 / 10 / 10

Monthly
✔

✖ 

640 x 480
✖ 

✔

✔

✖ 

✖ 

1.5 MB
✖ 

✖ 

✖ 

✔/✔
✔

✔/✖
✔/✔
✔/✖

✖ 

✔/✔
2

3.5
3.75
3.75
3.5
3.5
2.5
2.75

56.8
10495
0.54

MMoottoorroollaa
V878

External 
85

82 x 42 x 21.5
Tri-band

130
3

65,000
128 x 160 

6
Polyphonic

300
10 / 10 / 10

Monthly
✔

✔

640 x 480
✔

✔

✔

✖ 

✔

NA
✖ 

✖ 

✖ 

✔/✔
✔

✔/✖
✔/✖
✔/✔

✖ 

✔/✔
2

3.5
2.5
3

1.5
1.5
2
3

57.9
20495
0.28

NNookkiiaa
6100

Internal 
76

102 x 44 x 13.5
Tri-band

320
6

4,096
128 x 128

5
Polyphonic

300
10 / 10 / 10

Monthly
✔

✔

NA
NA
NA
NA
NA
NA

725 KB
✖ 

✔

✖ 

✔/✖
✖ 

✔/✖
✔/✔
✔/✖

✖ 

✔/✔
2

4.25
3.75

4
4
4

NA
3

64.65
13039
0.50

NNookkiiaa
6600

Internal
125

109 x 58 x 24
Tri-band

240
4

65,000
176 x 208

6
Polyphonic

Limited by memory
Limited by memory

MonthlyWeeklyDaily
✔

✔

640 x 480
✔

✔

✔

✖ 

✖ 

6 MB shared
✔ -32 MB

✔

✔

✖/✖
✔

✔/✔
✔/✔
✔/✔

✖ 

✔/✔
2

3
4

3.5
4
4

3.5
3.5

75.3
26069
0.29

NNookkiiaa
6610

Internal 
87

106 x 44 x 19
Tri-band

300
4

4,096
128 x 128

5
Polyphonic

300
10 / 10 / 10

Monthly 
✔

✔

NA
NA
NA
NA
NA
NA

625 KB
✖ 

✔

✖ 

✔/✖
✔

✔/✖
✔/✔
✔/✔

✔

✔/✔
2

3.5
4.5
4.5
4
4

NA
3

64.1
12349
0.52

BBeennQQ
S670C

External
80

80.5 x 44 x 22
Tri-band

120
3

65,000
128x128

5
Polyphonic

500
10 / 10 / 10

Monthly
✔

✔

300K Pixels
NA
✔

✔

✖ 

✖ 

300KB
✖ 

✖ 

✖ 

✔/✔
✔

✔/✖
✔/✔
✖ /✖

✖ 

✔/✔
2

3
3

3.25
3.5
3.5
2.75

3

55.75
13490
0.41



Sleek cell phones with inbuilt cameras are shooting up the popularity
charts today. Clicking cool images anywhere and everywhere, with lit-
tle or no storage hassles, is perhaps way too irresistible for many. How-
ever, easily available camera phones can be really detrimental to busi-
ness houses—phones can be easily misused to surreptitiously leak
information from the inside of any office. It is virtually impossible for an
organisation to keep a tag on who is carrying a camera phone. 

Imagine a scenario where a key process, crucial for a new product, is
formulated by the company—say the product isn’t yet introduced in the
market. At this juncture, someone from the core team takes a snap of

the sample product, or a document carrying product information, and
passes it on to a rival company, which is working on a similar product.

Cell phones can be deployed for carrying out industrial sabotage
as well. For example, they can be used to clandestinely supply
images or short video clips of the actual work in a factory to the
competition. Camera phones can also prove dangerous for security
agencies run by the government.

These are just a few examples that indicate that the growing
popularity of camera phones is keeping some factions of society ill
at ease. 

Camera phones and security fears

SSaammssuunngg
SGH-E700

Internal
85

90 x 45 x 23
Dual band

230
3

65,000
128 x 160

6
Polyphonic

1000
20 / 20 / 20

Monthly
✔

✔

640 x 480
✖ 

✔

✔

✖ 

✖ 

600KB
✖ 

✔

✖ 

✔/✖
✔

✔/✖
✔/✔
✖/✖
✖ 

✔/✔
4

4
4
4

3.5
3.5
3
3

59.65
22599
0.26

SSiieemmeennss
C60

Internal
85

110 x 47 x 23
Tri-band

250
6

4,096
101 x 80 

4
Polyphonic

100
10 / 10 / 10

None
None
None

640 x 480
✖ 

✔

✔

✔

✔

1.86 MB
✖ 

✖ 

✖ 

✔/✖
✖ 

✔/✖
✔/✔
✔/✖

✖ 

✔/✔
5

2.75
3.5
3.5
3.5
3.5
3
3

49.75
8000
0.62

SSiieemmeennss
M55

Internal
83

101 x 46 x 21
Tri-band

250
6

4,096
101 x 80 

4
Polyphonic

500
10 / 10 / 10

Monthly
✔

✔

640 x 480
✖ 

✔

✔

✔

✔

1.86 MB
✖ 

✖ 

✖ 

✔/✖
✖ 

✔/✖
✔/✔
✔/✔

✖ 

✔/✔
3

3.25
3

3.25
3.5
3.5
3

2.5

62.65
9900
0.63

SSiieemmeennss
S55

Internal
85

101 x 42 x 18
Tri-band
12 days

6

256
101 x 80 

4
Polyphonic

500
10 / 10 / 10

Monthly
✔

✔

640 x 480
✖ 

✔

✔

✔

✔

400KB
✖ 

✔

✔

✔/✔
✔

✔/✔
✔/✔
✔/✔

✖ 

✔/✔
3

4
4
4

3.5
3.5
3

2.5

67.3
12700
0.53

SSoonnyy-EErriiccssssoonn
T610

Internal
95

102 x 44 x 19
Tri-band

310
14

65,000
128 x 160

6
Polyphonic

500
30 in all

Monthly
✔

✔

352 x 288
✖ 

✔

✔

✖ 

✖ 

2 MB
✖ 

✔

✔

✔/✖
✔

✔/✖
✔/✔
✔/✔

✖ 

✔/✔
3

4
3.75
3.75

3
3

2.5
2

65.9
19995
0.33

NNookkiiaa
7200

Internal 
115

86 x 50 x 26
Dual band

300
5

65,000
128 x 128

5
Polyphonic

500
10 / 10 / 10

Monthly Weekly
✔

✔

640 x 480
✔

✔

✔

✖ 

✖ 

4 MB shared
✖ 

✔

✖ 

✔/✖
✔

✔/✖
✔/✔
✔/✔

✔

✔/✔
3

3.5
4
4
4
4

3.25
3

68.8
25919
0.27

NNookkiiaa
7250i

Internal 
92

105 x 44 x 19
Tri-band

300
5

4,096
128 x 128

5
Polyphonic

500
10 / 10 / 10

Monthly 
✔

✔

352 x 288
✖ 

✔

✔

✖ 

✖ 

3.5 MB
✖ 

✔

✖ 

✔/✖
✔

✔/✖
✔/✔
✔/ ✖

✔

✔/ ✔
3

3.5
4
4
4
4

2.75
3

65.5
18759
0.35

NNookkiiaa
7600

Internal 
123

87 x 78 x 19
WCDMA

170
4

65,000
128 x 160

9
Polyphonic

Limited by memory
20 / 10 / 10

MonthlyWeeklyDaily 
✔

✔

640 x 480
✔

✔

✔

✖ 

✖ 

29 MB
✖ 

✔

✔

✔/✔
✔

✔/✔
✔/✔
✔/✔

✔

✔/✔
✖ 

2.5
2.5
2
4
4

3.25
3.5

71.55
26939
0.27

SSaammssuunngg
SGH-X600

External 
80

102 x 43 x 20
Dual band

360
5

65,000
128 x 160

6
Polyphonic

1000
20 / 20 / 20

Monthly
✔

✔

640 x 480
✖ 

✔

✔

✔

✔

500KB
✖ 

✔

✖ 

✔/✖
✔

✔/✖
✔/✔
✖/✖
✖ 

✔/✔
5

3.5
4
4

3.5
3.5
3
3

60.85
12999
0.47

SSoonnyy-EErriiccssssoonn
Z600

Internal
110

90 x 48 x 28
Tri-band

200
6

65,000
128 x 160

6
Polyphonic

500
20 / 20 / 20

Monthly
✔

✔

353 x 288
✖ 

✔

✔

✖ 

✖ 

1.5 MB
✖ 

✔

✔

✔/✖
✔

✔/✖
✔/✔
✔/✔

✖ 

✔/✔
3

3
3
3
3
3

3.5
2.5

64.35
17000
0.38

PPaannaassoonniicc
EB-X66

External 
82

75 x 45 x 27
Dual band

270
4.5

65,000
128 x 128

7
Polyphonic

300
NA

Monthly  daily
✔

✔

110 K pixels
✖ 

✔

✔

✖ 

✔

4 MB
✖ 

✔

✖ 

✔/✖
✖ 

✔/✖
✔/✔
✔/✔

✖ 

✔/✔
4

3
4
4

3.5
3.5
2
3

58.15
13400
0.43
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The Siemens C60 is a good performer; the voice clarity is good
and reception is clear. At Rs 8,000 for the entire package includ-

ing the camera, the C60 is sensibly priced. SMS junkies, keep away!
We liked the phone’s looks, with its grey-silver outfit and dash

of chrome. The colour panels are exchangeable. The keypad is tra-
ditional Siemens—small buttons, hard to press,

and completely lacking in tactile feedback. The
navigation keys, are quite cramped and add to
the frustration when operating the phone:
build quality is one area where a lot is left to
be desired. 

The 4K colour, 7-line display screen is
nothing to write home about. When the
phone is used indoors, the backlight is able
to create the proper contrast for strain-free
viewing. Outdoors, one can hardly read the
screen. The icon-based menu structure is
simple and intuitive.

The phone has a total of 350 phone
book entries, 100 on the phone and 250 via
the SIM card. Other good features include
support for MMS, hands-free calling, and

Java applications. There are 16 polyphonic ring-
tones and two games, although these can only be called mediocre.

There’s an external camera attachment with a flash. It fits snug-
ly into the data port at the bottom of the phone. Taking pictures
takes its toll on the batteries, especially with the flash switched on.

The C60 offers tri-band compatibility. For data transfer, the
C60 relies on GPRS. You might miss infrared functionality. The bat-
tery lasts about three days with normal use.

Siemens C60 AAPrice: Rs 8,000

The 6600 is definitely a phone to consider buying, especially if
you are a Nokia fan and want a device with great flaunt value,

decent features, excellent voice clarity and decent image capturing
functionality—and also if you can afford the price of Rs 26,069.
However, there are not many compelling reasons for existing Nokia
7650 or 3650 users to switch to a Nokia 6600.

Though the design may not appeal to you at first, it grows on
you. The body is oval and features a dual-tone finish. In spite of
being smaller than its predecessors, the 6600 feels bulky, and peo-
ple with smaller hands may have an issue with single-handed oper-
ation. The keypad is standard Nokia. There's a five-directional joy-
stick in the middle flanked by two soft-keys.

This tri-band GSM phone has a 176 x 208 active matrix 64K TFT
display. The internal memory is 6 MB. There’s also a memory card
slot for additional user memory—a 32 MB MMC card is included
in the package. The phone supports multiple entries per contact,
custom ringtones and contacts can be assigned to groups. You can
also assign thumbnail images to contacts which are displayed when
scrolling through the contacts list or when the person calls you.
The camera features 2X digital zoom and a self timer, and can shoot
in standard, portrait and night modes. It can also capture video
clips at 176 x 144 or 128 x 96 pixels, with or without audio. These
can be played back on the installed RealOne Player.

Voice clarity is excellent and you will have no problems listen-
ing to a conversation even in a noisy environment. The perform-

ance of the hands-free speaker is also quite good, though not rec-
ommended in noisy conditions. The inbuilt polyphonic ringtones
and more that you download play very nicely, though it may be dif-
ficult to hear the phone ringing if you are outdoors, even at maxi-
mum volume. If you want to use a number stored on your SIM
card, you’ll need to browse to the SIM directory. You cannot view
your SIM and phone book contacts together. Even text messages
stored on the SIM card are not displayed directly, which  create a
problem when you switch from the 6600 to another phone, as all
messages you have received are stored in the phone memory.

Standard messaging features such as MMS, concatenated SMS,
picture messages, SMS distribution lists, and predictive
text input are supported. You can connect to
other devices using Bluetooth or infrared,
though there is no pop-port interface for wired
connectivity. GPRS and HSCSD data transfer
speeds can go up to 40.2 Kbps and 43.2 Kbps
respectively. 

An XHTML browser and a Wallet fea-
ture that can store passwords are also pre-
installed. In terms of voice features, the
device provides voice dialling, voice com-
mands for applications, a voice recorder,
and an integrated hands-free speaker. There
is support for downloadable Java MIDP 2.0
applications. However, some of the features
found in even entry level or mid-range
Nokia phones are absent. Noticeable among
these are an inbuilt stopwatch, repeat alarms, timed profiles, and
automatic key-guard.

The 6600 comes with 4 themes preinstalled, and you can down-
load others from WAP sites. Other applications available include
notes, To Dos, a calendar with customisable views, and two games.

Using the keypad is not an issue at all, except if you have small
hands. Text messaging should be a breeze for seasoned users, though
the buttons on the lower part of the keypad lack depth.

Screen visibility reduces considerably in direct sunlight, but is
usable. Still pictures captured using the camera are decent in good
lighting conditions. In dim light, images turn out quite noisy as
there is no flash. Another issue is that you need to hold the phone
in position for a few seconds after clicking, otherwise you end up
with blurry pictures. Video capture quality is not great, although it
does the job. The audio captured with the video is fine, though. A
negative point is the cap on length of clips that can be captured—
just about 9 seconds, which is fine for sending via MMS.

As far as connectivity is concerned, we paired the device to a
desktop PC using a USB Bluetooth adaptor and had no problems
installing applications and transferring data. Even an infrared con-
nection with the HandSpring Treo 180 was established without any
hiccups. The included BL-5C battery offers a couple of days of life
with normal use.

Nokia 6600 CCPrice: Rs 26,069

Conclusion
When is comes to smart features, nothing beats the Nokia 6600.
Apart from great features, this was the only phone to come with
an expandable 32 MB memory MMC card, and 6 MB inbuilt.
Nokia's 7600, though, boasts of nearly the same features as the
6600, but completely lacks the slickness the latter offers in terms
of usability. If you want an affordable smart phone, opt for the
Siemens M55 from or LG's G5300i, which offers decent features
at a significantly lower price. 
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For a full-fledged PDA-cell phone combo, the Motorola A760 is
worth the price tag of Rs 20,495.
The A760 comes with a USB cable to connect to a PC. You can

connect the phone to a PC over the USB interface, Bluetooth or
Infrared. The USB cable is provided with the phone. There’s an addi-

tional connector embedded so you can connect a charger,
and charge the phone while transferring files between
phone and PC.

Once the phone is connected to a PC, it can be
used as a GPRS modem. You can transfer contacts to
and from the PC, and also copy images and video.
When the complete set of utilities is installed on the
PC, you can build themes using the Theme Man-
ager, upload MP3, WAV, and MIDI files to the
phone, and also synchronise contacts from the
address book and calendar, and tasks from
Microsoft Outlook.

Some of the functions of the phone closely
resemble those of the Windows operating sys-

tem. You can multitask as well—for example,
you can listen to MP3s while reading SMSes. How-

ever, while multitasking, applications tend to run slow. 
There are nine turbo-dial functions. The camera is not very

impressive, especially when the subject is zoomed into. However,
there are some good features such as brightness adjust and white
level adjust. The recorder offers good playback—you will, howev-
er, have to hold the phone in the range of 4 to 5 feet of the sound
source for best results. 

The brightness of the backlight is adjustable.
The Motorola A760 comes with the BVR Live Update utility

that downloads updates for the software from the Internet.

Motorola A760 Price: Rs 20,495

Features such as support for e-mail with attachments and an
inbuilt viewer that can read Microsoft Word, Excel, PowerPoint

and PDF documents, make the P900 phone-PDA combo an excel-
lent companion for executives on the move. However, you may
want to wait till the price comes down to a more affordable level.

A worthy successor to the P800, the P900 is much better look-

ing and more professional in appearance,
and nicely integrates phone and PDA func-
tionality into one neat device. It’s only mar-
ginally smaller than its predecessor, but the
P900 does appear to be less chunky. 

There’s now video capture functional-
ity, a small mirror for the camera at the
back, and support for 65K colours. Also,
the P900 has a cylindrical stylus housed in
a silo and accessible from the top right.

The design of the P900 is quite business-like
with a dual-tone silver-grey finish. This tri-band device boasts of all
the features you would expect of a high-end smartphone. The 65K
colour touch screen is 40 x 61 mm with the flip open. The internal
16 MB memory can be boosted by using the Memory Stick Duo
socket that can support up to 128 MB. A 32 MB memory card is sup-
plied along with the device. You can enter multiple pieces of data
for each contact including eight phone numbers, office and home
addresses, e-mail ID, URL and a note.

There are two modes the P900 can be used in—flip closed and
flip open. In the flip closed mode, the P900 offers great function-
ality as a regular phone, with excellent voice clarity even in areas
with low network coverage. The 65K colour touch screen is
extremely clear and produces rich colours. When you open the flip,
the LCD is fully exposed, and the phone transforms into a fully-
functional PDA. The toothpick-sized stylus could be problematic:
it takes some time before you get used to it. For text input, the Jot-
Pro mode is very similar to Graffiti, and does not have a steep learn-
ing curve. You can use it even if you are not familiar with Graffiti.

The media functionality of the device is commendable, and
music playback is quite good. Pictures captured using the camera
turn out quite well, though videos are a bit grainy. You do require
good lighting conditions to be able to get usable results. In terms
of pure speed, the CPU seems a bit sluggish and the device feels
noticeably slow while powering up and opening some applications.
Playing games is not really a great experience, as there is no full
screen mode, and you have to use the stylus and a virtual naviga-
tion pad to control game objects. However, opening MS Word, MS
Excel, and PDF files using the Viewer application is a breeze.

You can use themes to change the interface colour scheme, and
set different images as wallpapers for both the flip-open and flip-
closed modes. In terms of voice features, the devices boasts of voice
dialling, answer or reject calls using voice commands, a voice

Sony-Ericsson P900 Price: Rs 40,000

P D A PHONES
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recorder, and an integrated hands-free speaker. There are three modes of text input—T9 using
the numeric keypad, an onscreen virtual keypad, and CIC’s JotPro. The latter is a character
recognition mode akin to Palm’s Graffiti.

Connectivity and data transfer options include Bluetooth, Infrared, GPRS and HSCSD. You
can surf the Web using the pre-installed WAP 2.0 HTML browser.

The multimedia capabilities of the device include support for the MP3, WAV, AMR, MIDI,
RMF and iMelody formats with 24-note polyphony. All stored sound files in different formats
can be set as ringtones. This means you can set your favourite MP3, or even an audio piece
recorded using the sound recorder, as the tone for incoming calls or alarms.

The integrated digital camera captures images at 640 x 480, 320 x 240, or 160 x 120. You
can choose three types of picture quality—high, medium and low. Capture modes are Auto,
Indoor, Outdoor, and Night, and you can customise a lot of things. In video capture options,
you can choose between three levels of video quality and two levels of audio quality. You can
shoot videos for as long as you want, limited only by the amount of free memory. Still pic-
tures are captured in the JPEG, and video in the MPEG-4 formats. As far as battery life is con-
cerned, the lithium polymer battery packs in enough to last three days with normal use of
phone, camera, multimedia and PDA features.

The SP230 is a tad expensive at close to Rs 30,000. It is a full-fledged PDA running Microsoft
Pocket PC 2003, and has an integrated GSM tri-band phone. But remember that at 109 x

68.5 x 21.6 mm and weighing 158 grams, the device is quite bulky. The detachable numeric
flip keypad adds a few millimetres and grams on top of this. The thick, protruding antenna
makes the device even more bulky, but also acts as a housing for the full-sized stylus.

Powered by an Intel PXA255 400 MHz processor, and well complemented by 64 MB of
RAM, the SP230 boasts of a bright 3.5-inch transreflective TFT display

that supports 65K colours with resolutions up to 240 x 320 pixels.
However, advanced features such as Bluetooth and WiFi are missing.

The SP230 is decent as a phone, though it does have issues in areas
with low network strength. The phone allows multiple conference calls
and speed dial for 99 entries. As with most PDA phones, you need to
copy your SIM contacts to the device to be able to use the contact man-
agement features properly. The SIM Manager does not allow messaging,
so you can only send SMSes using the contacts stored in the device, or
by entering the destination phone number directly. The numeric key-
pad is a flip that protects the screen by covering three-fourths of the area. 

You get Pocket Word, Pocket Excel, Microsoft Reader, IE, Media Play-
er, MSN Messenger, e-mail and standard PIM applications such as Cal-
culator, Contacts, Calendar, Notepad, etc, pre-installed. The installed SIM
Manager enables you to read and copy contacts from your SIM card, and

also dial directly. There’s also a backup utility called WiBackup. You can
downclock the CPU to 200 MHz to save battery power. The ‘Today’ screen displays the num-
ber of unread messages, pending tasks and upcoming appointments. There are quite a few
downloadable plugins for the Today screen that enhance functionality and make use of the
phone simple. For example, a plugin called TodayPhone (www.funnysnake.com) displays missed
and dialled calls on the Today screen, and even lets you call directly.

Synchronising the SP230 with a PC is simple using the bundled USB cradle and Microsoft
ActiveSync software. Text can be input using the onscreen virtual keyboard, letter recognition
and full-fledged handwriting recognition. The latter is fairly accurate once you get used to it,
and should be quite convenient for SMS junkies.

ALIASGAR PARDAWALA (alisgar_pardawala@thinkdigit.com)

SANKET NAIK (sanket_naik@thinkdigit.com)

AnexTEK SP230 Pocket PC Phone Price: Rs 30,000
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022-26856993
sales@sagemindia.com
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Siemens
Siemens India Ltd
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www.siemens.com

Sony Ericsson

0124-2560808
dhiraj.soni@sonyericss
on.com
www.sonyericsson.com



‘Accounts’ brings to mind the Chartered Accountant, which
in turns brings in memories of the tax you paid last year
out of your hard earned money.

Each year you resolve that the coming year, you’ll regularly
monitor your finances, investments and budgets so you don’t land
in no-man’s land in the month of March. And this, 
every year.

What you need in order to end the resolutions game is account-
ing software. We bring you eight accounting software to choose
from, plus two tax software. We tell you all about the pluses and
minuses of these, explaining the key features that a useful account-
ing software should carry.

Accounting needs of a typical individual are simple—your soft-
ware needs to have a salary account, a couple of bank accounts and
a few expense accounts. At the and of the year you print a trial

balance and take it to your accountant, who then takes care of your
taxes after taking some of your money.

The SoHo segment has different requirements: track needs to be
kept about client information, incoming cash and 
expenses, TDSs and salary payouts need to managed, etc. If the
SoHo happens to be a trading firm, inventory management is
needed as well.

There are therefore two software categories—those targeted at
the SoHo segment, and those at individuals. Of course, the former
will work for individuals too. All software start with catering to indi-
viduals first, and then to SMEs. We take some basic accounting soft-
ware both with and without inventory management, which would
suit the needs of  both categories. We sought help from two account-
ing experts for an informed review—their opinions are in quotes.
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resolutions regarding how
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finances
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Accounts 21 is the fastest in terms of data entry. Anybody with
basic knowledge of accounting, and familiarity with

Windows, can get straight to work. Accounts 21 comes in a range
of variants like accounting only, accounting plus, invoicing plus
multi-currency, etc. In all, there are five vari-
ants of the product.

The layout of the software is impressive:
There are one-touch buttons for common
operations such as Cash Receipt, Bank
Receipt, Cash-To-Cash, Bank-To-Bank, etc. This software has some
cool features such as ready-to-use accounting templates for differ-
ent business categories, and a document designer for voucher

designing.
There are advanced

features such as Cost
Centre-wise Accounting,
Ratio Analysis, Cash and
Fund Flow Statements,
etc. Reports can be based
on credit limit and
outstanding, in addition
to basic reports such as

Trial Balance, PNL, and Balance Sheet. There are some good
features relating to vouchers too. For example, locking and unlock-
ing of vouchers for a period, voucher re-numbering, and customis-
ing voucher format. If you’re sure about a transaction that has not

yet occurred, planned vouchers can be used;
this entry stays afloat until the transaction
happens, and the respective accounts will then
show the desired results.

In the reports section, there’s a previewing
facility, and there’s the option to print reports in graphical or text
mode. Accounts 21 can generate reports based on specific periods.
It provides exporting of report data in the .csv format, so that it
can then be used with spreadsheet applications. Help is built-in,
and there are no manuals.

Accounts 21 comes at a rock-bottom price of Rs 999 for
the Single Company version. This is a good version to start
with—you can upgrade as
volumes increase.

ACE 7.0 provides several valuation methods for generating
pricing. Another, related feature is re-order level and re-order

quantity, which help keep a check on available stock.
Printing reports, as well as the facility to export data to popu-

lar office applications is common, but exporting into HTML is a
feature only ACE has. Likewise, e-mailing reports directly to a
contact.

The layout of the software isn’t too good. The inbuilt help
isn’t sufficient, either. ACE does come with some useful features
such as online bill adjustment, customisable voucher numbers,
date-wise locking, credit days and credit limit facility both for
debtors as well as creditors, multiple unit support as well as
conversion between the units automatically based on ratio, aging
report, sale or purchase price list, etc. 

Another good feature is that while creating a chart of
accounts, ACE lists groups in
different tabs, categorising
them—thereby making it
easier to search or navigate.

The software is not free of

bugs: For example, if you add a new entry, it’s not reflected imme-
diately; you’ll need to restart the chart of accounts. Similarly, if
your computer doesn’t have a printer driver installed, the software
won’t open reports; it just prints an error message and aborts the
operation.

Although the software has pretty good features, some basic
programming flaws make it lose ground. We believe a patch
should be released.

JULY 2004

Accounts 21 

Accounts 21

Performance
Features
Ease of Use
Overall

B+B+

ACE 7.0 ▲

ACE 7.0

Performance
Features
Ease of Use
Overall

B+B+Price: Single user—Rs 13,200; 
5-user—Rs 25,300
+ Online bill adjustment, date-wise
locking, customisable aging report
– Lacks ratio analysis, cash flow and
fund flow; lacks year-end balance
confirmation format; naïve layout

Price: Rs 999
+ Simple; easy to use
– Not too many features

Simple, Economical, User
Friendly—the Novice Edition

“

“

Basic accounting is
difficult, though features are
manifold. Also, expensive

““

▲

A
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There aren’t too many companies in the online accounting area;
one that provides this facility is IndiaAccounts. Using online
accounting, you can update and check the status of your
finances anytime and anywhere. All data resides on a Web
server, so you need never worry about data loss.

There’s a subscription fee. With IndiaAccounts the fee is
yearly; its Rs 200 for individuals and Rs 750 for SMEs. With the
multiple login feature for SMEs, there’s the possibility of debating
your financial stituation with accountants, each sitting in his
office or home.

IndiaAccounts provides three modules—Accounting,
Inventory and Payroll. Your accountant can observe daily
transactions as and when they happen, while supervising entries,
allowing or disallowing entries. For accountants it’s an even
better service, as one can manage entries of more than one
individual simultaneously. The Web site doesn’t provide
advanced features, though. It just provides a vanilla version of
the Accounting, Inventory and the Payroll modules. You can’t
export data to office applications. But one nice thing is that a
BSE 30 ticker appears in front with the latest quotes.

Online Accounting
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EQA
Expert Quick Accounting (EQA) is an accounting package tht’s

filled with good features. The software has all the common
features and reports, and also provides some unique features such
as HIFO and WETG as price valuation methods for stock items,
apart from common ones like FIFO, LIFO, etc.

At company creation time, you can enable or disable the
inventory module. You can specify voucher numbering on a
daily, monthly, or yearly basis. Different
types of warnings such as reordering, nega-
tive balances, etc., can be enabled or

disabled. You can even customise the reports header such that
each report printed has your company’s logo or banner.

Relating to inventory, unique features include challans, ABC
analysis, and FSN analysis. There’s a provision for uninvoiced
challans report and unpurchased GR reports. EQA also helps in
maintaining a current price list; there can be separate lists for
buying and for selling. Merging of Accounts is yet another feature

our accountants appreciated.
Most of the common reports are

part of the software, and there are
more, such as receipts and payments

report, outstanding report and a customisable aging report.
The customisable aging report can provide details based on
different days as against the standard <30, 30-60, 60-90, >90
periods. An eye-catcher for our accounting experts, was the
presence of a variety of sales tax forms that the software gener-
ates by itself.

The Rs 3,000 price tag, weighed against the features and func-
tionality provided, makes it a good buy. 

To start with the pluses of EPA: It provides templates for the
type of company you’re creating. It does not provides many

options, but does feature the most commonly used ones: Indi-
vidual, Trader, Manufacturing, Chartered Accountant, and a
Normal template as well.

The Smart Finder feature provides a variety of ways to search
customers, suppliers, items and documents. You can find a
customer on the basis of amount of sales, sales return, etc., while
for suppliers, it could be on purchase-related details. A method
is provided to maintain a narration list, which will help in data
entry. The ‘charges’ section helps in maintaining excise rates,
sales tax rates, etc., at a central location.

EPA does not provide too many stock valuation options: just
Weighted and Moving Weighted. There’s no FIFO, LIFO, etc.

Our expert pointed out some irregularities in the creation of
accounts, which may be a point of concern.

In reporting, the software provides options for three basic
reports—Trial Balance, Comparative Balance Sheet and Profit
and Loss (PNL). Trial Balance provides two options, Standard
and Opening, and the other reports have three—horizontal,
vertical and comparative. The Comparative Balance Sheet 
and PNL help you analyse the situation vis-à-vis the previous
year. There are also advanced reports such as a budget 

variance report, but ratio analysis, cash flow, and fund flow
tools aren’t provided.

EPA can be tailored to your needs by the vendor, at an
affordable price.

EX Personal

Ex Personal Accountant

Performance
Features
Ease of Use
Overall

A-A-

Price: Rs 3,000
+ Very user friendly, strong controls
such as uninvoiced challans and
unpurchased GRs, provides ABC
analysis for inventory, customisable
company headers for reports
– None

Price: Single user Rs 10,000,
Multiple users (5) Rs 40,500 
+ Reduced clutter in menu layout,
comparative report for BS and
PNL, Smart Finder
– Lacks ratio analysis; cash flow 
and fund flow

Broad Spectrum control features,
well conceived and value for money

“

“

Simple accountant, but not a management accountant

“

“

EQA

Performance
Features
Ease of Use
Overall

A-A-

▲

▲
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FACT, an award-winning software in our previous accounting
software comparison test, was nowhere near last time’s

performance, this time around.
The software has its advantages; the accounting code that

can be assigned with account-heads was appreciated by our
accountants. The impression of the expert panel reviewing the
software was that FACT was too complex.

When we posted some entries, FACT began giving “no
cash/bank codes exists” messages. After going through the help

files, we realised that FACT expects account codes to be in a partic-
ular range—this imposes some restrictions on the user.

The software has most, if not all, of the common features,
but the weakest link here is the help and support. The layout
of the software appears too hazy with almost no classification

and categorisation of
options. At the same
time, menu and
option names are
technical in nature.
A user with only
basic accounting
knowledge is not
likely to be familiar
with these.

FACT is definitely
a no-go.

Price: Single user—Rs 30,000, 
5 users—Rs 42,500 
+ Facility to assign codes to
accounts
– Too complex, menu names 
technical

FACT

Performance
Features
Ease of Use
Overall

BB

The learning curve for Simple
Accounting Pro (SAP) is on the

higher side—takes getting used to.
Once it’s installed, you need to

either create a new company or work
with sample data. The software
provides the biggest template list
among the software tested. This
simplifies the task of creating a new
company quickly.

First-time users will have a tough time. You
need more than basic
accounting knowledge to
handle the intricacies of
the software. Handling
operations related to
taxes, chart of accounts,
etc., will scare away
newbies.

A unique feature in
SAP is the ‘advice’ feature.
If the feature is set to auto
mode, the software
‘advises’ you frequently.

An example: if one of your customers is a habitual late-payer,
the software warns you. Another interesting utility is Daily
Business Management, which helps you maintain a list of
activities that needs attention at appropriate times.

A big plus for SAP is that it provides a complete audit trail,
thereby restricting the company from modifying vouchers and
falsifying the records.

To summarise, SAP is a good product, but not for beginners.

Price: Single user—Rs 9,999;
Multiple users—Rs 14,999
+ Huge variety of templates to
choose from while creating a new
company
– Presents a rigid frame to work
with 

Simple Accounting Pro 

Performance
Features
Ease of Use
Overall

A-A-

Simple Accounting Pro

Prakash Marathe
started his
practice as an
Accountant and
Tax Consultant in
1995, and he has
13 years of
experience in the
field. 

Marathe provides
complete solutions including
day-to-day accounting, and
advice on direct and indirect
taxation. He heads a team of
15, and his practice includes
accounting, income tax, sales
tax, service tax, partnership
registration, company

formation, company law
matters, etc. His services in
direct and indirect taxation
ranges from registration to
assessments and appeals.

He is one of the
accounting experts who gave
us an expert’s opinion.

Profile
PRAKASH NARHAR

MARATHE

Bachelor of
Commerce, Bombay
University in April
1990
Intermediate
Examination of The
Institute of Chartered
Accountants of India
in November 1994.

FACT

Ill planned, complex for laymen, restrictive operations
and overpriced

“

“

Innovative, auditor-friendly, but lacks individual
affordability

“
“

▲

▲
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Tally 6.3

JULY 2004

No software can beat Tally in terms of ease of use. Its two-button
combination of [Enter] and [Esc] takes you to micro-level details

as well as brings you out of them. Though Tally’s
learning curve is exceedingly small, novices
might still get stuck at the company creation
process or viewing trial balance. Initially, you’ll
find yourself referring to the help files within the software quite
frequently. However, once you master the hotkeys, you won’t need
to do all that. No documention is bundled.

There’s a pre-defined set of groups, but no templates for charts
of accounts while creating a new company. However, it does allow

you to enable or disable the inventory
module while creating accounts.

It has some great new features such as
e-mailing and uploading the data directly

from the software. It also has support for budgeting, cost centre,
VAT, excise, cash flow, funds flow, aging analysis, etc. Some may
feel that having a facility to enter back-dated entries is a plus
point. However, corporates reckon that it might increase the
chances of corruption. Such entries are allowed by default, but
you can restrict the user by specifying the necessary permissions
in the security control. You can restrict the rights of the user in
the security control by using create, alter, create/alter, etc. Around
nine different types of ratios are provided by the software for
analysis by accountants.

Thus features-wise, Tally is right up front. It has a horde of
them that might take you some time to master. Indeed, it’s defi-
nitely a lot more than a simple accounting package.

Wings is one of the crown holders in our previous tests, and
this time too, it stood up to the test. What first grabs your

attention is the neat menu layout with dividers to group and
sub-group functionalities.

There’s almost no feature that Wings lacks. Wings presents a
range of new features like a History file, pending bills, year-
ending process, peak balance, etc. The History file feature is of
utmost importance, as it can reconstruct the entire database if
disaster should strike. The History file feature takes incremental
backup. If you have offices in multiple locations, you can have
a central database repository where all the other locations would
send the incremental data to, by e-mail. This would then be used
to sync the central database with the location databases.

Wings provides ways whereby users can be restricted on a
field-by-field basis.

What helped Wings retain the crown were its reports. It has
a whole gamut of reports, right from basic trial balance to
advanced reports such as reorder report, sales tax report, excise
duty report, etc. Each report is entirely customisable. In the
collection of reports, some reports are based on new concepts
such as transaction analysis, trend analysis, deleted voucher
report, etc. The bulk import facility provides a way to easily
import large volumes of data.

An example of how feature-rich the software is, is that the

interest calculation feature for late payments has been extended
to a slab architecture whereby, as the payment gets more and more
delayed, different
interest rates can be
applied.

Another new
feature is the peak
balance report,
which not only
shows the peak
balance, but also
the date upon
which the peak
balance occurred,
for both debit as
well as credit.

Wings Accounting starts at Rs 5,900 (Wings Accounting SB),
with Inventory at Rs 12,900. The multi-user pack comes for an
additional Rs 10,000. With each copy of Wings Accounting, you
get a free copy of ACT!5, and contact management software
worth about Rs 6,000.

Price: Softlock—Rs 9,900; unlimited
network version—Rs 45,000
+ User-friendly, advanced features
such as budgeting, cost centre,
etc., reports such as aging analysis,
peak balance, etc.
– Back-dated entries

Wings 16

Tally 6.3

Performance
Features
Ease of Use
Overall

A-A-

Price: Wings Accounting SB Rs
5,900; with Inventory Rs 12,900
+ Easy to handle, provides peak
balance, exceedingly good year
ending routine
– None

Wings 16

Performance
Features
Easeof Use
Overall

AA

Accountants’ best friend;
control drawbacks unresolved

“

“

Good management tool with a plethora of
customisable reports. Economical

“

“

▲
▲
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We roped in a couple of experts to provide comments and
feedback for all the software we tested. We kept some features
as bases for the software to qualify for the tests, for example,
that the software should have a backup and restore option. We
expected that basic reports such as Trial Balance, Profit and Loss
(PNL) and balance sheet would be provided. We looked for a
facility to export reports to common office applications such as
MS Excel, Acrobat Reader, etc. In the inventory section, we
scanned for options such as type of stock valuation. Some of the
newer-generation reports, too, were part of what we looked
for—aging reports, sale/purchase price lists, and features such as
transaction analysis, online bill adjustment, and 
date-wise locking.

To test the ease-of-use factor, we had a set of eight

accounting entries which we posted in each software. This test
was aimed at finding how fast a user can create groups, chart of
accounts, vouchers, etc. We also did other things, such as
entering amounts so that the balance went negative, to see if
the software generated errors or not, and to check if reordering
worked or not.

We did not compare the products on pricing, as each
vendor had different prices depending on the modules that they
bundled. The scenario was not altogether simple; some had the
base pack with the inventory bundled, others had a base pack
with just the accounting module, and some had accounting,
inventory and manufacturing modules within the base module.

Apart from these, ease of installation was also considered
important.

How We Tested

CompTax, a software that aims to lessen the trouble of tax
calculations, does not perform to its full potential.
It needs a lot of patchwork before it could be held as truly

helpful. In its current state, CompTax does not perform any
calculation. Instead, it provides you a multi-columnar grid to
enter values. Why pay for software if you have to do the calcu-
lations manually. Instead, use Excel to do the same. To list a
couple of examples, there’s Taxable Prequisites, Other exemp-
tion, etc.

The software does not consider an important aspect of
Rebate-section VIII A due to investments into insurance, prov-
ident fund, public provident fund, etc. Omission of such an
important feature renders it useless for individual users.

From the corporate point of view, it provides Form 16
reports, which is its single most important function. Other

features include calculation of
advance and self-assessment taxes,
deductions under section 88c
(working women) and under
section 88d (senior citizen), calcu-

lation of interest on National Saving Certificates (NSC), and
calculation of interest payable under section 234A, 234B and
234C. However, it does not consider section 89(1)  that deals
with salary arrears.

CompTax does not let you enter salary figures month-wise.
You have to manually sum up each element of your salary struc-
ture for the entire year and then enter them into the system.

All said and done, CompTax needs a lot of fine-tuning
before it really kicks off.

CompTax
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▲

Price: Rs 3,250
+ Helps in calculating taxes
– Not very helpful features-wise

CompTax

Performance
Features
Ease of Use
Overall

A-A-

A re-visit to the
tax provisions by a
tax expert required

““
K Murtuza is a
Graduate Member
of The Institute of
Cost and Works
Accountants of
India, and a Fellow
member of The
Institute of
Chartered
Accountants 
of India.

Having qualified as a CA in
1995, he has 13 years of
experience in accounting. He
has worked with a leading firm
of Chartered Accountants in

Mumbai for
almost eight years,carrying out
a variety of Audit and
Assurances services.

He was another one of the
two experts that contributed
informed opinions to this
software test.

K MURTUZA
Bachelor of
Commerce from
Bombay
University,
Master of
Commerce from
Pune University

Profile
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Compared to CompTax, Taxbase is more complete as a tax
package for corporates as well as individuals.
The important rebate under Chapter VIII is present in this

software. It also throws in a few niceties such as date of birth as
well as date-of-return on the computation of taxable income
report. This report presents an additional annexure as well which
too was missing in the other software.

There are a variety of reports provided: Income tax register,
groupwise income sheet, Assesse AY year-wise report, advance
tax challan, advance tax register, etc., which makes the entire
process of taxation easy at both the accountant of a business or
a individual. Also featured are a gamut of forms—right from 
Form 1 to Form 56G—that are needed by the Government.

Both CompTax and TaxBase enable computation of tax under
the following chapters—salary, house property, capital gains,
business income, income from other sources, etc. TaxBase also
does not take into account section 88(1) that pertains to 
salary arrears. 

Taxbase includes useful practical information on income tax,
sales tax, and company laws. This information is updated with
each new version. You are notifed of releases via e-mail.

To summarise, Taxbase is useful for both individuals as well
as business houses, mainly due to the wide variety of reports.

▲

Price: Rs 15,000
+ Wide variety of reports
– None

TaxBase

Performance
Features
Ease of Use
Overall

A-A-

Accounts 21 Single Company

ACE

EQA

Ex Personal Accountant

FACT

Simply Accounting Pro

Tally

Wings

CompTax

TaxBase

Companies such as www.filereturn.com and www.filemyreturns.
com provide services such as applying for a PAN card and
filling IT returns online. The feature list includes facilities to
prepare computation of income, tax returns, capital account,
balance sheet, etc. The Web site also provides lots of useful
information such as tax rates, due dates, etc.

Filemyreturns.com is a much better site in terms of layout.
Filereturn.com is rather cluttered, and is difficult to go
through—the fonts are in all sorts of colours.

Online Filing of Returns

TaxBase
Calculate your own taxes

Conclusion
Of the software we tested, only four came close in terms of fea-
tures—Tally, EQA, Wings and Ex. Each provided some advanced
features such as budgeting, cost centres, etc., which made it dif-
ficult to declare one as a clear winner. The ease-of-use factor, too,
didn’t help in putting one software at the top slot. Finally, it was
the kind and number of reports that brought out what little dif-
ference exists among the software. EQA provides ABC analysis as
a unique report, while Ex provides comparative reports for BS
and PNL. Similarly, Wings provides trend analysis and transac-
tion analysis. The major difference between our winner—
Wings—and the others, was the customisation of reports that
Wings allows, in line with the bunch of reports and the report
writer that it provides.

MUSTALI KACHWALA

mustali_kachwala@thinkdigit.com

Conceptually groundbreaking and easy to use

“

“

Telephone

+91-80-25274343

+91-22-28314613

+91-40-2460 7074

+91-22-25006490

+91-80-22384900

+91-22-56925230

+91-40-23211458

+91-80-23354600 

+91-20-4008649

Email

topsys@vsnl.com

info@coralindia.com

info@compubrain.net

rakesh@mum.vedika.com

sourav.biswas@accpacindia.com

sales@tallysolutions.com

veeren.singh@wingsinfo.net

info@relyonsoft.com

sales@indiataxes.com 

Website

www.topsyssolutions.com

www.coral.co.in

www.compubrain.net

www.fact.com.sg

www.accpacindia.com

www.tallysolutions.com

www.wingsinfo.net

www.relyonsoft.com

www.indiataxes.com

Company: 

Topsys Solutions Pvt Ltd

Coral Soft’wares Ltd

Compubrain India Limted

Vedika Software Pvt Ltd

ACCPAC India

Tally solutions Pvt Ltd

Wings Infonet Ltd

Reylon Softech Ltd 

Shinewave Computer Services 
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The best products in different 
hardware and software categories

Motherboard
MSI 875P Neo
+ Terrific performance and equally
good features
- Bad component layout
Contact: Cyberstar
Phone: 080-2276986
E-mail: narend@cyberstarin.net
Price: Rs 14,500

Primary Storage
Maxtor 250 GB MaxLine
Plus II
+ Tons of space
- Gets heated
Contact: Cyberstar
Phone: 011-6438216
E-mail: yogi@maxtor.com 
Price: Rs 19,500

Secondary Storage
DVD-Writer 
LiteOn LDW-811S DVD-
Writer
+ Fast write speeds
- Cannot write on dual-layered
media
Contact: Mediatech India 
Phone: 022-56396696 
E-mail: sales@mediatechindia.com
Price: Rs 13,750

Input Devices
Microsoft Natural
Multimedia Keyboard
+ Great quality and ergonomics
- Takes time to get accustomed
to new key layout
Contact: Microsoft Corporation 
Phone: 011-26294600
E-mail: connect@microsoft.com
Price: Rs 1,498

Graphics Card
PowerColor X800PRO
Limited Assassin Edition
+ Superb performance
- Expensive
Contact: Mediatech India
Phone: 022-56396696
E-mail: nad@godrej.com
Price: Rs 35,000

Sound Card
Creative SoundBlaster
Audigy 2 Platinum 
+ 6.1-channel output
- Expensive
Contact: Creative Technology Ltd
Phone: 9820357713
E-mail: rajshekhar_bhatt@
ctl.creative.com 
Price: Rs 14,199

Speakers
Creative Inspire 5700D
+ Crystal clear sound reproduction
- Will not be able to shake the
room
Contact: Creative Technology Ltd
Phone: 9820357713
E-mail: rajshekhar_bhatt@
ctl.creative.com 
Price: Rs 23,999

Display
LCD Monitor
Samsung SyncMaster 173P
+ Very elegant looks, Landscape and
Portrait modes
- A bit heavy
Contact: Samsung India Electronics
Phone: 011-51511234
E-mail: marketing@samsungindia.com
Price: Rs 47,500

The A-List

Microsoft Wireless
IntelliMouse Explorer
+ Optical Mouse, USB interface
- Expensive
Contact: Microsoft Corporation
Phone: 011-26294600
E-mail: connect@microsoft.com
Price: Rs 4,278

Products that topped
our performance tests

Laptop
IBM T40
+ Great design, 
excellent performance
- Expensive
Contact: IBM India Ltd
Phone: 080 2063199
E-mail: sanmenon@in.ibm.com
Price: Rs 1,53,366

Branded PC
HCL Beanstalk 4658
+ Great package
- None
Contact: HCL Infosystems Ltd
Phone: 0120-2520977
E-mail: raman@hclinsys.com  
Price: Rs 51,490

Multi-functional
Device
Xerox PE16 All-In-One
+ Good fax features, 
compact design
- Below par scan and 
copy quality
Contact: Xerox Modicorp Ltd
Phone: 0124-2561930/ 940
E-mail: kuldeep.malhotra@
ind.xerox.com
Price: Rs 40,000

Laser Printer
Canon LBP3200
+ Compact and light; fast 17
ppm text printing speed
- Flimsy paper tray mechanism
Contact: Canon India Ltd
Phone: 011-26806572
E-mail: rajeev.singh@
canon.co.in 
Price: Rs 13,995 plus taxes

Inkjet Printer
Canon i560
+ Classy printing speeds

- None

Contact: Canon India Ltd 

Phone: 011-26806572

E-mail: rajeev.singh@

canon.co.in  

Price: Rs 9,995

PDA
Palm Tungsten T3
+ Stretch Display

- Expensive

Contact: Tech Pacific 

Phone: 022-55960303 

E-mail: manishl@ 

techpacindia.com 

Price: Rs 26,499

Mobile Phone
Sony Ericsson P900
+ Good integration of phone

and PDA features

- Expensive

Contact: Sony Ericsson

Phone: 0124-2560808 

E-mail: dhiraj.soni@sonyerics-

son.com

Price: Rs 40,000

Digital Camera
Canon IXUS 400
+ Cerabrite body, better 

buttons layout, wide shutter

speed range

- Ultra compact body 

hampers handling

Contact: Canon India Pvt Ltd 

Phone: 011-26806572

E-mail: shyam@canon.co.in 

Price: Rs 49,995

MP3 Player
Apple iPod
+ Hard-drive based, FireWire

cable bundled, line-out socket

- Very expensive

Contact: Apple Computer

International Private Limited

Phone: 080-25550575/ 73

E-mail: indiainfo@

asia.apple.com

Price: 30 GB-Rs 41,000

CPU
AMD Athlon64 FX-51
+ Great performance with multi-
media applications
- Expensive
Contact: Tech Pacific
Phone: 022-55960101
E-mail: pratik.chube@
techpacindia.com
Price: Rs 41,000
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Secondary Storage
CD-Writer
Benq CRW5224W
+ Cheap
- Data cable not bundled
Contact: BenQ India Pvt Ltd
Phone: 022-25705231
E-mail: salesenquiryin@benq.com
Price: Rs 2,000

Speakers
Frontech JIL-1870 
+ Good sound at an affordable
price
- Cannot handle high volume
Contact: Jupiter International
Phone: 022-22001211
E-mail: frontech@bom5.vsnl.net.in 
Price: Rs 1,500

CPU
AMD 2400+
+ Sufficient power for normal
desktop use
- Cumbersome installation
Contact: Tech Pacific
Phone: 022-55960101
E-mail: pratik.chube@techpacin-
dia.com 
Price: Rs 4,100

Motherboard
Krypton NF2400U
+ Good features, impressive per-
formance 
- Lacks onboard video 
Contact: Priya Ltd 
Phone: 022-56663100 
E-mail: priyabom@priyagroup.com
Price: Rs 3,550

Primary Storage
Samsung SV1203N 120 GB
+ Noise Guard and ImpacGuard
- 5400-rpm drive
Contact: Samsung Electronics
India Information
Telecommunication India Pvt. Ltd
Phone: 011-515111234
E-mail: marketing@
samsungindia.com
Price: Rs 7,200

Display
CRT Monitor
Philips 109E5
+ Good geometry results, good
colour purity
- Average results in fine matrix
Contact: Philips India Ltd
Phone: 022-56912325
E-mail: PCP.India.Info@philips.com
Price: Rs 11,500

Branded PC
HCL EzeeBee
+ Winner of Best Value and
Best Performance
- Needs a better graphic card
Contact: HCL Infosystems Ltd
Phone: 0120-2520977
E-mail: raman@hclinsys.com
Price: Rs 26,500

Laptop
ACI Ethos 4
+ Good configuration for
the price
- Hampered ergonomics
Contact: Allied Computer 
International (Asia) Pvt Ltd 
Phone: 022-56943260/
26733124/ 56407000
E-mail: sales@aci-asia.com  
Price: Rs 44,990

Multi-function
Devices
HP Officejet 4110 All-in-
one 
+ Very fast printing speed
- Lacks a flatbed scanner
Contact: HP India Ltd
Phone: 011-26826000
E-mail: seema.dawar@hp.com
Price: Rs 8,999

Laser Printer
Samsung ML-1510 
+ Good image quality
- Slow print speed for combo
document
Contact: Samsung Electronics
India Information and
Telecommunication Ltd
Phone: 011-51511234
E-mail: farrukh@
samsungindia.com 
Price: Rs 10,990

Inkjet Printer
HP Deskjet 3550
+ Good photo printing 
capability, quite cheap
- High cost per page
Contact: HP India Ltd   
Phone: 011-26826000
E-mail: ashwini-k_aggarwal@
hp.com 
Price: Rs 2,999

PDA
Palm Zire 21
+ Affordable, good battery life
- No Palm Universal Connector,
no backlight, no expansion slots
Contact: Tech Pacific
Phone: 022-55960303
E-mail: manishl@
techpacindia.com
Price: Rs 7,249

Digital Camera
Kodak DX6340
+ 3.1 megapixel camera with 
4X optical zoom
- Only 16 MB memory 
Contact: Neoteric Infomatique
Phone: 022-24172600
E-mail: rajeev@neoteric-info.com 
Price: Rs 18,900

Mobile Phone
BenQ M560G
+ Light-weight, perfect grip,
WAP 1.2.1 browser and 
43.2 Kpbs GPRS, PIM features
- Plain looks
Contact: BenQ India Pvt Ltd
Phone: 022-25705230
E-mail: salesinquiryin@
benq.com 
Price: Rs 4,450

MP3 Player
Ennyah Digisound II
DS601
+ Fast data transfer, feature-rich
Contact: Great World Tech 
Pvt Ltd
Phone: 022-23892828
E-mail: sales@gtechworld.com
Price: Rs 6,000 (approx)

Graphics Card
Ennyah GeForce FX 5700
+ DirectX 9.0 compatible
- Very expensive
Contact: Great World Tech 
Pvt Ltd
Phone: 022-23892828
E-mail: sales@gtechworld.com
Price: Rs 8,500

Products that are 
the best value buy

Input Devices
Samsung PC Keyboard
+ Unmatched value for money
- No multimedia buttons, wrist
support not bundled
Contact: Samsung Asia Pvt Ltd
Phone: 022-22814886
E-mail: marketing@samsungindia.
com
Price: Rs 300

Logitech Scroll Mouse
+ Ambidexterous design
Contact: Rashi Peripherals
Phone: 022-28260258/ 59
E-mail: ho@rptechindia.com
Price: Rs 450
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The Digit test centre was perplexed.
The decision to send out DVDs to
some corporate partners had run

into rough weather. The problem was
something like this: The DVDs had to be
1X-compatible. The DVD supplier had
guaranteed 1X writing, however, the disks
themselves were not branded, neither was
there 1X written on them. Nevertheless,
they tried to record the stuff, and the
results were disastrous. This set off the
alarm bells: they needed 1X-compatible
DVDs, guaranteed. Hmm, this was a job
for Agent 001.

When I got off the train suitably dis-
guised as a marketing guy, it was after-
noon. Lamington Road was bustling
with activity as usual. “Hmm,” thought
I, “nice little shop selling CDs, DVDs and
cigarettes. Perfect place to begin my
investigation.”

With a suitably professional voice I
ask, “You have DVD-Rs? I need
1X-compatible ones.”

“Of course,” the guy says.
“How many pieces?” 

He sounds too ready to
sell. “Are they branded?”, I
ask. “Yes, of course, they’re. Sam-
sung,” I am told.

“What’s the price?,” I ask. “Rs 120
each,” he says, as he turns to the man
next to me. “But how do you know what
speed I want to write at?,” I question.

No answer. I repeat the question. He
looks at me and paints ‘4X’ in the air with
his finger. I tell him the problem my
clients face. You can write stuff onto the
DVD, he says. That’s all.

Next stop, Video Plaza. Swank shop. I
step in and the extremely well-dressed
salesman comes up to me—later I dis-
cover he has a Nokia 6600, evidently not
a salesman—and asks me what I want. I
get to the point straightaway. He tells me
that all DVDs are 1X to 4X compatible,
and prices range from 90 to 135. I tell him
the problem. He looks a bit fazed, though
completely in control. He goes through
the covers musingly and brings out a Pio-
neer DVD-R, smartly packaged, the cover
proudly declaring ‘1X-4X compatible.’
“This is Pioneer; it guarantees 1X to 4X

write speeds.” How much does it cost, I
ask. “ Rs 375,” he says, and adds, “Guar-
anteed 1X to 4X.”

Expensive, I think, but as long as it

works...I guess! “But do you know it’ll
really work at 1X?”

“Everyone wants 4X DVDs. Well, you
can take this other stuff, it’s not
branded, but it should work. It’s Rs 35
apiece.” He fishes out a box from the
display. It’s evident this is the same stuff
that was being offered to me in the cig-
arette shop for Rs 120.

Outside, I go into a couple more shops:
the same thing, the same names and
prices, however, no guarantees of
recording speed. I decide to take a last
shot. In a side-alley I come across this
shop proclaiming availability of all things
musical. Up a short flight of stairs, I enter
the shop with three or four shady-looking
people around. Two of them behave like

old customers. Familiar sight—lots of
shops use this ploy to convince unsus-
pecting customers of their credibility. I get
to the point straightaway. Predictably, the
man at the counter nods, “How many do
you want?”

“500 to 1000 pieces,” I say, feeling as
sleuth-like as ever. “But they have to be
guaranteed 1X.”

A voice behind me says, “Yes, may I
help you?” I turn around and see a guy
who looks like one who runs the shop.
“I’m looking for 1X DVDs.” He smiles.
“Everyone wants 4X and you want 1X!” I
nod and say, “You have to guarantee it.” 

He nods. I ask again, “How will you
guarantee it?” half hoping he would tell

me—high hopes.
“Please come into my cabin,” he

says, and I follow him in. “How
many pieces do you want?”

“That’s negotiable. Do you
have a sample?”

He picks up the phone and
dials a number. “Hello Ashish
bhai, you didn’t send me the
sample of those 1X DVDs…yes I
know…1X to 4X?...but the cus-

tomer specifically wants
1X…you guarantee it?...what

is the pack size?...5o…branded…
you say? It has to be 1X, what did you say
the name was?”

Finally he tells me, “You’ll get it, Rs 37
per piece. Guaranteed 1X. The DVDs are
branded. How many do you want?”

“What brand name?”
“Thin Media.”
“Just tell me how you determine it’s

1X.”
“It will be written on the DVD.”
“What if it doesn’t work?”
“Then come back to me, I will change

the whole lot.” He’s sounding rather
cranky by now.

Out on the street with his phone
number in my pocket, I sum it all up in
my mind as I walk back towards the sta-
tion. It is not possible to ascertain
whether DVDs will be guaranteed 1X-
compatible. However, if required, there
are ways to get them, though not at your
average roadside shop.

1X Blues 
Agent 001 has a hard time finding the single X

Mahesh Benkar



JULY 2004

test drive ■
■ reviews

88

We test the latest and the best hardware and software products available in the market 

➜

The Canon ImageClass
MP390 caters to both the

home user as well as the
SoHo segment, with
PictBridge USB connectivity
to directly connect your
digital camera to the printer
and take photo printouts.

Its slow print speed
means this MFD is not for
bulk printing. 

The functions on the
control panel on top of the
unit are clearly explained on
the small LCD screen, and
you can start using the MFD
in no time. Installation of
the device is easy, and both
Twain and WIA drivers are
provided for the scanner—to
be used when using a
graphics application for
scanning. 

The built-in fax unit
makes the MP390 suitable for
a SoHo environment and the

software bundle is extensive
too. The MFD has a multi-
purpose paper feed tray that
holds about 100 sheets.

The rated printing speed
is 18 ppm in fast mode, and
12 ppm in normal mode.
However, in our tests, the

Canon MP390
was slower than
that. Though the
image quality
was good, it is by
no means the
best we’ve seen.
Scanning an
image at full
colour at a
resolution of 600
dpi took one
minute and 11
seconds. This is
quite fast,
considering that

the quality of the image
scanned was distinctly above
average.

The Canon MP390 comes
with a two-year warranty.
Printing and scanning apart,
this MFD loses points as it
doesn’t bundle in an
automatic document feeder.

The REV external solution
from Iomega will find

favour with corporate and
SoHo users; the product is

essentially an alternative for
tape backup. It will not
appeal to regular computer
users who do not consider
data backup a priority—a CD
or DVD writer would do just
fine.

The drive has a capacity
of 35 GB in uncompressed
format, and 70 GB in
compressed format.

We reviewed the external
USB 2.0 version—an internal
parallel ATA version is also
available. Drive connectivity
is simple—all you need to do
is connect the drive to USB
2.0 port on your computer.
Just connecting the drive to
the computer will enable
read access; for writing to
the disk, you’ll need to
install the drivers. 

You can control access to
the drive by either granting
read-only access, or by

locking the drive altogether.
You can also password-
protect the cartridge, which
will take care of any

unauthorised
attempts to accessing
data from the disk.
The software bundle
is good and includes
a REV version of
Norton Ghost.

The sequential
read speed for this
drive was 22 MBps in
our tests, while

random read speed was 3.9
MBps with an average access
time of 107 ms. We
performed real world tests
that included the reading and
writing of a 1 GB file to and
from the drive. Reading and
writing of the file both took
the same time—46 seconds—
which is comparable to the
performance of any good
7200 rpm external hard drive.

A drawback with this
drive is that it is not forward
compatible, which means
that if you insert a 70GB
cartridge—when it becomes
available—it will still only be
read as a 35 GB cartridge.

Price: Rs 23,990
Contact: SES TECH limited
Phone: 022-26824141
E-mail: kp@sesindia.com
Web site: www.intel.com

Canon ImageClass
MP390 B-B-

SPECIFICATIONS

Print, copy, scan and fax fea-
tures; PictBridge technology;
memory card slot; USB port for
connecting digital cameras

SPECIFICATIONS
35 GB native capacity per
removable disk; transfer rates of
12.7 to 25.4 MBps; approx. 5
years drive service life; USB 2.0
or ATAPI interface

Canon ImageClass MP390
All-in-one

Price: Rs.23,850 (USB 2.0)/
Rs.22,500 (ATAPI)
Contact: Neoteric
Phone: 022-24172600
E-mail: sales@neoteric-info.com
Web site: www.iomega.com

Iomega REV

Performance
Features
Build quality
Value for money

B+B+

Iomega REV Removable Hard
Disk Drive

Performance
Features
Build quality
Value for money
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The CoCoPod from S-
Media is a hard-drive

based MP3 player and is
heavily inspired by the
Apple iPod. The unit has a
20 GB hard drive and can
play MP3, WMA and WAV
files. This means you can
have as much as 45.5 hours
of MP3s encoded at 
128 Kbps. 

It also has an SD/MMC
slot. The player, when
connected to a PC, shows
up as a drive, and you can
use it as an SD/MMC card
reader as well. It is also one
of the few devices available
with a USB 2.0 interface.

The player also works
as a recorder, with the
microphone on the front,
right under the scroll
button, and has five
different rates, from 64 Kbps
to 256 Kbps. Another feature
is that you can insert breaks
between tracks while
recording. 

Then there’s FM radio,
with the headphone acting
as the antenna. Signal
reception and clarity are

impressive.
The CoCoPod also

allows you to record from
FM, and saves tracks as
MP3s.

The sound quality is
good, but the earphones

bundled aren’t. You’ll need
better quality headphones to
enjoy this player.

The Radeon
Powercolor X800

Pro retails for Rs
35,000—a good bargain!
It is, considering that
you had to pay the
same amount when the
9800 PRO was released,
and the Powercolor is
twice as fast! With an all
new core, and its
extremely competent
scores in the game and
synthetic tests that we
ran, this is a much
recommended card for any
gaming enthusiast.

The
Powercolor
has under-
lined the
fact that
the X800 series from ATi has
set the bar again, as the
fastest GPU on the planet, for
now...

This card is almost
identical to the original
Radeon X800 PRO.

The software bundle
disappoints, since there is just
one game—Hitman2.

Cables are provided for
connectivity options, and add
to the value of the card.

SPECIFICATIONS
20GB hard drive space; 32 MB
SD-RAM; SD/MMC memory
slot; USB 2.0 interface; MP3,
playback; voice recording; FM
radio; 800mA Li-Ion battery;
weight: 158 gms

Price: Rs 18,990 +taxes
Contacts: Xserve India Pvt. Ltd
Phone: 080-51131001
E-mail: info@xserves.com 
Web site: www.s-media.com

PowerColor X800PRO Limited
Assassin Edition

Price: Rs 35,000
Contact: Mediatech India
Phone: 022 - 56396696
Fax: sales@mediatechindia.com
E-mail: nad@godrej.com
Web site: www.powercolor.com.tw

PowerColor X800PRO B+B+
Performance
Features
Build quality
Value for money
Overall

SPECIFICATIONS

256 MB GDDR3 memory; 475
MHz core clock; 450 MHz mem-
ory clock (900 MHz DDR); 256-
bit Quad Channel Memory
Architecture; 28.8 GBps memory
bandwidth; 145 billion floating
point operations per second

With good printing capabilities,
a decent scanning unit and
useful copying and faxing
features, the 5510 comes out as
a good MFD. At Rs 12,499, the
5510 is worth it. It is
aesthetically appealing, and has

a small footprint. In the printer
unit test, the 5510 beats the
pants off some standalone
printers from HP that we’ve
reviewed previously.

The photographs printed on
this all-in-one are life-like, and
colour reproduction is terrific.
Text printouts didn’t have any
visible artefacts, and it’s hard to
distinguish it from a laser
printout. On the speed front,
the 5510 is faster than a regular
standalone printer.

Images scanned on the
scanner unit were good on the
quality front, but lacked the

colour resolution a professional
might look for.

The copy unit is simple to
use, and the printouts were
acceptable.

Features abound on the
5510: The faxing console
features one-touch faxing and
speed dialling. Copying
preferences can be set from the
console—a good feature, as it

allows taking a copy without
switching on the PC. The
automatic document feeder
makes life easier. All totalling up
to a thumbs up for this device.

Price: Rs 12,499
Contact: HP India ltd
Phone: 1600-444 9999
Fax: 0124-2566112
E-mail: seema.dawar@hp.com
Web site: www.hp.com 

SPECIFICATIONS
4,800 dpi printing; 600 x
2,400 dpi optical scanning 
resolution; 20-page ADF; 25 to
400 per cent  reduction/
enlargement; USB compatible

HP Officejet 5510 

Performance
Features
Build quality
Value for money

BB

HP Officejet 5510 

S-Media CoCoPod MP3

Performance
Features
Build quality
Value for money

BB

S-Media CoCoPod MP3 Player

➜
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With the sudden spurt in
the number of MP3

players launched by various
brands, buyers now have the
luxury to choose from a wide
range of players, based on
hard drive and flash memory.
We compared three flash
memory based MP3 players
that are portable, look good
and can carry enough songs
to keep you charged for at

least two hours. All three have
a storage capacity of 128 MB.

The best thing about
flash-based MP3 players is
that they are small and light.
PQI Joy Tone, an MP3/WMA
player, is the lightest of the
three, and hence, the most
portable. Blood red in colour,
it sports the traditional USB
stick look, with the only
difference being the LCD
panel on the front face. 

Second to Joy Tone is
Umax Vega, which has a
rather unusual square shape.
It also has an inbuilt
SD/MMC card reader. The
small LCD panel on the
front face shows
information, such as track
names, equaliser modes, and
duration of the tracks in
seconds—all tiny, but
readable, with a backdrop of
tidy animation. 

In contrast, the Butterfly
from S-Media is way too
bulky. It sports the typical
flip design of a cell phone,
but opens to almost 340
degrees—a standard cell
phone flip opens to about
120 to 150 degrees. Opening
the flips completely, reveals
the USB connector and the
two tiny speakers. Both the
earphones and speakers
provide output
simultaneously, a feature
that can result in lower
battery life. Ideally, the
speakers should switch off
automatically when
earphones are plugged in.

The Butterfly also has a
Line-In to record directly
from the PC—a special
feature missing in the other
two contenders. All three
players have the USB 1.1
interface and are detected in
Windows XP without
drivers. The Umax Vega
draws power from an AAA
battery, while the Joy Tone
and Butterfly have in-built
batteries that are charged
when connected to the PC.
So you’ll actually be
charging the device while
you’re transferring data to it. 

The Joy Tone and Umax
Vega are bundled with
headphones that are
attached to the neck strap.
Encasing the wires in the

neck strap, eliminates the
chances of damaging them.
The earphones of the Joy
Tone also double up as a
wired remote, with an FM
scan and a reset button. 

All three players returned
nearly the same results in the
audio quality test. The scores
were average in the test
tracks—a mix of Hindi,
English and Bass tracks at 75
per cent volume. However,
once the volume level was
turned up, the noise and
distortion, especially with
high frequency sounds, were
bad. All three players are
bundled with poor quality
earphones. You’ll have to buy
a better set of headphones to
enjoy the sound output. The
FM reception is clear when
outdoors, but inside
buildings, or when away
from windows, all three
players fail to receive
properly.

The voice recording
feature is decent. The
recorder isn’t very useful
outdoors, since
background noise is way
too prominent while
recording.

Priced at Rs 49,999,
the Joy Tone is
reasonable for a flash
memory-based player
that records, and has an
FM radio. The Umax Vega

is priced higher at Rs 7,000,
with the additional feature of
a card reader. The Butterfly is
bulky, but has the advantage
of an external speaker,
though at the cost of using
more power.

we decided that the Joy
Tone was the best amongst
these, as far as music goes. If
you need more storage, the
Umax will come in handy,
since the card reader can
store many more tracks.

S-Media Butterfly, PQI Joy Tone U800 and Umax Vega MP3 Players

SPECIFICATIONS
128MB capacity, MP3 and WMA
playback, FM radio, Voice
recorder, USB flash drive, Built-in
Li-ion battery, USB interface

S-Media Butterfly

Performance
Features
Build quality
Value for money

B+B+

SPECIFICATIONS
128MB capacity, Card reader,
MP3 and WMA playback, FM
radio, Voice recorder, USB flash
drive, 1 AAA battery

Umax Vega

Performance
Features
Build quality
Value for money

C+C+

SPECIFICATIONS
128MB capacity; MP3/WMA
playback; FM radio; Voice
recording; USB flash drive; Built-
in Li-ion battery; 

PQI Joy Tone U800

Performance
Features
Build quality
Value for money

B-B-

Price: Rs 7,990 +taxes
Contacts: Xserve India Pvt. Ltd
Phone: 080-51131001
E-mail: info@xserves.com 
Web site: www.s-media.com

Price: Rs 4,999
Contacts: Shree Sagarmatha
Distrubutors Pvt Ltd
Phone: 011-26428541
E-mail: sagarmatha_dlh@bol.net.in 
Web site: www.pqi.com.tw 

Price: Rs 7,000
Contacts: Neoteric Informatique
Phone: 022-24172600 
E-mail: sales@neoteric-co.in 
Web site: www.umax.com

S-Media Butterfly

Umax Vega

PQI Joy Tone U800
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In our performance
tests, the drive gave
good results in the
Nero DVD Speed tests
in the data transfer
rate and access time
tests.  CPU utilisation
was another department
where the drive excelled,
posting some of the lowest
CPU utilisation scores.
However, it suffered in the
CD-burning tests and posted
very average scores.

The drive supports the
Mt. Rainier standard, which
lets you use a CD-RW disk
as a big floppy, provided
the OS supports this. The
sofware bundle is good, too.
However, with absolutely

nothing special enough to
justify its price, we suggest
you give this drive a miss.

The Compex Wireless
Internet Gateway Kit is a

wireless access point
(802.11g). It allows a
broadband or dial-
up connection to
be distributed in
both normal LAN
and wireless forms.
The Kit comprises
the NetPassage 16A
broadband Internet
gateway box, which
has a removable
wireless PCMCIA
card—the heart and
soul of the package. It comes
for Rs 9,500, and carries a
three-year warranty. This is
an excellent solution for any
SoHo or home usage
scenario, offering superb
price-to-performance ratio
with versatility. If you’re
shopping for a switch or
hub, you can pay just a little
extra and get yourself this
wireless gateway kit.

Connecting the gateway
takes about two minutes

since everything is pre-
configured. All you need to
do is set your computers to
DHCP, and connect the

incoming
broadband or
switch LAN
cable to the
WAN port on
the gateway. You
can also connect
an external
modem to the
RS-232 port and
set it up as a
backup

connection.
Four LAN ports are

provided. An uplink button
lets you connect more than
four PCs at the same time on
the LAN, excluding the
wireless option.

We tested the Internet
gateway in different
scenarios, such as WLAN,
LAN and WAN. Data
throughput was pretty
good—4 MBps in the
Wireless LAN and WAN
scenarios. In the LAN
simulation, the data
throughput was a
respectable 62 MBps.

There’s one drawback:
the WAN port is limited to
10 MBps. This automatically
limits the other LAN ports to
10 MBps.

Price: Rs.9,500
Company: Rashi Peripherals
Phone: 022-28260258
E-mail: ho@rptechindia.com 
Web site: www.cpx.com

Compex Wireless 
Internet Gateway Kit
Performance
Features
Build quality
Value for money
Overall

B+B+

Compex Wireless Internet 
Gateway Kit

SPECIFICATIONS
Supported standards: IEEE 802.3
10Base-T, IEEE 802.3u 100Base-
TX, IEEE 802.3x Flow Control
WAN Protocol: Static/Danamic
IP, PPP over Ethernet (PPPoE),
Dana RAS WAN Interface: 1 x
RJ45 Ethernet port
LAN Interface: 4-port
10/100Mbps Fast Ethernet
Switch

The BenQ CB482B is a
48X/24X/48X CD-RW

drive and a 16X DVD-ROM
drive. It retails for Rs 4,000,
which is quite high for a it’s
speeds—you can get
52X/24X/52X/16X drives
from other manufacturers

for much less. The drive
does come with a two-year
warranty, but that does not
justify its price. It comes
bundled with a CD-R, CD-
RW and the necessary
software but is just an
average performer. 

BenQ CB482B Combo 
Drive

Performance
Features
Build quality
Value for money

B-B-

SPECIFICATIONS
16X (read) DVD; 48X (write)
CD; 24X (rewrite) CD-RW;
48X (read) CD; E-IDE/ATAPI
Interface; 2 MB buffer
memory; flash memory
firmware (upgradeable);
supported writing modes:
DAO/DAO-96, SAO, TAO

PhotoReplica Version 5

PhotoReplica is a good tool
for digital photographers.

With a small learning curve,
a simple interface and low
pricing, it makes printing

photos from a digital camera
a breeze.

PhotoReplica is a tool to
assist in printing, not
editing. It has features such
as index printing, creating
preset size templates, etc.,
mainly to change colour
overtone, brightness,

contrast, hue, etc.
Although this software is

no match to the
heavyweights from Adobe
and Corel, it is definately

more affordable—
priced between
Rs 750 to Rs 2,750.
The price varies
because different
versions handle
different file sizes.

The software
provides excellent
colour correction,
duo tone and a range
of effects.

BenQ CB482B Combo Drive

Price: Rs 4,000
Company: BenQ India Pvt Ltd
Phone: 022-25705230
E-mail: salesenquiryin@benq.com
Web site: www.benq.com

Price: 0.8M: Rs 750, 1.4M: Rs
950, 2.0M: Rs 1,250, 3.0M: Rs
1,650, 4.0M: Rs 2,150, 5.0M: 
Rs 2,750

PhotoReplica Version 5

Performance
Features
Ease of use
Value for money

B-B-

SYSTEM REQUIREMENTS
PIII 700 MHz or above, 128 MB
RAM, colour monitor (24 bit at
800 x 600) and Windows
95/98/2000/XP. A printer, 
scanner, and digital camera
helps you click and print



93 JULY 2004
JULY 2004 JULY 2004 JULY 2004 JULY 2004 JULY 2004 JULY 2004 JULY 2004

This software is a complete
payroll managing

solution—with even forms
such as Form 3, Form 6A and
Form 10C. NestPay lets you
manage loans to employees,

Provident Funds, Professional
Tax, Employees State
Insurance as well as TDS.

The software is pretty
simple to work with,
though there is a lot to do
the first time. In
subsequent months, you
just need to enter
attendance details. From
pay slips to forms for the
different government

departments, everything is
just a click away.

There are several irritating
aspects to the software. While
filling in entry forms, you
have to enter ‘-’ in any empty

text boxes. If you
happen to put the ‘-’
in the wrong box,
the program displays
a runtime error and
crashes. There aren’t
any explanations
alongside each field
either.

The software is
rich, with tons of

features, but the interface is
bad. The performance is in
no way exceptional, mainly
due to runtime errors that
pop up way too often.

The Phaser series caters to
a wide range of user

segments. The Phaser 3130 is
a monochrome laser printer,
and is targeted at the lower
end of the user spectrum.
The printer is priced at Rs
22,045, which makes it one

of the costliest in its class.
Similar models from, say,
Samsung are approximately
Rs 16,000. The price of the
3130 is not justified, as its
performance is good, but not
exceptional.

Performance wise, this
printer is above
average, and printed at
14 ppm—2 pages
short of the claimed
16 ppm. However, it’s
slower when printing
images or documents
that contain images.
Our test image and
combination image
documents took a
about 21 seconds and
29 seconds
respectively.

The Phaser 3130 features
a removable printer tray that
holds 250 sheets. There’s 32
MB of buffer memory, so jobs
can be spooled faster—which
translates into faster printing
and low-latency printing
queues. Another plus is that
it is USB 2.0 compliant,
which makes for much

higher data transfer speeds.
Drivers are provided for

almost all Windows versions
and also for Linux.

The Dart SP-916 will
satisfy the casual

listener and gamer who
doesn’t mind below-average
sound quality. The bass
department needs a
thorough overhaul; this
speaker set has completely
missed the bulls-eye that
Dart intended to hit.

The satellites and
subwoofer are both made of
wood. This set comes with
a built-in FM Tuner. We
tested the FM tuner
function and found that
reception was pretty bad.

You’ll need just three
minutes to get the speakers
up and running. But
remember that the

subwoofer has a tendency
to get really hot.

The subwoofer doesn’t
lend enough depth to the
bass. Another issue is the
low bass output—even with
the bass control knob
turned up to the max, the
output is pretty low. Vocals
and treble tended to go too

sharp when the volume was
turned up. Gaming tests,
too, gave below par scores.

At lower volumes, the
overall sound quality is
okay for songs and games.

Dart SpeakersSP-916

SYSTEM REQUIREMENTS
Windows 95/98/2000/NT/XP,
CD drive, 32 MB Ram, and min-
imum 10 MB HDD space

SPECIFICATIONS
32 MB memory; 16 ppm; 600
x 600 dpi; USB 2.0 compliant;
media types supported: A4
and smaller, and special media
such as transparencies, labels
and envelopes

NestPay

Performance
Features
Ease of use
Value for money

CC

Price: Rs 30,000
Contacts: RP Software Associates
Phone: 080-36782796
E-mail: rogergo_2000@yahoo.com
Web site: www.nestpay.com

SPECIFICATIONS
2.1 speakers (1 subwoofer and 2
satellites); 54W total RMS rating;
frequency response:
30Hz~20KHz; FM tuner

Price: Rs 1,400
Company: Dart Computers 
Tel: 07104-232565
E-mail: dartcomp_ngp@sanchar.
net.in
Web site: NA

Xerox Phaser 3130 

Performance
Features
Ease of user
Value for money

C+C+Price: Rs. 22,045
Contact: Xerox Modicorp Ltd
Phone: 0124-2561930/0124-
2561940 ext. 4569
E-mail: kuldeep.malhotra@ind.
xerox.com
Web site: www.xerox.com

Dart Speakers SP-916

Performance
Features
Build quality
Value for money

B-B-

NestPay

Xerox Phaser 3130
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“Iwish life was not so short, lan-
guages take such time,” remarked
JRR Tolkien, creator of the Hob-

bits language for The Lord of The Rings.
Languages may be your passion, or you
may want to learn a language to impress
your friends, or to make sure taxi drivers
in foreign cities don’t rob you blind—the
reasons to want to learn a language are not
important. What is more pressing is the
fact that you may not be able to afford the
time or resources to take up a course. So,
what do you do? 

One site, many options
If you are not sure about what language you
want to learn, visit the British     Broad-
casting Corporation (BBC) Web    site at
http://www.bbc.co.uk/languages. The site offers
languages from German to   Mandarin and
even English variants such as Welsh, Irish
and Gaelic. It adopts a practical approach
for online teaching—using everyday situa-
tions, such as taking a taxi, or asking for

directions. The course consists of six stages:
from getting your basics right to finding
your way around a foreign city and order-
ing food, you learn everything. 

Each stage is complete with situations,
grammar tips and vocabulary listings. And
you can also use the message boards to

communicate with fellow learners, native
speakers, as well as experts. If your lan-
guage skills have become rusty, you can
take the challenge test that the site offers
you. All in all, a complete site that also
gives you the itinerary for its television
programmes on languages. It also has

interesting sections called ‘Odd-
ities in a language’. For example,
did you know that the term
‘white rhino’ is a Dutch
Afrikaans word?

One at a time
If you prefer a dedicated Web
site for the language of your
choice, no sweat! You will find
niche sites catering to one par-
ticular language. Visit
www.deutsch-lernen.com to learn
German. As with classroom
learning, beginners are instruct-
ed in  grammar, with examples.
Advanced  learners grapple with

Move over books and pens, the Internet is here to teach you new languages...

PHOTOGRAPHER: Jiten Gandhi IMAGING: Parag Joshi

Language Lessons

The BBC courses span a myriad of languages 



complex sentences and their usage. They
also have the     international pen pal sec-
tion that      allows you to communicate
in German with  people across the world.

Similarly, www.businessspanish.com
teaches you Spanish. It offers 520 lessons

a year. You receive a daily lesson once you
sign up for their services. In addition, you
are taught business related
terms ranging from adver-
tising to government. With
the support of audio clips
for pronunciation, you will
be comfortable with Span-
ish in no time flat.

So you want to flatter
that special someone by
speaking the language of
love, French. Check out
www.france-pub.com. You
can get grammar lessons
based on real life situa-
tions, you can download

the lessons and listen to
them. The chat rooms let
you to talk in French, and
help sharpen your linguis-
tic skills. You can e-mail
your homework in, and get
feedback. Who said online
lessons are not interactive?

Mera Bharat
mahaan
India has 18 official lan-
guages, and is a linguist’s
delight. And yes, there are
Web sites that promote
Indian languages. Sanskrit,
often called the mother of
all languages, is on       the
verge of extinction in the

very country it originated in. Visit
w w w . o u r k a r n a t a k a . c o m /
learnsanskrit/sanskrit_main.htm to learn San-
skrit taught to you with English as your
base language.

You can also learn     the oldest South
Indian language—Tamil.
Just log on to
http://ccat.sas.upenn.edu/plc/
tamilweb. Promoted by the
University of Pennsylvania,
this is a funded programme
that caters to students
studying in American
Universities. It has three
levels of learning: Begin-
ning from learning the
alphabet and grammar; it
goes on to show you Tamil
radio plays and     stories as
an introduction to the
Tamil literary culture.

The recently popular
music video Aika Dajiba by
singer Vaishali Samant has

generated considerable interest in
Marathi. Check out www.marathimitra.com
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Ancient Languages
Mel Gibson’s movie, The Passion of The
Christ, about the torture Jesus Christ went
through in his last hours of life, has
fuelled the desire in many, to learn
languages of yore such as Aramaic,
Hebrew, Latin, etc. Here are some sites
that will do exactly that:

http://www.wannalearn.com/Academic_Su
bjects/World_Languages/Latin/
The Web site points you to places that
will teach you how to use grammar, 
pronounce and converse in Latin.

http://www.kypros.org/LearnGreek/
Learn the language of the Gods—well
Greek mythological gods at least. Read
the fascinating tales of the Greek culture
while you learn.

http://perso.wanadoo.fr/babel-site
You can learn obscure languages such as
Occitan, used in the medieval France
more than 700 years ago, or just try your
tongue at Hebrew.

http://www.assyrianlanguage.com
Learn Aramaic, and you won’t squint to
see the subtitles in the movie The Passion
of The Christ. Aramaic was spoken in
ancient Turkey, Persia and Palestine.

Oriental Leanings
The Mandarin language dialect of 
Chinese is spoken the most in the world.
If you’re keen on mastering oriental
languages, check these sites out:

http://www.csulb.edu/~txie/ccol         
/content.htm
Learn Mandarin, with more of an
emphasis on spoken Mandarin, rather
than written.

http://www.japanese-online.com
Here you can learn Japanese, and also
culture pointers in terms of what to say
when—the Japanese have a lot 
of traditions.

http://korean.sogang.ac.kr
This is an intensive five-week course that
will also fetch you a certificate, complete
with a seal of the Centre for Korean
Studies at Sogang University. Signed by
the director and everything!

Sites to visit

Deutsch-lernen.com takes meticulous care of both the beginners
as well as the advanced learners

Ourkarnataka.com stands out for the lucid technique it 
uses in teaching Sanskrit

A glimpse of the Tamil alphabet, neatly laid out for easy learning
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to familiarise yourself with
grammar, pronunciations and
an exhaustive Marathi word list.

Another Web site worth visit-
ing  is www.ukindia.com. Though
it’s targeted at expatriates settled
abroad, the site is really useful. It
uses both English and the region-
al language to make things more
comfortable for you. You can
learn Tamil, Urdu, Hindi, Punjabi,
Gujarati, Bengali and Sanskrit.

Language exchange
Every action has an equal and opposite
reaction! Newton's third law of Lan-
guages? It sure seems like that at
http://www.mylanguageexchange.com.

The concept is simple yet brilliant! The
site uses language exchange to teach peo-
ple languages. For example, a person whose
native language is French, can team up with
a Hindi speaking user. For half the time they
interact per day, they speak in French, the
other half is in Hindi. This is called the
Cormier method of language exchange,
used in schools in Canada. This method is
named after Helene Cormier who came up
with it way back in 1998. She conducted
language workshops at the Club d'échange
linguistique de Montréal language school
(CELM) in Canada for over 3 years.

The Web site even recommends creat-
ing pen pals for beginners and has voice
chats for advanced learners. 

Conventional tools of learning new
languages may have a charm of their own.
But it is time to move over stacks of books,
pens and the desk. The desktop is here for
a whole new way of learning a language—
using the Internet. 

APARNA KRISHNAKUMAR

aparna_krishnakumar@thinkdigit.com

All Web sites instruct using audio-visual
methods that makes it easier to grasp
pronunciation as well as the script. The
Web sites also offer useful links to help 
you learn about a country, its culture and
the language. 

The basic tips of learning any language
remain the same—read out aloud,
converse in the language as often as
possible and diligently practice all the
exercises listed with every lesson. 

Of course, you have the added
advantage of learning at a pace that you’re
comfortable with—either as slowly as

possible, or skim over the easy bits and get
your hands dirty with the really tough stuff.
This all depends on how badly we want to
learn a language. Some of us might need
the goading of a teacher, prodding us
reluctantly along the learning curve—in
which case, learning online might be
a problem. 

Just try and remember what Nelson
Mandela, former South African President,
once said, “If you talk to a man in a
language he understands, that goes to his
head. If you talk to him in his language, it
goes to his heart!”

Attention! Read out aloud

Mylanguageexchange.com features the Cormier method of
language exchange, used in schools in Canada

1/2 pg HD
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Let’s begin by asking a question.
What’s the maximum data transfer
speed you can get over your home

telephone line?
Being used to 56K modems, you prob-

ably thought the maximum speed you
could get from your telephone line was 56
kilobits of data per second. Now read this:
on that same phone line, you can actually
get data rates reaching 8,192 kilobits per
second. And we’re not talking cable or
ISDN here. 

A landline telephone is today as
commonplace in the average household
as the TV or fridge. For most of us, the
landline doubles up as our only window to
the Wide World of the Web. Well, right
now, there are quite a few competing tech-
nologies that offer connectivity and band-
width solutions: Leased Lines, ISDN,
Cable, Satellite links, LMDS (Local Multi-
point Distribution Systems) and 3G, or
Third Generation Wireless, are differing
technologies that try to address the
increasing demand for bandwidth. This
demand has spilled over from large enter-
prises to small and medium businesses
and increasingly, homes.

Since its inception in 1989 as an
attempt at delivering streamed video

over copper phone lines, DSL, or Digital
Subscriber Line, has branched into
several similar, competing technologies.
Combined, this family of technologies is
known as xDSL. Asymmetric Digital
Subscriber Line, or ADSL, is by far the
most important member of this
extended brotherhood.

Cable is the most widely deployed
broadband solution in the United States,
and also in India; However, DSL does have
its advantages. You get a dedicated
connection instead of a shared one, and
surfing speeds therefore don’t vary
depending on the time of day. 

Peeling off the insulation
First things first: DSL is a modem tech-
nology that uses existing twisted-pair tele-
phone lines to digitally transport
high-bandwidth data, such as multimedia
or video, to subscribers. You can use your
phone while being simultaneously
connected to the Internet: The process
entails a technique known as multiplex-
ing (see box ‘Multiplexers and Multiplexing’
on page 99) to pack the two kinds of data
and channel them through the existing
telephone network.  The two modems,
one at the central office of the telecom

Turbocharging
the tele-

ADSL is one of
the strongest
contenders in the
race to deliver
broadband

Mahesh Benkar
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company (typically a Digital Subscriber
Line Access Multiplexer, or DSLAM) and
the other at the subscriber’s home, are DSL
modems. DSLAM is a mechanism at a
phone company’s central location that
links many customer DSL connections to
a single high-speed ATM line.

When the phone company receives a
DSL signal from the subscriber, an ADSL
modem combined with a POTS splitter
detects voice calls and data signals. Voice
calls are sent to the Public Switched Tele-
phone Network subscriber line, or PSTN,
and data signals are sent to the DSLAM,
where it passes through to the Internet,
then back through the DSLAM and ADSL

modem before returning to the
subscriber’s PC. 

The two separate lines—one from the
external PSTN network and the other
from the broadband service provider—are
merged using a pair of filters, one of them
a high pass filter (HPF), the other one a
low pass filter (LPF). The data line is first
passed through what is called an ATU,
and then through the HPF (a reverse of

the splitter that is
installed at the user’s
end). Similarly, the
POTS line is passed
through the LPF. Then
they are merged and
fed into the ‘last mile’.
On the subscriber’s
end, there is a mirror
image of the arrange-
ment before the data is
fed into the respective
machines—voice to
telephone, data to
computer.

The line connecting them, the ‘last
mile’ as it is referred to, is part of the
DSL circuit.

Interestingly, the ‘upstream’ data rate,
or data coming from the client computer
to the server, is quite low. The bandwidth
requirement is asymmetric. This is what
an ADSL or Asymmetric/Asynchronous
Digital Subscriber Line circuit does—it
suits an asymmetric flow of data needs.

Last mile blues
Most telecom companies, or telcos, use
fibre optic technology to communicate
with each other. With the passage of time,
most developed countries, even some

developing ones, have come to possess
incredible amounts of backbone band-
width. The progress of both wire-line and
wireless technologies mean that there are
effectively no problems in transmitting
high bandwidth data from the servers of
an Internet Service Provider to the telco. 

The bottleneck is created when the
broadband data is transferred from the
backbone to the much slower Public
Switched Telephone Network (PSTN) or,
Plain Old Telephone Service (POTS)—the
‘last mile’. The last mile comprises the
wiring that starts from the telecom service
provider to the consumer’s home. This
section, or ‘subscriber loop plant’, not
only varies widely in terms of quality, but
also contains voice-line-specific artefacts
installed by telecom companies. The idea
is to help voice transmission. 

The POTS network, though extremely
large and intricate—India has about 43
million fixed-line telephones—is mostly
of rather poor quality, and almost entirely
consists of ‘untwisted’ copper wire.
Though some countries have recently
replaced this in urban or high-demand
regions with fibre-optic cables and T1
lines, most of the world’s POTS networks
still run on age-old wires.

Any T1 system handles POTS voice
channels at about 4 KHz for a channel
capacity of about 64 Kbps. Common
PSTN wiring does, in fact, support much
higher bandwidths. However, since the
system was set up for voice communica-
tion only, all modification to the wiring
was done to optimise voice transmis-
sion. These include loading coils (origi-
nally installed on long circuit loops to
cancel noise during voice calls), over
long loops (which attenuate signals),

Multiplexing connects multiple remote
sites to a single centralised location.
Typically, a connection originating at the
host location is fed into a multiplexer at
the service provider’s end. The
multiplexer splits the host circuit into
smaller circuits, which are then delivered
to the remote sites.

It can be either code-division
multiplexing, or time-division multiplexing.
In code-division multiplexing, the data
stream is divided according to the
requirement. In time-division, data is
divided according to priority—data that is
more important is transmitted faster.

Multiplexers and multiplexing

Echo cancellation: The available bandwidth is
divided into upstream and downstream, and
these overlap to create a duplex band

Frequency Division Multiplexing: The available bandwidth is divided
into upstream and downstream, without any overlap. All bands are
multiplexed on the same line



bridged taps (un-terminated pairs), and
cross-coupled interference (cross talk
between wires in the feeder cables that
run to local exchanges). All this effec-
tively restricts the available bandwidth
in copper wire cables.

Splitting the bottleneck,
splaying the bandwidth
Telephone wires are bundled together in
large cables, and 50 pairs to a cable is a
typical configuration. Cables coming out
of a central office (CO), though, may have
hundreds or even thousands of pairs
bundled together. An individual line from
a CO to a subscriber is spliced together
from many cable sections, as they fan out
from the CO.

The normal copper wiring for POTS
can support bandwidths of up to 1.1 MHz,
but since voice signals are only transmit-
ted in the lowest end of the spectrum,
only the lowest 4 KHz is reserved for voice.
DSL widens the bottleneck by utilising the
frequencies above the 4 KHz range. The
rest of the bandwidth is split into two
bands, one high-speed downstream band,
and another medium-speed duplex band. 

Interestingly, the ‘upstream’ data
rate, or data coming from the client
computer to the server, is very low
compared to the downstream. Typically,
if the downstream is about 6 Mbps, the
upstream would at most be 128 Kbps.
This figure varies according to the serv-
ice subscribed to.

There is but one important difficulty
with twisted pair copper wire. It creates
interference and cross talk, and the prob-
lem worsens with increasing distance and
length of wire. It turns out in the end that
attempts to send symmetric signals in
many pairs within a single cable may
severely limit the data rate and length of
line attainable. Asymmetric DSL, in
context, is ideally suited to serve high-
speed data over short distances. The reason
for this is that the data rate falls with
distance from the CO. The table below
gives a rough idea of the data rate ADSL
media can transport over given distances.

As can be seen, the data transfer rate
falls off with distance, which makes it
difficult to deploy ADSL as a long-range
broadband solution. For the same reason,
it can be a feasible short-range solution for
Internet over telephone wires.

Challenge of the racing data
Transmitting data at tearaway rates as ADSL
does, poses a host of technical challenges.
ADSL modems divide the available band-
width of a telephone line in one of two
ways—frequency-division multiplexing
(FDM) or echo cancellation (see figures on
page 99). This is known as Discrete Multi-
tone Modulation (DMT). DMT is a modu-
lation technique using FDM within the
DSL band. Echo cancellation assigns the
upstream band to overlap the downstream,
and separates the two by means of local
echo cancellation, a technique well known
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High-pass filter: A filtering circuit
that only lets through frequencies
higher than a specified frequency,
blocking all lower frequencies. Acts
like a check-dam in the data stream.
Low-pass filter: Passes frequencies
lower than a specified frequency.
Acts like a height barrier on roads
before low overbridges.
ATU: ADSL Transceiver or
Termination Unit, respectively,
depending on whether it is installed
with the telco, or the household end.
Loading Coils: An inductor placed
on the local loop by the phone
company. Coils are generally placed
between 3,000 feet and 6,000 feet
intervals to suppress exactly the
signal that DSL modems need to
transmit high speed data on—high
frequency. The effect of a load coil is
similar, from the perspective of the
DSL equipment, to adding 20k feet
to the line length.

No DSL equipment now works
through load coils.
Unterminated pairs: a pair of
twisted or untwisted cables not
bridged or joined at the end that can
cause disturbance and static on
phone lines.
Cross-talk: Noise from one
telephone line that is audible on
another line. Caused when lines are
too close, touching, not twisted,
or by bad punch-downs or other
wiring problems. This can cause
noise bleed—through from the DSL
line to other voice lines in the
same location.

Jargon Buster

Data rate
(Mbps) 
1.5 or 2

1.5 or 2

6.1 

6.1 

Wire gauge
(AWG) 
24 

26

24

26

Distance
(feet) 
18,000

15,000

12,000

9,000

Wire size
(mm) 
0.5

0.4

0.5

0.4

Distance
(kilometers) 
5.5

4.6

3.7

2.7

w
w

w
.c

is
co

.c
om

Data rate drops with
distance. This table shows
how much, taking into
considerating wire gauge
as well.
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in V.32 and V.34 modems, the ones used
commonly in dial-up or ISDN lines.

Putting an ADSL circuit in place on
existing telephone infrastructure has a
load of hardware related problems too.
Loading coils, for instance, are essentially
low-pass filters that cut off all frequencies
above 4 KHz. Unfortunately, all digital
modems require frequencies higher than
4 KHz. Loading coils must be removed
from the telephone network before any
digital service can be availed.

ADSL in India
ADSL attempts in India have been based on
the classic copper cable infrastructure with
ADSL modems. Dishnet DSL, a Chennai-
based company, has been offering Digital
Subscriber Lines since the late nineties. A

franchisee-based
pilot trial in Kolkata
by one operator
offering voice, data
and video-on-
demand was said to
be a great success.
Services offered
include ADSL-Lite
and ADSL, which
have been intro-
duced in a couple of
metros under several
tariff packages. These
packages range from
low monthly
subscription, speci-
fied per-MB down-
load charge, a charge per view of
video-on-demand, to high flat rate monthly
rental with unlimited downloads and a low
per view charge for video-on-demand.

There are reasons for low connectiv-
ity for services such as xDSL in India. Low
PC penetration, subscription price, lack of
proper infrastructure and security and
service-related problems are major
contributors to the sluggish growth of
xDSL services.

Recently, the Confederation of Indian
Industry (CII) finalised a document for the
broadband market named Vision 2010.
The document envisages India as one of
the top five countries in the world in
terms of broadband penetration. The Tele-
com Regulatory Authority of India (TRAI)
has also released a paper analysing broad-
band penetration in India. The CII
National Broadband Economy Committee
has defined broadband as an always-on
network capable of providing interactive
voice, data and video services on public
networks, reports Cable Quest magazine.
Technically, true broadband would be

capable of providing a minimum asym-
metric bandwidth of 1.5 Kbps.

In the US, a recent legal ruling abol-
ishing price ceilings and structures for
telecom companies in leasing infrastruc-
ture services to DSL operators has
thrown the establishment into a tizzy.
The ADSL market in India, however,
recently got a shot in the arm with
MTNL announcing its ADSL services in
Mumbai and New Delhi. India now has
45,000 DSL broadband subscribers,
growing 50 per cent in the latter half of
2003, with only 0.11 per cent penetra-
tion of its phone lines. A survey done by
Pielle Consulting, London, under the
auspices of the DSL Forum, came up
with these results. The DSL forum has a
mass-market target of 20 per cent pene-
tration of all telephone lines by 2005 in
countries where ADSL connectivity
already has a base. 

Looks like ADSL will at last be a
Formula One solution for the ‘last mile’.

SUPROTIP GHOSH

suprotip_ghosh@thinkdigit.com

JULY 2004

Types of DSL other than ADSL have been
deployed, albeit none so widely as ADSL.
For example, IDSL is an acronym for ISDN
Digital Subscriber Line. The data rate is
128 Kbps across 18,000 feet on 24 gauge
wire. It is similar to ISDN service but with
data only—there’s no voice on the same
line. DSL Lite (same as G.Lite) is a ‘splitter-
less’ DSL where the data rate varies from
1.544 Mbps to 6 Mbps downstream,
depending on the service subscribed to.
The typical range is 18,000 feet on 24
gauge wire. This the standard ADSL in the
sense that it sacrifices speed for not
having to install a splitter at the user’s
home or business. G.Lite is DSL Lite
without the ‘truck roll’, or the cost of
setting up the splitter arrangement at the
user’s end. The splitting is done remotely
at the telco’s end.

Different flavours of DSL

ADSL data is transmitted in what are known as frames. These frames
are put into 68-frame superframes. Frames 0 to 67 contain data plus
the Reed-Solomon forward error correction bytes. Frame 0 also
contains cyclic redundancy check bits, and frames 1, 34, and 35
contain indicator bits used for administrative purposes



So you got yourself that new phone
that can store a thousand contacts,
maintain a log of your past 500

missed calls and dialled numbers, and
can store 50 custom ringtones? Great!
But what happens if the phone malfunc-
tions some day, or you need to use a
new SIM card? You may discover that
all of a sudden you’ve lost access to
some of your most important con-
tacts! Sounds scary? 

Using a software called Oxygen
Phone Manager with a compatibe
Nokia phone, you can make your PC
talk to your phone. The software
allows you to read and write data to
the phone through an easy-to-use
graphical interface. 

Connect the phone to
your PC
You need a data cable, which will
connect your phone to your PC at
the serial (COM) port or the USB
port. The USB cables are relatively
more expensive than their serial
counterparts, but they’re worth
the price because of  the better
transfer speeds they offer. You can
get a compatible cable for your
model from an authorised Nokia
dealer, a third party reseller, or
even from Web sites such as
Baazee.com. We got ours from
Manish Market, a hot spot for
electronics and related goods in
Mumbai for about Rs 200 (the
serial model). Now, connect the
data cable to the PC. In the

case of the classic 3315,
follow these steps:
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Manage your
phone like a Pro

PHOTOGRAPH: Mexy Xavier, 
IMAGING: Solomon Lewis

Here’s how  you get the mobile to be in contact with the PC via some Oxygen.



Turn off the phone.

S l i d e
o p e n

the battery
cover.

Take the battery out, and insert it
into the cable clip.

Attach the clip in place of the bat-
tery, so that the pins of the clip

touch the point provided on the base.

Push the cable clip with the battery
in the slot until it clicks into place.

Attach the other end of the cable to the
serial or USB port of your PC.

Turn on the phone. If the phone
says “insert SIM card”, try pressing

the clip into place properly, and switch
the phone on again.

Backing it all up
Now, start the Oxygen Phone Manager and
go to ‘Tools’ in the menu and click on
‘Options’. In the ‘Connection & Common’
category, click on ‘Add’, and add ‘com1’ or
‘com 2’, depending on where you plugged
in your phone. Add the port with DAU-
9P/FBUS connection type. Click OK, and
the software should detect the phone. If
that doesn’t happen, try changing the port
or the connection type and try again.

Immediately after detection, the soft-
ware will offer you to back up the phone’s
information. Click ‘Yes’, and the software
will begin reading all data from your phone.

A dialog box will show up, asking you
to select exactly what you want to back
up from your phone.

After the backup and the data reading
part is complete, the software will show
an Explorer-type interface displaying a
collapsible view of all data on your phone.
It will include the phonebook (both the
phone and the SIM card), the call register

(dialled numbers, missed calls and
received calls), startup and operator logos,
ring tones, and the various SMS folders.

Clicking on the ‘New Phone’ on the
top of the phone explorer tree will display
useful information about your phone, such
as model number, battery type, IMEI num-
ber, software version, network provider,
phonebook load and more. You can even
set your phone alarm from this box, or syn-
chronise the phone date and time with
that of your computer.

Go Graffiti
Did you know that getting a logo for your
phone will lighten your wallet by about
Rs 5 per logo you download? But you can
try out cool new logos for your phone for
free. Oxygen Phone Manager, used in con-
junction with your phone allows you to
upload and try out as many logos as you
want, free of cost!

Click on the ‘Logos’ section in the
Phone explorer to preview your current
logos, with their dimensions, on the
phone. To change your startup logo, click
on ‘Startup’ and you will be presented
with the logo in a zoomed grid format. 

You can now use the various tools
available, such as paintbrush, shape tools,
text tool, paint bucket, etc., to draw any
logo graphic you want. 

Additionally, you can use the ‘Cap-
ture’ button to open a small window that
can be moved anywhere on the screen to
take a screenshot. Once a screenshot is
taken, the graphic can be used on the
logo. Click the ‘Write to phone’ icon on
the top to write the logo to your phone
and instantly see the results.

While you work on your logo, Oxy-
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gen Phone Manager also shows you a pre-
view of how it would look on the screen of
your phone.

Get vocal
Lend variety to the chords of your phone by uploading new ring-
tones. Oxygen Phone Manager allows you to easily add or delete
ringtones, to and from your phone. You can choose to use
Oxygen’s in-built set of ringtones, download some from the
Internet, get some from your friends, or simply create your own
tune using the keyboard as a piano. 

You can use the ‘Add’ icon to add a new ringtone from your
hard disk. The ringtone can be in RTTTL, MIDI, Oxygen Extend-
ed Ringtone, RT File or RNG file format. The ‘Play’ button will
allow you to preview the ringtone then and there. Use the ‘Read
from phone’ icon to get the ringtones currently on your phone,
or the ‘Write to disk’ to write changes to the phone.

To top it all off, you can click on the ‘Editor’ button in
the Ringtones Manager to open the ringtone editor. This
is where you can create your own custom ringtones and upload
them to your phone.

It’s all about contacts
You are no longer stuck with the contacts only on your phone.
Oxygen Phone Manager allows you to export the phonebook
on your phone to your favorite application on the PC, such as
Microsoft Outlook. To do this, Click on the ‘Phonebook’ menu
on the top, and click on ‘Export’. You will be presented with a
number of formats in which you can export your phone’s
address book.

For this exercise, select ‘MS Outlook (Custom folder)…’. If

you select the ‘MS
Outlook (Default
folder)’ then the
contacts will be
merged with your
current contacts in
Outlook, but if you
wish to keep your
phone contacts in a
separate folder in
Outlook, choose
‘Custom Folder’.

Oxygen Phone Manager will now make you select or create a new
folder in Outlook.

Similarly, you can import contacts from Outlook into your
phone. After importing you will have to right click on the ‘New
Phone’ item in the Phone Explorer and click ‘Write all data’ to
actually write the changes to your connected phone.

Outlook provides a number of data fields, such as ‘home,
phone, office phone, fax number, home phone 2 etc.’ You can
choose which field in Outlook the number from your phone's
contacts goes into, by going to Tools > Options > Phonebook > Import
& Export > Outlook mapping.

Snd tht msg acrss
The software also allows you to manage your SMSes on your
phone. You can view, delete and create SMS messages easily. A
really neat feature is the provision to ‘shrink’ messages so that
long text messages can be shortened, while the essence of the

message isn’t lost.
To do so, go to Tools
> Options > SMS Man-
ager > Shrinking.

Here, enter your
original message on
the ‘Before shrink’
box, and use the
slider on top to alter
the amount of
compression to use.
You can even view
the results in the

‘After shrink’ box. From now on, managing SMSes on
your phone is this easy. 

SAURABH KUMAR

saurabh_kumar@thinkdigit.com

If your Nokia phone model is listed below, you can
use this software to make your phone talk to your PC

1100, 1220, 1260, 1261, 2100, 2270, 2275, 2280, 2285,
2300, 3100, 3105, 3108, 3200, 3205, 3210, 3300, 3310,
3320, 3330, 3350, 3360, 3390, 3395, 3410, 3510, 3510i,
3520, 3530, 3560, 3570, 3585, 3585i, 3586, 3586i, 3587i,
3588i, 3589i, 3590, 3595, 3610, 5100, 5110, 5130, 5140,
5190, 5210, 5510, 6100, 6108, 6110, 6130, 6150, 6190,
6200, 6210, 6220, 6225, 6230, 6250, 6310, 6310i, 6320,
6340, 6340i, 6360, 6370, 6385, 6500, 6510, 6560, 6585,
6590, 6610, 6610i, 6650, 6651, 6800, 6810, 6820, 7110,
7160, 7190, 7200, 7210, 7250, 7250i, 7600, 8210, 8250,
8290, 8310, 8390, 8810, 8850, 8855, 8890, 8910, 8910i.
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Use the software to shorten your SMSes—the
software removes vowels, etc.

Export your phone book to your favourite
application
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Shuttling files from a laptop to a work
PC and back again is tedious, isn’t it?
So, here’s a solution—connect them

directly. Doing so is easy, cheap and a
matter of minutes—30 minutes to be
precise!

A Serial Laplink or a Parallel Laplink
cable, priced at around Rs 50, is all you
need to connect a PC or a laptop directly
to another of its own ilk. Here, we use the
Serial Laplink. The steps for a Parallel
Laplink are similar, and the differences
will be highlighted as we proceed further.

Minute 1: Connect the two ends of the
cable to the serial port of the PC and/or
laptop. You can connect the cable even
while the computers are powered on.
Minute 2: In Control Panel, double-click
‘Phone and Modem Options’, go to the
Modems tab and click Add. Tick the

‘Don’t detect my modem; I will select it
from list’ option, and click Next.
Minute 3: Since it’s a serial cable, we
select ‘Communications cable between
two computers’. Click Next to select the
port to which the cable is connected.
Finally, click Finish.
Minutes 4-5: Repeat the steps from
Minutes 2 to 3 on the other PC or laptop
as well.
Minute 6: Double-click Network Connec-
tions in Control Panel, and start the ‘New

Connection Wizard’. 
Minute 7: Select ‘Set up an advanced
connection’ in the ‘Network Connection
Type’ list and click Next.
Minute 8: In the ‘Advanced Connection
Options’, select ‘Connect directly to
another computer’.
Minute 9: Specify your PC as Host or
Guest and click Next. One PC has to play
host and the other has to be the guest.
You cannot use a PC as a guest and a host
simultaneously.
Minute 10: Here, the type of cable
decides your selection. Select COMx if it’s
a Laplink serial cable or LPTx otherwise.
The x stands for a numeric value such as
1, 2… Generally, the mouse is connected
to the COM1 port, so the serial cable uses
the COM2 port. Click Next.
Minute 11: Now, specify the users who
can connect to the host using this
connection. You can even create a new
user especially for this purpose. Enable
the users, click on Next, and finally,

Finish to complete the Wizard.
Minute 12: Start up the Wizard yet again
and repeat the steps from Minutes 6 to 8.
A Host or Guest screen appears. Here,
select Guest this time.
Minute 13: When prompted, specify the
name of the remote computer connected
at the other end of the cable. 
Minute 14: Here, select the data port on
which the computer is connected.

Minute 15-23: Repeat steps from Minute
6 to Minute 14 on the other computer as
well.
Minute 24: This done, a pair of connec-
tions appears in the Network Connec-
tions window. One within Direct, the
guest connection—and another within
Incoming, which represents the host
connection.
Minute 25: Double-click the guest
connection and specify the username and
the password. This username should exist
on the remote machine.

Minute 26: Finally, on the guest PC, go
to Start > Run and type \\computername\
to access the remote computer.

MUSTALI KACHWALA

mustali_kachwala@thinkdigit.com

PC-to-PC

Select the appropriate port—the one where the
cable is connected

This step in the wizard lets you specify the
direction of control

Double-click on the guest icon to connect to the
remote computer

Get two computers to talk the serial or parallel way

Here’s the concept behind the host and
guest: A guest PC can access files from 

the host PC. However, the reverse is not
possible.

The ‘Computer name’ is the name you
assign your PC while installing Windows.

Windows XP users will find it by right-click-
ing My Computer and going to Properties
> Computer Name. In Windows 98, right-
click Network Neighbourhood and go to
the Identification tab.
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Sure, it seems really professional to
have an answering machine for
your company. That way you never

miss another important call—the
machine always gets it. Answering
machines cost only Rs 3,000 to Rs
15,000. This is cheap for any decent sized
company, but is that the only solution?
Vehemently, we say, “No!” How about
one that costs nothing? Yes, nothing.
Sounds good? How about one that also
doubles up as a Fax machine? 

Most PCs already have a modem,
internal or external. Most modems built
after 2000 are Voice/Fax/Data capable. So
all you probably need to do is find an
existing computer in the office that has
one of these modems connected. Even if
you don’t have one, you can buy an
internal PCI Voice/Fax/Data modem for
as little as Rs 400, or an external modem
for about Rs 1,400. You want more good

news? The necessary software you’ll need
to set up your computer to be an answer-
ing machine or fax comes with the
modem—free again.

Software-based answering machines
and faxes have other benefits too. For
one, a software-based answering
machine can have many voice-mail-
boxes—one for each extension, or
employee. A software-based fax saves on
paper, as all outgoing and incoming mail
is saved on a PC, and only what’s
required is printed. Let’s take a look at
the steps involved in setting up a
computer to be an answering machine-
cum-fax.

First, a small checklist! Make sure
you have the following, apart from a
computer:

1. A Voice/Data/Fax modem
2. A telephone connection
3. An answering machine software

such as PhoneTools eXPert or SuperVoice
4. A sound card and a microphone

with headset or speakers
In this workshop, we will use Phone-

Tools expert. This software comes with
most Voice/Data/Fax modems, or can be
downloaded from http://www.bvrp.com/
ENG/products/PhoneToolseXPert.

Answering machine
Start by installing the software. Double-
click on the file to start the installation
process. The installation is fairly simple,
though you have to keep clicking the
‘Next’ button several times. Punching in
the license information is an important
step that shouldn’t be overlooked.

The next important step is to enter
the Identifier, Telephone Number 
and Fax Number. The Identifier helps the
recipient of the fax to identify the
source. It is a 20-character alphanumeric
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Turn your PC into a fax and answering machine for your office 

I m not in, but my PC
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code.
The last important step is selecting

‘Callserve’ on the ‘Select Components’
window. Apart from these three steps,
continue pressing ‘Next’ for the remain-
ing steps. Remember to keep ‘Phone-
Book Selection’ as ‘Use an existing
phonebook in the list above?’ After the
installation is complete, a new setup

shows up for BVRP Internet, with the
first step as ‘Choose Setup Language’.
Click ‘Cancel’ to avoid this setup.

The application will automatically
start unless you have un-ticked the ‘Run
Application after installation’ option in
the final step. When the application
starts for the first time, it will start the
modem configuration wizard. Click on

the ‘Next’ button on the opening
window. Now, select the appropriate
modem and press ‘Next’ to proceed.

This wizard will install its own driv-
ers depending upon the modem that it
detects. Once the device detection
system completes, click ‘Next’ to

continue the setup. Finally, click ‘Finish’
to complete the installation.

When the software starts now, it
works in Answering Machine mode. At
this point of time, the software receives
the phone call after the second ring. The
software now plays the default greeting
and saves the message in the Inbox.
During all this, the maximum recording
time for any session would not exceed
60 seconds.

However, you can change these
default settings by clicking on the General
Configuration icon or by pressing [F6] or
by following the menu commands in Util-
ities > General Configuration.

Ring count before auto
pick up
If you wish to change the default ring
count before pick up, click on the
‘Communication’ tab. Choose any value
from the drop-down box. The number
of rings range from two to nine. 

Enter licensing information here

Select the Callserve component, which is
disabled by default The default is auto-detection of drivers, but

advances users can use the manual method

The software auto-detects the modem and
installs its own drivers

Allowable ring count values are 2 through 9
rings before the phone is attended by the
answering machine software

Select the modem to be used

To start the configuration window, press F6
or the wheel icon on the toolbar

Click cancel to stop installation of this
unwanted application that comes bundled
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Answering machine
ON/OFF
To enable or disable  Answering Machine
mode, click on the ‘Voice answering
machine’ tab. Select ‘Answering
machine disabled’ to stop the software
from answering incoming calls. The
‘Play Greeting, No Record’ option lets
you pass a message to all incoming
callers. This is particularly important for
customer support numbers, where the
message could simply inform the caller
of office working hours.

The ‘Play Greeting & Record’ option
lets you play a message as well as record
the caller’s message. This option is more
useful for on-the-field people who can
now have the liberty of listening to all
the callers at some later point of time in
the day. They can simply listen to all the
messages of the day after returning to
the office, either on the PC or on the
field by using remote commands.

Record your own greeting
In the ‘Voice answering machine’ tab,
click on the ‘Announcements…’ button.
On the right-hand pane, right-click and
select ‘New’ from the pop-up menu

window that shows up. Give a name to
the new voice message and press [Enter].
A new window will appear with two
buttons—‘Record’ and ‘Stop’. Use them
to record your own message.

Make your custom greet-
ing the default
If you change the view to ‘Details’ in the
‘Modify/Create Greetings’, then you’ll be
able to see the default greetings for the
modes ‘Greeting only’ and ‘Greeting and
record’. To change the default greeting,

right-click on the greeting of
your choice, select ‘Assign’
and select the mode you
want. After this, select the
modem.

Retrieve
messages
remotely
To set up remote retrieving,
go to ‘Voice answering
machine’ tab in ‘General
configuration’ and click on
‘Remote Msg. Retrieval…’
Specify the access code,
which then acts as a pass-
word for you while retrieving

messages. Click ‘OK’ to set it up. You
even have the option of changing the
default phone keys for the designated
commands. On the command panel, key
1 is meant for message replay, 2 for
moving to the next message, 3 for delet-
ing the message and 4 for listening to
the message.

Multiple Voice mailboxes
Creating an individual mailbox for each
employee of the organisation is facili-
tated by the ‘Advance answering
machine’ mode of the software. Enable
this option in the ‘Voice answering
machine’ tab of the ‘General 

Configuration’.
There are two distinct

ways in which you can set up
the multi-voice answering
machine with this software.

Scenario 1:
You can set up the software
as a single Inbox but with
multiple voice greetings.
This means that no matter
which voice mailbox a caller
chooses, all messages will be
stored in a single Inbox.
Interestingly, a caller will

never know the difference. There is no
privacy, though, for individuals here, as
all employees have access to the Inbox.

To set it up, you need to tick each
checkbox and select ‘Mailbox greeting
msg’ for the voice mailboxes you enable.
You can also retrieve messages remotely
by specifying ‘Access code Msg.’. 

Scenario 2:
Create multiple Inboxes first. To do so,
press the ‘Mailbox Management’
button—the first button from the left—
on the toolbar. It appears on the
‘Advanced Answering Machine Settings’
window.

Now, in the ‘Inbox Mailboxes’
window, click on ‘Inbox’ on the ‘New
mailbox’ button—the first button from
the left—on the toolbar. Specify the
name of the mailbox and press ‘Enter’.
Create the number of mailboxes needed
and close the window.

Return to the ‘Advanced Answering
Machine Settings’ window, and select
the Inbox for the mailboxes that are
enabled. That’s it—the setup is complete.

Faxing
With the answering machine set up and
running, the next move is to set up a Fax
machine. The biggest advantage is that
with just a single telephone line and a
modem, the computer acts as a fax
machine as well as an answering
machine. So how do you set up a fax
machine using this software?

Changing the identifier
In case you missed out on the identifier
settings during installation, or if you
need to modify the identifier, you can
do so by clicking the ‘Fax’ tab. Here,
change the value of the identifier accord-
ing to your needs.

Select any one of the three available functioning modes 

All the inbox appears in the drop-down list,
just relate them to the telephone keys as
required

Either right-click and select New, or press the NewMsg
button on the toolbar
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Auto-Printing faxes
A classical fax machine gives you a hard
copy of the fax, but software, by default,
doesn’t print each and every fax that
comes in or goes out. It is entirely up to
you to enable ‘Print incoming faxes’ in
the ‘Fax’ tab to get the necessary output.
Similarly, you can maintain copies of all
faxes sent by simply enabling ‘Print
outgoing faxes’.

Try, try, till you succeed
No longer do you have to stand by the
Fax machine and make sure a Fax is sent.
Software-based Faxing solves this prob-
lem by automatically trying and re-
trying to send Faxes. By default, the
software tries to send a Fax three times
with a three-minute break in between
each failed attempt. You can change this
default behaviour from one to five
times, or just disable retrying, or even
alter the time between each attempt
from two to 10 minutes.

These values are not fully customis-
able. You can choose an option from a
list available in a drop-down box. To do
so, click on the ‘Communication’ tab
and modify the ‘Wait’ and ‘Number’

settings within the ‘Transmission
Attempts’ group.

Send a fax directly from
the field
Let’s take an example. A sales executive
sitting in a client’s office can request a
Fax from his office, without any frantic
calling or help from anyone else. You
can set up a list of one thousand docu-
ments indexed for sales executives on
the move. An index file is automatically
maintained by the software, which is
constantly at the beck and call of 
the executive. This service is only 
available in ‘Advanced Answering
Machine’ mode.

To set up such a service, you need to
perform two tasks. First, enable the serv-
ice, and second, maintain a list of docu-
ments that can be auto-faxed. Click
‘Setup’ and then enable ‘voice answer-
ing machine’ under ‘Advanced Answer-
ing machine’. After this, enable the
‘Fax-On-Demand’ option.

After the service is on, prepare the
list of documents by clicking the ‘Fax-
on-Demand’ button on the toolbar—the
third from the left. Here, add as many

documents as you want. For each docu-
ment, you need to enter a description
and filename.

Once the service is on and the list is
ready, the entire setup is complete. From
the field dial the office number. Press [*]
to enable Fax-on-Demand, and enter the
document number to be faxed.  Punch
in the Fax number. That’s it—all the
documents are just a few clicks away.

Under EPABX, no problem
Generally, telephone connections under
EPABX need to dial out a code. This can
be a hassle for many. To solve this prob-
lem, click on the ‘Location’ tab and
enter your outgoing code to the ‘Outgo-
ing Prefix’ box. Tick the checkbox next
to it and select the ‘Dialing mode’ from
either ‘Tone’ or ‘Pulse’.

PhoneTools eXPert also provides
SMS, e-mail and Video Answering
Machine capabilities that can be very
useful in an office environment. Now go
set up that PC and modem, and give
your company efficient Fax and answer-
ing machine services.

MUSTALI KACHWALA

mustali_kachwala@thinkdigit.com
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Stable! That’s how most people
describe Linux. Yes, it’s true, we
believe that too! Right here in our
office, though most people use

other operating systems, Linux is the
choice for anything that requires huge
up-times and stability. It’s just the pre-
ferred solution for a server, and with good
reason. What’s the most common server
in use in a majority of offices? A proxy
server, of course! We all need our little
doses of the Internet, and it’s apparently
more addictive than chocolate!

At Digit, hundreds of employees bus-
tle about, complaining about how the
‘slow’ 2 Mbps line is just not enough.
What keeps them connected to the Inter-
net? Squid! It’s this amazing little (1.29
MB) Linux-based program that takes care
of the needs of the Net-hungry hordes.

Why do I need a proxy 
server?
You require one if you need to connect
more than two computers (under the
same roof) as securely as possible to the
Internet. So how’s this different from
connecting a router to the Internet? Well,
quite simply, Squid is more secure, saves
bandwidth if you use its caching capabil-
ities, is very light on resources
and easy to set up.
Also, if

A Serving 
of Squid
It’s popular, powerful and takes care of
all your Internet connection sharing
grief. Presenting Squid—the proxy and
caching server



you’re looking for a little advanced
tweaking, you can set it up to band-
width-throttle clients, either individual-
ly or by groups.

Saves bandwidth? How?
Once configured, Squid saves caches of
images and even entire pages. Hence, if
you and your colleagues have Yahoo! e-
mail  accounts, a normal router just
sends your requests to the Internet;
Squid, on the other hand, checks if it has
visited the same page recently. If your
colleague just visited a site and you go to
the same URL soon after, instead of load-
ing the page afresh, Squid loads it
straight from its cache. This saves band-
width, and also translates to a better user
experience, as pages load faster.

How do I know if I need it?
If you live in India, and have a ‘broad-
band’ connection that you want shared
over multiple computers, trust us, you
need it!

OK, seriously, if you’re looking for a
low cost, secure solution to share an
Internet connection over an existing
LAN, Squid is the sanest solution. It’s free
and can be run off a battered old Linux
box with a decent hard drive, and as
much RAM as you can install—the min-
imum being 128 MB.

So, what do I need? 
Just log onto www.squid-cache.org and
download the latest stable release, by
clicking on the link under ‘Versions’.
Choose the ‘.tar.gz’ file to download. You

can load and run Squid
on Linux, FreeBSD, NetB-
SD, OpenBSD, etc, and
also on Mac OS/X, OS/2,
SunOS/Solaris and Win-
dows via Cygwin.

Hardware require-
ments depend on the
level of caching you
expect the proxy to do,
and the amount of traffic
it receives. So, to set up a
proxy for, say, two to five
computers at home using
a dial-up Internet con-
nection, all you need is a
low-end machine with
about 128 MB of RAM
and 1 or 2 GB of space for
caching. You also need a
modem or Ethernet card

to connect to the Internet and another
Ethernet card to connect to your local
LAN. 

An office proxy that is to handle over
50 computers does need a good hardware
configuration. A bare minimum will be a
1 GHz processor, 512 MB of RAM, and 10
to 20 GB of free hard disk space. Remem-
ber, Squid’s performance isn’t really CPU-
intensive, but does use a lot of RAM and
hard disk space, so if you can get 2 GB of
RAM and 15,000-rpm hard drives, there’s
nothing like it—the hard drive is always
a bottleneck. 

OK, now what?
Now you need to install Squid. Use the
‘tar’ command to unzip the downloaded
file. For example, if the file you down-
loaded is called ‘squid-
2.5.STABLE5.tar.gz’, use ‘tar xvzf
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Just log on to www.squid-cache.org and download the latest
stable version of Squid

How does Squid work?

THE INTERNET

SQUID PROXY
SERVER

ROUTER

CLIENT COMPUTERS

Clients send requests to
Squid for objects or URLs

Squid checks to see if the
objects or URLs are cached

If the objects aren’t in
Squid’s cache, it connects to
the Internet to get them

Any objects or URLs received
from the Internet, which also
fit into Squid’s range of
minimum and maximum
object cache size, are cached

If the objects are cached,
Squid sends them to the
respective clients that
requested them—within
milliseconds

Legend:
Requests from Clients

Cached Hits
Communication with

the Internet
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squid-2.5.STABLE5.tar.gz’. This uncom-
presses the file and creates a directory
(squid-2.5.STABLE5) in the current work-
ing directory. 

Uncompressed. What’s
next?
Enter the ‘squid-2.5.STABLE5’ directory
using the cd squid-2.5.STABLE5 command.
Here, you need to ‘./configure’ your instal-
lation. You can type ‘./configure --help’ to
see the available options. If you’re a lit-
tle unsure about what you’re doing, we
recommend you use the default setting
and just type ‘./configure’ and press [Enter].
This sets up the default installation. As
another option, you can use the ‘./con-
figure --prefix=<path>’ command, where
‘<path>’ is the path to install Squid to.

This done, run ‘make’ to compile
Squid. Next, run the ‘make install’ com-
mand. If you didn’t set any parameters
when running ‘./configure’, Squid is
installed into the default directory—
/usr/local/squid. If you specified the ’--pre-
fix=<path>’ switch, you’ll find Squid
installed to the path you specified. You
now need to edit the squid.conf file
according to your preferences, before
you can think of starting the service.

Huh? Conf, what?
Yes, conf file! Short for configuration file,
it tells Squid how to run and what you
want it to do. Open it using any text edi-
tor, and don’t be intimidated by its
length—you don’t have to edit each and
every line!

Within the conf file, you’ll find each
setting explained in detail, with the differ-
ent options and examples, so you aren’t
going to run into too many problems.

Below, we also specify a few important lines
that need editing as per your network and
requirements. We suggest that those not
well versed with Linux change only the fol-
lowing lines, as doing so will load perfect-
ly acceptable default values for Squid.

Under the ‘Network Options’ header,
the first line specifies the port on which
Squid listens to incoming connections.
The default value is 3128. In case this port
is already in use or is inconvenient,
uncomment the line, i.e, remove the ‘#’ in
front of the line that reads ‘# http_port
3128’, and change ‘3128’ to any unused
and acceptable port. This can be anything
above port 1024, as most ports below that
are used by root processes, and could
cause conflicts; the default is always rec-
ommended though.

Next, we move on to the ‘Objects
which affect the cache size’ header. Here,
you can specify the minimum and maxi-
mum size of objects that the proxy
caches. This determines the Internet surf-
ing experience that you or the proxy users
will have. An extremely high setting here
eats up hard disk space and the other
extreme wastes bandwidth. Depending
on your Internet connection speed, you
need to decide whether to change this or
leave the default values. For most con-
nections, the defaults are fine.

The first setting, 'cache_mem' sets
apart 8 MB of RAM on the Squid system
for quick caches. This is fine for, say, 2 to
10 users. However, this may not be
enough for a proxy server in a large com-
pany. In this case, if you have a decent
amount of RAM on the server, set this
higher to, say, 64 MB. However, don’t
reduce it, as performance will decrease.
Note that this is just the amount of mem-

ory Squid uses as cache, and not the total
amount of memory used. If you have 256
MB of RAM on the server, setting
cache_mem to, say, 128 MB could cause
unpleasant crashes.  We suggest you set
this to 64 MB for a server with 256 MB of
RAM and a maximum of 128 MB for
servers with 512 MB of RAM or greater.

Squid gives top priority to all cur-
rently downloading objects (also called
in-transit objects). Therefore, if you have
a large amount of traffic coming in
through Squid, and a low cache_mem set-
ting, everything will be cached to the
hard drive, which is slower, and also
means non-stop writing to the disk;
reducing the hard drive’s life.

Only uncomment the cache_mem 8
MB line if you want to increase this value.

Keep an eye out for the Tag: acl head-
er, which lets you set IP addresses of sys-
tems using Squid as the proxy. If you
have a small number of users, you can set
an acl line for each one. However, if you
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Do the following to set your client
browsers  to use the proxy server:
Mozilla
Go to Edit > Preferences, and expand the
‘Advanced’ option on the left. Click on
‘Proxies’ and click on the Manual proxy
configuration button. Enter the IP address
of your server under ‘HTTP Proxy’ and the
port you set Squid to listen to incoming
requests on. Click OK and try opening a
Web site. 
Internet Explorer
Navigate to Tools > Internet Options, and
click on the Connections tab. Click the
‘LAN Settings’ button and check the Proxy

Server checkbox. Add the local IP address
of the machine that runs Squid, and its
listening port. Click OK twice to exit the
configuration menu and you’re done.
Opera
Go to Tools > Preferences, click on the
Network option in the left pane, and then
on the ‘Proxy Servers’ button. Put a tick
in the HTTP checkbox, add the local IP of
the Squid system and the port that you
set. If Squid runs as a proxy for the FTP
and HTTPS protocols as well, tick the
respective checkboxes and add the same
details. Click OK, then Apply, and then
OK again. 

Setting up the Clients

When editing the squid.conf file, be very
careful about the acl lines you add. Make
sure that all acl lines and ‘http_access allow’
lines appear before the ‘http_access deny all
line’, otherwise you’re going to have a proxy
that won’t allow anyone to connect
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have around 100 computers using Squid
as the proxy server, you need to enter a
range of IPs. Let’s look at two scenarios:

First, two computers (X and Y) using
Squid, with IPs 192.168.0.2 and 192.168.0.3
respectively. By adding the lines ‘acl X src
192.168.0.2’ and ‘acl Y src 192.168.0.3’, you
permit only these two computers to access
the Internet through Squid.

In the second example, we allow all
IPs between 192.168.0.2 and 192.168.0.254
to access Squid. To do this, you need to
add the following line: ‘acl ‘entire_office’ src
192.168.0.2-192.168.0.254/255.255.255.0’.
This tells Squid to allow the user group
‘entire_office’ to access the Internet—you
can replace ‘entire_office’ with anything
you want. 

The next section is ‘http_access’. Here,
be careful to allow access to any group
you’ve added an acl line for. So for the
examples mentioned above, make sure you
add ‘allow’ lines above the ‘http_access deny
all’ line. You’ll see a line that says INSERT
YOUR OWN RULE(s) HERE TO ALLOW ACCESS
FROM YOUR CLIENTS. Add the lines here.

For the first example, add: ‘http_access
allow X’ and ‘http_access allow Y’.

For the second example, where we

allowed access to the ‘entire_office’
group, add the line: ‘http_access allow
entire_office’. Now, uncomment the
‘http_access deny all’ line, making sure that
it’s below the allow lines you just added,
and your permissions are all set. 

The final step is to find the
visible_hostname line, uncomment it and
add a hostname. Usually, this is the
machine name. 

Am I finally done?
Yes! All you need to do now is go to the
/usr/local/squid/sbin folder, using cd /usr/
local/squid/sbin and type ./squid to start
Squid. Use another computer’s browser
to connect to Squid and test it (See box
‘Setting up the Clients’ for details). Use the
./squid -k parse command to check for
errors in your squid.conf file. Try the
./squid -h command for help.

That’s all there is to Squid?
Unfortunately, no! We’ve shown you
how to set up a very simple HTTP
proxy—it’s secure, but in no way makes
use of anything even remotely close to
Squid’s capabilities. There are hundreds
of different possible configurations, and

each has its own benefits. We suggest you
spend some time reading up on Squid.
Squid, The Definitive Guide, by Duane Wes-
sels, published by O’Reilly books
(www.oreilly.com), extensively covers this
subject. If we were to list out every feature
that Squid offers, this issue would have
been tagged the ‘Digit-Squid special’!

You can also set up Squid to act as a
proxy server for HTTPS and FTP access,
and not just HTTP. Of course, you need
to use the respective switches with the
./configure command right at the begin-
ning. Apart from being a proxy server,
Squid can also throttle bandwidth, mak-
ing sure no client gets an unfair share.
You can also configure Squid to allow
certain users access between certain
times, or only on certain days of the
week, etc—the possibilities are endless.

Finally, we suggest you download its
configuration manual from http://squid.
visolve.com/squid/squid24s1/sq24.tar.gz to
get a better idea of what this ingenious
little software is capable of. Here’s hop-
ing we’ll see you Squidding down the
Internet soon!

ROBERT SOVEREIGN-SMITH

robert_smith@thinkdigit.com

JULY 2004
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Files will be back
I have a Celeron 1.7 GHz with a 40 GB

hard disk. After I ran disk defragmenter, I
lost all my MS Office documents (Word,
Excel, PowerPoint, etc). I even lost data on
my D and E drives. How do I retrieve
all my  lost data? 

Pankaj Singhai 

Use R-Studio (www.r-tt.com)—it’s one
of the best data recovery software avail-
able. Ideally, load R-Studio onto another
PC, connect your hard drive to it (pre-
ferrably as a slave) and then restore data. 

Note that once you detect the data
loss, do not install, copy or move soft-
ware or data on the drives in question,
and keep disk activity at a minimum, so
that lost files don’t get overwritten.

Also, be very careful when recovering
data; don’t recover any data onto your

hard drive itself—instead, recover the
data to the other PC you’re connecting
your hard drive to. Once that is done,
copy all the recovered data back.

Error loading Gdi.exe
I recently installed Windows 98 Second

Edition. My computer is an Intel Pentium
III, 256 MB SD RAM, and a 20 GB Seagate
hard drive. Whenever I switch on my
machine, it automatically boots into Safe
Mode. Then I get a message that says,
“Error Loading Gdi.exe. You Must Reinstall
Windows” and the computer shuts off
automatically. How do I fix this? 

Abhijit Mukherjee

The error appears as a result of either
improperly moving the Fonts folder of
Windows or by corruption of some font
files. The simplest option is to re-install

Windows again.
If you don’t want to re-install

Windows, be prepared to execute
some commands at the DOS
prompt. First boot the computer
via the Windows 98 CD-ROM, and
select ‘Windows 98 Startup disk
with CD-ROM support’.  Now exe-
cute the following commands one
after another:
md c:\windows\fonts
attrib +s c:\windows \fonts
extract/a d: \win98\ win98_22.cab

*.fon /l  c:\ windows \ fonts extract /a
d:\win98\win98_22.cab *.ttf /l
c:\windows\fonts 
Now, reboot the computer. If your Fonts
folder exists, then the problem is caused
by corrupt fonts, namely Vgasys.fon,
Vgaoem.fon and Vga850.fon. All you
need to do is extract these files from the
Windows CD-ROM, using the following
commands:
extract /a d:\win98\win98_22.cab vgasys.fon
/l c:\windows\fonts
extract /a d:\win98\win98_22.cab
vgaoem.fon /l c:\windows\fonts
extract /a d:\win98\win98_22.cab
vga850.fon /l c:\windows\fonts

USB ports to transfer files over
telephone lines

I have an old computer: a Pentium 233
MMX, 32 MB of RAM and Windows 98SE,
but without a USB port. The Device
Manager shows two devices of the device
type USB Controllers—SIS 7001 PCI to
USB Open Host Controller and USB Root
Hub. First, what are these? Second, using
these can I install a USB port? If yes, how?
And finally, is it possible to create a network
between two computers using their
modems and a telephone cable?

Arun Das

The two devices you mention are
USB controllers. This means your moth-

Lost all MS Office data. Windows doesn’t load. Deleted the only XP user account...
Hang on, don’t press the panic button. Here’s your way out

Right-click on the additional drive and click scan to
start the process
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erboard supports USB. You’re probably
just missing the cable that connects from
the motherboard to the back of the PC,
to give you USB headers where you con-
nect USB devices. 

Buy one, and attach it to your moth-
erboard. Of course if you don’t know
how to, we suggest you get an engineer
to do so. Also remember that once you
do this, you’ll still need to install USB
drivers for any device you attach in
Windows 98. 

Yes, you can connect with the help of
Hyper Terminal.  It comes bundled with
Windows. Keep Hyper Terminal in wait-
ing mode on one computer by going to
Call > Wait for a Call, and the other com-
puter makes the call. After the connection
is complete you can transfer files as
required.

Alternatively, you should set up
connectivity using serial or parallel cables
and get a much higher rate than other-
wise. Refer to this month’s QuickStart
(30 Minutes Expert) on Page 105 to set up
such a connection.

Fails minimum system 
requirements

I have a Pentium 4 1.4 GHz machine,
running both Windows 98 and Windows
XP professional. The display card is SiS630
on a Vintron motherboard. When I play
Back Alley Brawl, I get an error that says I
don’t have the latest version of OpenGL.
Where do I get this?

Jayharsh Krishnakumar

SiS630 is a PCI-based display card,
which lacks hardware support for
OpenGL. The minimum requirements
are an AGP card for the game to run in
OpenGL. One of the cheapest solutions
is the GeForce MX 440, which costs
about Rs 1,700.

Combine the powers of two
dial-up connections

I have a computer with two modems,
each with a separate telephone connec-
tion. I want to combine the speed of both
connections to surf the Internet. Whenev-
er I try to dial the second line, the first gets
disconnected. How do I solve this?

Saurabh

You need to use gateway software

such as Sygate Manager. Install Sygate
Manager, and set it up to manage both
connections. Enable the ‘Auto dial
additional line’ option. It will now
connect both connections when you
tell it to. If you download two files
simultaneously, Sygate forwards the
request of one file on one connection
and the other on the other connection.
If you add a third download, it is
sent to the connection with more
available resources. So, individual files
aren’t really downloaded faster, but
multiple files will be.

Random IP addresses
Whenever I connect to the Internet,

Internet Explorer opens some random IP
address. Even after deleting the addresses
from the registry under ‘HKEY_LOCAL_
MACHINE/SOFTWARE/MICROSOFT/INTER
NET_EXPLORER/MAIN’ and ‘HKEY_CUR-
RENT_USER’, the problem remains. Fur-
thermore, an unknown toolbar tries to
install itself. What do I do? 

Deep Kamal Gohain

You seem to have a problem with
spyware or adware. The best way to get

Invalid page fault in Paint
When I start MS Paint, my computer shows an error

message: “MS PAINT caused an invalid page fault in module
MFC42.DLL…”. What do I do?

Bharat Shah

This error message is caused by corrupted registry
entries for MS Paint. To resolve this problem, you have to
first uninstall Paint, then delete the registry keys and
finally reinstall Paint.

To do this, go to Start > Settings > Control Panel, and then
double-click on ‘Add/Remove Programs’. Click on the
Windows Setup tab, click on Accessories, and then click on
Details.  Uncheck the Paint checkbox, and click OK twice. 

Now, go to Start > Run, type ‘regedit’ and press [Enter].
Navigate to HKEY_CURRENT_USER\Software\Microsoft\Win-
dows\Current Version\Applets\Paint, and delete all the 
keys there.

To reinstall Paint, go back to the Windows Setup tab,
and check the Paint option we asked you to uncheck in the

first step, and click
OK twice.

Warning: Be very
careful when editing
the registry, and
remember to back up
your registry before
making changes to it.

1/4th AD

Illustrations: Mahesh Benkar
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rid of these programs is to install
an anti-spyware tool such as Spybot
to clean your system. Get it from
www.download.com.

Trial vs Full
I purchased a CD with Norton Antivirus

on it from a local contact. When I installed
it, it worked fine for a few days, and then
began displaying the message ‘Trial ver-
sion,’ and expired. I had to buy another
pack which is working fine. I want to know
how to distinguish between the two so that
one is not taken for a ride. 

Rakesh K

If the version of Norton you bought
is 2004, you shouldn’t forget to activate
the product using its activation process;
if you don’t, it will expire. If the problem
occurs even after activation, you should
contact Symantec. By default, you get a
year’s free subscription with the pack.
But if you bought a pirated pack there’s
nothing much you can do about it.

Errors in opening Web page
When I run a Java applet in IE6 it says

“alt=”Your browser understands the
<APPLET> tag but is not running the applet
for some reason.” Your browser is com-
pletely ignoring the <APPLET> tag!" How
can I can run my Java file, applet.htm,
through IE6?

Jayantadeep

As a first step, download the Java
Runtime from www.sun.com and install it.
This should solve the problem. Also, 
you should install the latest service pack
for IE (www.microsoft.com/downloads).
Alternatively, it could be a problem with
the Java applet code in the .htm file,
which you will have to debug for it to
run properly. 

Internet sharing
I have five PCs connected in a LAN with

one running Red Hat 9 and the others run-
ning Windows XP. I have two LAN cards on
the Linux machine. I’d like to connect to
the Internet through DIAS (cable connec-
tion). The phone line is attached to eth0
on the Linux machine, and the second LAN
card is used for the local network. The
address for DIAS line is: IP: 10.70.0.1; Sub-
net Mask: 255.255.255.0; Gateway:
61.3.129.194; Primary DNS: 61.0.128.65;
Secondary DNS: 61.0.0.5. How can I con-
figure my Internet connection and how can
I share the connection with the other

machines?

Sukanta Hui

First, you can’t attach a phone line to
eth0; only an RJ45 connector can con-
nect to the LAN card. Next, the cable
connection would have an RJ45 connec-
tor, and not an RJ11, which is what you
have connected to the eth0, and that is
right. Now, to share the Internet connec-
tion, install Squid, and configure the
proxy port. By default, the port is 3128.

You can change this if you want to. As
one LAN card is connected to the cable
from your Internet service provider,
specify the IP, subnet mask, gateway, and
DNS of the LAN card as specified by the
operator 10.70.0.1.  For the other LAN
card, specify the IP address of your local
LAN. Typical local LAN IP address range
from 192.168.0.1 to 254; use an IP from
amongst these for each of the five PCs
you have. Finally, in the Internet options
on the Windows machines, set the proxy

settings as the local IP address of the
Linux machine and the port as 3128,
unless it’s been changed. Refer to the
Squid workshop in the Linux Works sec-
tion of this issue for the exact steps.

Virtual memory is full
I have Windows 98 on my C: drive. The

C: drive is 4 GB, and it has 1.5 GB of free
space. But whenever I start using any pro-
grams, the swap file consumes all the free
space, i.e., 1.5 GB. At the same time, Win-
dows says the C: drive is full. I cannot use
any programs because it shows a message
saying something like "Virtual Memory is full.
Try after closing any opened programs."

Unnikrishnan Bhaskaran

Keep in mind that the swap file size
changes dynamically because Windows
is auto-managing the file. The first thing
you can do is set an upper limit to the
size of the file by going to My Computer >
Properties > Performance > Virtual Memory.
Here, select ‘Let me specify my own vir-
tual memory settings,’ and set the maxi-
mum file size. 

Windows starts using virtual memory
when there’s a shortage of physical RAM.
If you use too many applications or mem-
ory-heavy applications, virtual memory
comes into play. The more the RAM you
have, the less dependent Windows would
be virtual memory.

One point of caution here is that one
of the applications you’re running might
be causing a memory leak. If this is the
case, then you won’t be able to get rid of
the problem even by increasing RAM and
virtual memory. You’ll have to first find
the application causing the problem, and

Deleted the only user account
I run Windows XP, and recently

deleted the only user account. I have
disabled the Guest account, so I can’t log
on to Windows XP. I didn’t provide any
password for ‘Adminis-
trator’, but I am unable
to logon using adminis-
trator credentials. It says
‘Could not log on. Make
sure the domain name
and password are in cor-
rect case’. Is there any
way to retrieve the
password or account
that I had deleted?

Prakruti V. Vora

Boot your computer in Safe 
Mode, then log on using administra-
tor credentials. After that, enable 
a guest account and/or create a 
new account.

Go to the Control Panel, then to Internet
Options, then to Connections, and finally, to
‘LAN settings’

➜



then either get a patch if available or get a
newer version of the software.

Protection error
I have a Motorola SM56 PCI speaker-

phone modem. Whenever I connect to the
Internet, the connection gets disconnected
and the system  display reads, “Windows
protection error. Press any key to continue”
and then it shuts down. The only advice I’ve
received is to format my hard disk. Also, can
you let me know where I can find the driv-
ers for Windows XP for the modem?

Karthik

The drivers for the Motorola
SM56 PCI card are available at
http://www.motorola.com/softmodem/sm56_d
ownload.htm. Depending upon the
modem, for example, if the modem is
Data/Fax/Voice, Data/Fax, etc, choose the
file to download. Actually, the Web page
offers drivers for all operating systems
and for both ISA and PCI modems.
Choose the proper file.

Designers’ choice
One of our clients wants to purchase an

AMD Athlon 64-based system. He is a

graphic designer, and uses Photoshop most
often, working with files of sizes in excess of
500 MB. What system would be ideal here?

I downloaded Microsoft XP, the 64-bit
edition. Does it give good performance
with the Athlon 64? Also, how should I con-
figure the system for best performance?

Krishna Prasad

You should opt for an Athlon 64. It
gives better performance than the Intel
Prescott. Also, in memory-intensive
applications like Photoshop, an Athlon
64 will give much better performance, as
the memory controller is within the CPU,
as against the Prescott, where the memo-
ry controller resides on the Northbridge.

The second factor is memory. The RAM
needs to be high enough, say 768 i.e. 512 +
256 MB.

Fibre optic vs WiFi LAN
I have a five-PC network on a CAT 5

cable and a hub.  What do I need to set up
a fibre optic cable network. I’d also like to
know what’s needed to set up a WiFi net-
work, and the approximate costs involved.

Anil Gupta
Setting up a fibre-optic LAN would be

a very costly affair, and also a tedious
and complicated process. You’ll need a
LAN card with optical fibre cable con-
nectors, an optical fibre switch, an opti-
cal fibre patch cable and connectors.
You will also need equipment to con-
nect the cables to the connector, etc,
basically, lots of costly equipment.
Fibre-optic connectivity is used to set up
a high-speed backbone, while WiFi is
used for connecting people on the
fly. WiFi is simpler and also compara-
tively less expensive, but definitely
more expensive then a wired LAN.
You will need a WiFi access point,
which would cost around Rs 10,000,
and five WiFi cards costing around Rs
3,000 each. The software needed to set
up the access point comes bundled
with the hardware.
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sos@jasubhai.com
E-mail us your
computing
problems, and we
may answer them
here! Since we
get more mails

per day than we can handle, it may take
some time for your query to be
answered. Rest assured, we are listening!

More the RAM, better the
performance

I am in the process of finalising the
configuration of my new PC, and want to
know whether 512 MB of RAM is suffi-
cient to run Maya, or should I opt for 1 GB
of RAM?

Kumaresh

Minimum memory requirements
depend on the applications you use. For
office applications 256 MB is enough; for
2D image editing tools 512 MB should be
sufficient, while for AV and 3D, a mini-
mum of 1 GB is necessary. Basically, as
much RAM as you can afford and cram
into your system is recommended. Maya
will definitely run with 512 MB of RAM,
but will be sluggish. 

Free e-mail via POP3
I wanted to know if there are any free
POP3 e-mail Web sites. I am sick of using
Hotmail and the like, as they are too
slow.

Nikhil

Most free e-mail service providers
do not provide POP3 mail access. Some
providers such as Spymac.com,
Myrealbox.com, etc, offer POP3 access. Of
course, they charge a premium for this,
for example, Rediffmail.com. You can also
try Yahoo! Pops (http://yahoopops.source-
forge.net), which lets you download e-
mail via POP3 from the popular and
free e-mail provider, Yahoo!. Download
the free tool and install it on your
machine. Now configure your
POP3/SMTP server address in your e-
mail client to 127.0.0.1. Also you need
to change the timeout in the advanced
settings to three minutes or more, oth-
erwise the e-mail client will keeping
getting disconnected and no mails will
download.

One OS in dual boot failed
I have both Windows 98 and Win-

dows XP installed on my system. For
some time now I’ve been having prob-
lems with Windows Explorer whenever I
start Windows 98, I get an error that says,

“Explorer has performed an illegal opera-
tion and will be shut down”. If I format
and re-install Windows 98 SE, will my
Windows XP install be affected?

Soummya Seal

It all depends on how the OSes are
installed. If both Windows 98 and
Windows XP exist on the same parti-
tion, you’ll have to delete the Windows
98 ‘Windows’ folder. Next, you’ll have
to modify the boot.ini file, and remove
the line corresponding to Windows 98.

Your safest bet is to reinstall Win-
dows 98 with the Upgrade option. After
this you need to boot via the XP
bootable CD, select the Recovery Con-
sole option, login via administrator priv-
ileges and execute the fixboot.exe and
fixmbr.exe commands. However, If both
OSes reside on different partitions, all
you need to do is format the partition
that contains Windows 98, reinstall it to
the same partition and modify the
boot.ini file as mentioned earlier.

FAQs
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50 Easter eggs
Take a look at some of the smart little fun things you

can find hidden within some of the most commonly

used software

54 Game cheats

Tired of struggling with that game? We’ll show you

how to become a gaming god in no time—cheats

for 23 of the most popular games inside

Take a look at how to have fun with some
professional software, and also become a
serious force with the most popular of games
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■ tips and tricks

Easter Eggs are undocu-
mented, hidden tidbits in

software, games, etc., that
users accidentally stumble
upon. These are fun to find,
and thousands have already
been documented.

Easter eggs started out as
a rebellion by early program-
mers who did not get credit
for their work. That’s why
some of them are as simple
as a scrolling list of program-
mers. However, you also find
some as advanced as a
hidden car racing game in
Excel 2000. So read on to
explore the amusing world
of Easter eggs. 

Windows XP
Unexpected shutdown  

For this, you need a software
called Resource Hacker. Get
it from our July 2004 Mind-
ware CD, or download it
from http://www.users.
on.net/~johnson/resource-
hacker/. Resource Hacker is a
free tool to view and modify

32-bit Windows executables
and resource files.
Open the msgina.dll file,
located in the C:\Windows

\System32 directory, in
Resource Hacker. In the left
pane, expand Dialog > 2210 >
1033. A dialog box opens at
the bottom right hand of the
screen. Notice the line just
below the drop-down list

EASTER EGGS entitled ‘Why did the
computer shut down unex-
pectedly?!’

Solitare Win Win
Force Solitare to win by a
hack. Here’s how: Open
sol.exe located in
C:\Windows\System32\ using
Resource Hacker. Expand
String Table > 64 > 1033 in the
left pane. Notice a line in the
right pane saying 1010,
“Force a win”. Use these
numbers to enable the Easter
Egg. Now expand Menu > 1 >
1033. Create a menu by
typing the following just
before the last closing brace:
POPUP “&Easter Egg”
{

MENUITEM "&Egg 1",  1008
MENUITEM "&Egg 2",  1009
MENUITEM "&Egg 3",  1010

} 
Now, click the

Compile Script
button. Next, go to
File > Save and save it
in the original loca-
tion, i.e.,
C:\Windows\System32
\sol.exe. Also, replace
sol.exe in the
C:\Windows\System32
\dllcache folder.
Now, a new menu
Easter Egg appears
with Egg 1,  Egg 2
and Egg 3 as
options. Click Egg 3
to force a win.

WinRAR
Falling Book 

Works on: WinRAR 3.20,
3.30
WinRAR—the popular file
compression utility—has a
smart Easter Egg. Start

WinRAR and go to Help >
About. Next, click the book
icon and it starts to fall.
Further, if you press and hold
[Shift], and click the logo, you
see a small sail boat near the
letter ‘R’. You may have to
click a few times to see it ,
though.

Winamp
Full Screen Credits

Works on: Winamp 2.91
Start Winamp, go to
Winamp menu, click Null-
soft Winamp and switch to
the Credits tab to see an
animated screen. Now, hold
down [Ctrl] + [Alt] and right-
click twice on the animation.
This changes it to full-screen
mode and alters the anima-
tion a bit. Repeat the same
step to get back to normal
mode. This full-screen
animation depends on the
active visualisation. Change
it to spectrum and then oscil-
loscope and repeat the
process to see the difference. 

Full Screen Credits
Works On: Winamp 5
An animated logo comes up
as you go to Winamp menu >
Nullsoft Winamp and click the
Winamp tab. Press and hold
[Shift] and double-click on
this logo to change it to an
ASCII art.

Dancing Llamas
Works On: Winamp 5
This is one amusing egg in
Winamp 5. First play a song
with fast beats and heavy
bass. Now, switch to the
modern skin and resize the
main window. Increase its
width to make the Beat

Resource Hacker is a handy tool to find out
what’s hidden inside Windows System files.
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Analyzer visible to the left of
the Spectrum Analyzer. Now,
hold down [Shift] + [Ctrl] +
[Alt] and click the centre of
the Beat Analyzer. You’ll see 
two llamas striking their
heads on the ground in tune
with each beat.

Transparent Beats
Works On: Winamp 5,
Windows XP or 2000
Play a song that’s akin to the
one described above. Now,
ensure that the main window
has the focus (its title bar
should be brighter than that
of other windows) and type
‘NULLSOFT’. However, since
pressing [L] opens the File
Open dialog, you’ll have to
press [Esc] after each [L].
Hence, you end up typing [N]
[U] [L] [Esc] [L] [Esc] [S] [O] [F] [T].
This done, you see that the
main window goes transpar-
ent at each beat and then
reverts to being opaque.

This Easter egg consumes
a lot of system resources. If
your system runs slow, type
NULLSOFT again to turn it
off, or just exit Winamp and
restart it. 

In Winamp 2.91, the title
bar shows a funny change
when you do the same thing.
Try this and see yourself.

MS Excel 
Excel has
several interest-
ing Easter eggs,
some of 
which we
mentioned in
the article ‘Excel
Entertainment’
in the Decem-
ber 2003 issue
of Digit. Find

that in the 
36 issues archive CD of June
2004. Here, we repeat some
‘Excel’lent (Eggcellent?)
Easter eggs.

Dev Hunter Game
Works On: Excel 2000,
requires DirectX 
This Easter egg is compli-
catedness re-defined. To
access it, create a new file in
Excel 2000 and go to File >
Save as Web Page. Choose
‘Publish Sheet’ and ‘Add
Interactivity’.  Next, save
and open it using Internet
Explorer. You see the Excel
file in the middle of the
page. Go to row 2000,
column WC and select this
row. Press [Tab] to highlight
the cell WC:2000. Then
press and hold [Shift] + [Ctrl]

+ [Alt] and click the Office
logo in the upper-left
corner. 

A car racing game Spy
Hunter should start. Use the
arrow keys to steer, [Space] to
fire, [O] to drop oil on the
road and [H] to turn on your
head lights.

Windows 98
Teapot

Works on: Windows 98,
Windows 95
Right-click on the desktop
and select Properties. Go 
to the Screensaver tab 

and choose the Pipes
screensaver. Click
Settings and select
Pipes as Multiple, Pipe
Style as Traditional,
Joint Type 
as Mixed and Surface
Style as Solid. Click
OK and then click 
the Preview button.
Watch the screen-
saver churn out
teapots instead 
of joints!

Windows 98 team
Go to C:\Windows\ Applica-
tionData\Microsoft\WELCOME
and find the file Weldata.exe.
Right-click it and select
Create Shortcut. Now, right-
click the shortcut and
select Properties. In
the General tab, add
Y o u _ a r e _
a_real_rascal to the
Target text box, after
the path, and choose
Minimized in the
Run combo box.
Click OK, double-
click the shortcut
and enjoy!

Windows 98 team
Version 2
Works on: Windows 98
There is another way to view
Windows 98 team credits.
Double-click the clock in the
system tray to bring up the
Date and Time Properties.
Click the Time Zone tab, hold
down [Ctrl] and click and hold
the mouse button  on Cairo,
Egypt. With the mouse
button still pressed, drag the
pointer to Baton Rouge, LA.
Release the mouse button but
keep [Ctrl] pressed. Click on
Baton Rouge, LA again and
drag it to Redmond, WA. The
credits movie starts to play
once you release the mouse
button. You can also try
doing the same thing in
Regional Settings under
Control Panel.

Hearts Cheat
Works on: Windows 98
Interested in the cards of
other players while playing
Hearts? Try this. Go to Start
> Run, type ‘regedit’ and press
[Enter]. Navigate to the key
HKEY_CURRENT_USER\Soft-
ware\Microsoft\Windows\Curre
ntVers ion\Applets\Hearts .
Here, create a new string,
name it ZB, and enter 42 as
its value. Now, close the

Find Easter eggs in Winamp to reveal two llamas
headbanging, and also to make it transparent

The hidden windows 98 credits

It’s hard to believe that this is an Easter
egg hidden inside Excel 2000
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registry editor and start
Hearts. During the game,
press [Shift] + [Ctrl] + [Alt] +
[F12] to see what cards the
other players have.

MS Access
Magic Eight Ball 

Works on: MS Access 97, MS
Access 2000
Create a blank database in
Access and then go to Macros
> New. Now, press the Space-
bar and click
Close. Save the
macro as Magic
Eight Ball.
Click and drag
it to the tool-
bar. The icon
should change
to the picture
of an eight ball.
Click it for
some advice!

Access 97
Setup “Lizard” credits
Works on: MS Access 97
MS Access includes a Setup
wizard to create setup
programs used to distribute
databases. This Easter egg is
included in this Setup
wizard. Start this Setup
wizard from the Start menu,
select ‘Create a new set of
setup options…’, click Next
and then Add. Browse to the
folder C:\Program Files\
Microsoft Office\Office\, select
All Files in the ‘Files of 
Type’ field and choose
mso97.dll.

The screen goes blank and
the credits appear. Notice
that the letters are made up
of tiny lizards. Also, look out
for the warning at the end 
of them.

Macromedia
Flash

Gary’s Car Jump

Works on: Macromedia Flash
4 and 5

For this, go to Help >
About in Macromedia Flash.
Now, double-click the
Macromedia logo—the one
with two upward arrows
located at the right of the
about box. Click the Thanks

button and the logo
bounces up and down. 
Click the Team button to
play a cool game—
Gary’s Car Jump.

Six Games
Works On: Macromedia Flash
MX
While Flash 4 and 5 have
one hidden game each,
Flash MX has six. To access
these, go to Help > About.
Now, click underneath the X
of the logo. Clicking the
correct spot may need a few
tries. Once you do so, your
screen turns dark blue and
offers you a choice of six
games—Gary’s Bike Jump,
Gold rush, Asteroids, Lunar
Lander, Breakthrough and
Flash Blox (Tetris).

Adobe Illustrator
Works On: Adobe Illustrator
10

Teri, one of the developers
of Adobe Illustrator 10, coded
this egg for his daughter. Open
any document in Illustrator,
open the Symbols palette and
set it to List view, so that you
see the symbol names.
Double-click a symbol to
rename. Type in “Teri’s daugh-
ter’s” and press [Enter]. Note
that this is case-sensitive. 
Now, double-click it again and
rename it to something that
might logically be associated
with Teri’s daughter’s—for
example, name, eye colour, etc.
Now, when you press [Enter],
instead of renaming, it treats
this as a query and renames the
symbol to the answer, or a
random failure message. 

For the next question, you
will have to rename it back to
Teri’s daughter’s first and then
rename it to the question.
After a certain number of fail-
ure messages, it starts giving
hints as to what to ask for—
You haven’t asked about her
favourite food yet.

Birthday Cake 
Works on: Adobe Illustrator
8, 9 or 10

Create a new document in
Illustrator. Now, open the
Brush palette and click the
‘New Brush’ button. Select
‘Calligraphic’ and enter
angle 5, roundness 26 and
diameter 56. Now, when
you start drawing with this
brush, instead of the normal
brush strokes, it draws birth-
day cakes. To make different
cakes, set the sliders on the
right to ‘random’.

ImageReady
Ducks

Works on: ImageReady 7.0
and CS mageReady developers
seem to have a soft corner for
ducks. This is evident from
this Easter egg, which is actu-
ally composed of more than
one egg. First, press and hold
[Ctrl] and go to ImageReady
> About ImageReady. You see
a different About screen, with
its code name, for example,
Taconite in case of
ImageReady CS. That’s the first
egg. Wait a few seconds for the
second and the 
credits will start scrolling.
Speed them up by pressing
[Alt]. At the bottom, you see
two big ducks with the line,
“Long live the Ducks!”

More ducks
Works on: ImageReady CS
For the really funny duck’s
egg, press [Ctrl] and go to
ImageReady > About
ImageReady. Now, if you press
and hold [Ctrl] again, the
mouse pointer changes to a
rubber stamp. Click anywhere
on the image and a duck
appears. You can stamp up to
ten ducks. To erase all ducks,
press [Ctrl] + [Shift] and click.
To ‘shoot’ ducks one by one,
press and hold [Alt] + [Shift],
aim and click. 

This is one of the six games hidden in Flash MX

Duckerboard in ImageReady CS
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Duckerboard
Works on: ImageReady CS
By default, the grid that you
see is similar to a chessboard.
To change its look, open a
new file with a transparent
background. Click anywhere
inside the canvas window and
type ‘duckerboard’. Your
chessboard like grid turns into
a duckerboard.

Photoshop
Credits

Works on: Photoshop 6, 7, CS
and ImageReady 7, CS

This egg works on almost
all versions of Photoshop and
ImageReady. Click [Ctrl] and
go to Help > About. In case of
older versions, you may have
to press [Ctrl] + [Alt]. This
brings up a different screen,
with the code name of the
software. The credit list starts
scrolling after a while, and if
you press [Alt], the scrolling
speeds up. Read the last lines
of the credits carefully—
they’re really interesting.

Cat Eyes
Works on: Photoshop 7
Go to Help > About Photoshop,
while holding down [Ctrl].
The Liquid Sky splash screen
appears. Now, press [Print
Screen], click File > New and
paste the clipboard contents

using [Ctrl] + [V]. 
Now switch to

the Channels
palette and click
the Red, Green
and Blue channels
one at a time.
Notice the eyes of
the cat move.
Change the Hue
using [Ctrl] + [U]

and an interesting effect
comes your way.

Begone
Works on: Photoshop 7, CS
To see this egg, open any file
or create a new one. Next,
press and hold [Alt], click the
triangle at the top-right
corner of the Layer palette
and then click Palette options.
You see a Merlin window
appearing. If you can’t read
the text on the title bar, right-
click it and then click Move.
Use the right-arrow to resize
and then press [Enter]. Click
the Begone button to close it.

Outlook
Ren Hoek

It is named after the charac-
ter from the animation
series Ren & Stimpy Show.
Open Outlook 2000 and
type Ren Hoek in the ‘Find a
Contact’ textbox. Outlook
will show a dialog box
saying that it cannot find
the contact. This egg may
not work if you do have a
contact named Ren Hoek in
your address book. Now, go
to Tools > Marco > Macros.
In the Macro Name box,
type OL2Rocks. Click the
Create button to open the
About Microsoft Outlook
dialog. Hold down [Shift] +

[Ctrl] + [Alt] and click OK.
The Outlook 2000 team
credits appear. Try to catch
the names as they fly to the
mailbox.

MS Word
Word Credits

Start MS Word 2000 and go
to Help > Show
Office Assistant
to bring the
office assistant.
In the ‘What
would you like to
do?’ box, type in
Cast and click
Search. From the
results, click Microsoft Office
2000 User Assistance Staff.
Then, click the graphic on
the Word help screen.

VB Credits
Works on: MS Word 97,
Word 2000
Start Word and press [Alt] +
[F11] to open Microsoft Visual
Basic Editor. Right-click
anywhere on the toolbar and
click Customize. Now, go to
the Help Menu and right-click
‘About Microsoft Visual Basic’.
In the Name field, you see
&About Microsoft Visual
Basic, which is editable.
Change it to Show VB Credits.
Now close the Customize
dialog box and then go to
Help > Show VB Credits. Turn
on the speakers and enjoy
these credits. You can use the
arrow keys to adjust the speed.
These will be different for both
the versions of Word.

Dreamweaver
Toast your own

Works in: DreamWeaver 2.0
or later

Create a blank page in
DreamWeaver. Then, go to
Insert > Layout Objects > Layer
and create a new layer. Now,
open the Layers palette by
going to Window > Layers.
With the layer selected,
double-click its name in the
Layers palette and rename it

to ‘ToastYourOwn’. Press
[Enter] and you see a dialog
box saying, “So, I see you
want to toast your own...”.
Click OK to be taken to
www.dreamcentral.com/tyo/.
Interesting!

A Game
Works in: Dreamweaver 4 or
later, requires FireWorks to be
installed

Start Dreamweaver and go
to Commands > Create Web Photo
Album. Enter the title of the
album as play a game. Click
OK and have fun! 

Developers’ Pictures
Works in: Dreamweaver 2.0
or later
Open a page that has images
in Dreamweaver. Now, select
the image, hold down [Ctrl],
and double-click the image
thumbnail in the Properties
palette. Keep on double-
clicking, while holding
down the [Ctrl] key 
and you see photographs of
the developers and 
their names.

The credits screen with ducks in ImageReady

See the photographs of the developers in
Macromedia Dreamweaver



Age of Empires 2
To use these cheat codes,
press [Enter] while playing
the game, type in the code
and press [Enter] again.

Age of Mythology
To use these cheat codes,
press [Enter] while playing
the game, type in the code
and then press [Enter] again.

Airport Tycoon 2
To use these cheats, press [~]
to get the console while play-
ing. Enter these codes and
press [Enter] to activate.

America’s Army
To use these cheats, press [~]
to get the console while play-
ing. Then enter these codes
and press [Enter] to activate.
These will only work on
servers with cheats activated. 

Unlock online levels 
To use these cheats, press [~]
to get the console while play-
ing. Thereafter, enter the
following commands and

press [Enter] to activate:
‘mpcheat changeclass
<code>’. Substitute ‘<code>’
with one of the codes
mentioned below 

Call of Duty
To enable cheats on this
game, locate the executable

file in Windows Explorer.
Most probably, it will be
C:\Call of Duty\CoDSP.exe.
Right-click the file, go to
Send To > Desktop (Create
shortcut). Now go the desk-
top, right-click the created
shortcut and click Properties.
In the target box, add the
following to the end of 
the path: ‘+set thereisacow
1337 +set developer 1
+setsv_cheats 1 +set
monkeytoy 0’

Now click OK and double

click the shortcut to start the
game. Then, press the [~]
during the play and enter
following codes.

Counter-Strike
Condition Zero
To enable cheats, press [~]
and enter ‘sv_cheats’. This
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behindview 1 

God 

Fly 

Ghost

3rd person view

God mode

Flying

No clipping mode 

God 

give all 

notarget 

noclip 

give ammo

God mode

Weapons, items and amm

Enemies don’t target you

No clipping mode

Max out ammo

G

S

AK

S24

F

GP

SVD

M16A2 (w/ grenade launcher)

M81 (sniper)

AK47

M24 (sniper)

Fists

AK47 (w/ grenade launcher)

Dragonov sniper rifle

ROCK ON

LUMBERJACK 

ROBIN HOOD

CHEESE STEAK JIMMY’S

MARCO

POLO

AEGIS

NATURAL WONDERS

RESIGN

WIMPYWIMPYWIMPY

I LOVE THE MONKEY 
HEAD

TORPEDO#

BLACK DEATH

I R WINNER

1,000 stone

1,000 wood

1,000 gold

1,000 food

Reveal map

Remove shadow

Fast build

Control Nature

You lose

Destroy yourself

Gives VDML

Kill opponent #

Destroy all 
enemies

You win

THRILL OF VICTORY

SET ASCENDANT

DIVINE INTERVENTION

JUNK FOOD NIGHT

TROJAN HORSE FOR SALE

ATM OF EREBUS

THRILL OF VICTORY

SET ASCENDANT

GOATUNHEIM

WUV WOO

ISIS HEAR MY PLEA

RED TIDE

LETS GO!  NOW! (2 spaces between go and

now)

Win scenario

Show all animals

Enable used God power

Get 1,000 food

Get 1,000 wood

Get 1,000 gold

Win scenario

Show all animals

Turn enemy to goats

Flying purple hippo

Heroes from the campaign

Changes water to red

Faster gameplay

GAME CHEATS

MassDrop 

DoEarthquake 

DoTornado 

INeedCash 

SetBudget <number> 

SetCash <number> 

HideGame 

ShowGame 

Huge airport

Start earthquake

Start a tornado

Get $100 million

Replace <number> with the budget you want

Replace <number> with the cash you want

Hide game

Show game

Age of Empires 2 Cheats

America’s Army cheats

America’s Army Cheats

Call of Duty Cheats

Age of Mythology cheats

Airport Tycoon2’s cheat codes



enables the cheat. Then pres
[~] during the game play and
enter these cheats.

DX-Ball 2
During the game, type 
‘eureka’. You will hear a tune
if it is typed correctly. Now,
press any of these keys:

Grand Theft
Auto
To use these cheats, first go to
the Character Select screen
and press [Delete], enter the
code and then press [Enter].
If [Delete] doesn’t work, use
[Backspace] instead. 

Hard Truck 2
Pause the game and type in
the following cheats:

Hidden and 
Dangerous
To enable the cheats, type
‘unlockcheatmode’ at the
Campaign Select screen. A
clicking sound indicates that
the code is entered correctly.
Use these specific cheats
during the game play:

The Hulk
Enter cheats by going to
Options > Code. Activate them
by going to Options > Special
Features > Cheats.

Max Payne
To enable the cheats, you need
to enable the console first. To
do so, start the game with the
‘-developer‘ parameter. Create a
shortcut for the game and add
this parameter at the end of
the path in the target box.

Start the game and press
[F12] to bring the console
and enter any of the fol-
lowing  cheats:

Midtown 
Madness 2
To enter cheats, press [Y] dur-
ing the game play and enter
these cheats:

Motocross 
Madness 2

Various Cheats

Type Big Heads at the main
menu and everyone’s head
becomes heads . If you fall
down, press [Tab] and you get
up immediately. To do a nose
wheelie stunt, take a small
jump when the landing space
is clear. Before you land, lean
forward until the bike
becomes vertical. Now hold
the break button and see
yourself doing the stunt.

Need for Speed
Underground
Go to the Main > Statistics. Go
back again by pressing [Delete]
or [Backspace]. Now enter the
codes below:

No One Lives 
Forever 2
Press [T], then enter one of the
following codes:
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God 

Fly 

notarget 

Noclip 

impulse

101

God mode 

you will fly 

No one will target you

Go through 

You’ll receive a sniper rifle,

an AK 47, 3 grenades and a
desert eagle

6031769 

itsgallus 

stevesmates 

itcouldbeyou 

suckmyrocket 

itstantrum 

Unlimited life

All levels all cities

No police presence

999,999,999 points

All weapons, armour,

and jail key Unlimited
lives

zombie 

bighead 

killthemall 

missiondone 

openalldoor 

allammo 

noplayerhits 

goodhealth

After death return as
zombie
Big heads 

Kill enemies

End current mission OK

Open all doors

Get all weapons

High falls are the only
thing that hurts player

Resistant to gunfire

[Right]

[Left]

[Down]

[Up]

<any key>

[F6]

[F5]

Advance to next board

Return to previous board

Advance to last board in set

Return to first board in set

Random power-up

Turn Music Off

MIDI On/Off

GMMSKIN

FLSHWND

ANGMNGT

GRNCHTR

HLTHDSE

BRNGITN

MMMYHLP

FSTOFRY

BRCESTN

TRUBLVR

Be Invincible

Get regenerator

Rage Meter to Max

Unlimited continues

Double HP

Double HP for enemies

Half HP for enemies

Killer punch

Solve puzzle

Get all levels

winalottery 

openallroads 

hardtruck-
isthebest
advancedmap

fillup 

minesoff 

[Backspace]

Display all police
units on the map

All other vehicles are
buses

All other vehicles are
compact cars

All other vehicles are
airplanes

All other vehicles
move much faster

All traffic vehicles
drive around in
reverse

showme cops

big bus party

tiny car

jet planes

warp eleven

amizdA eoJ

Counterstrike Condition Zero
Cheats

DX-Ball 2 cheats

Grand Theft Auto cheats

Midtown Madness 2 cheatsThe Hulk cheats

Need for Speed Underground
Cheats

Hard Truck 2 Cheats

Hidden and Dangerous cheats

Unlock circuits 

Unlock sprint

circuits 

Unlock drag

circuits 

Unlock Petey

Pablo 

Unlock Rob

Zombie 

Unlock Mystikal 

Unlock Lost

Prophets 

All level 1 perform-

ance parts

All level 2

performance parts

All drift tracks

Drift physics

gimmesomecircuits 

gimmesomesprints 

gimmesomedrag 

gimmeppablo 

gotcharobzombie 

havyamystikal 

needmylostprophets 

allmylvloneparts 

seemylvl2parts 

driftdriftbaby

slidingwithstyle
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Get money and license

Get all roads

Get money and license

See hidden containers
on map view 

Unlimited fuel 

Get rid of mines

Use it to repair a damaged
truck sans any cost

Here we’ve only given the
cheat codes themselves, as
they’re self-explanatory:
god c_addhealth

GetAllWeapons GetInfiniteAmmo

GetBaseballbat GetBeretta

GetBerettaDual GetDualBeretta

GetDesertEagle GetSawedShotgun

GetPumpShotgun GetJackhammer

GetIngram GetIngramDual

GetDualIngram GetMP5

GetColtCommando GetMolotov

GetGrenade GetM79

GetSniper GetHealth

GetPainkillers GetBulletTime. 
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Postal 2
Press [Shift] and [@] (or [~] on
some systems) to make the
Game Console Window
appear. Type in ‘SISSY’ to

enable cheat mode, and then
enter the cheats:

Serious Sam
Bring up the console using
[~], then enter one of the fol-
lowing codes

Tony Hawk’s Pro
Skater 4

Leaving the practice area
While playing in the Practice
mode, go to the fence at end
of the ramp, lie down, allot
and then just only slip

through. You’re now out of
the practice area and can
skate on the road. 

OTHER CHEATS
Unreal Tourn-
ment 2004
Single Player Cheats Press
[~] in the game to bring
down the console, or press
[Tab] for quick  console.

Road Rash
To enable cheats, first type
‘XYZZY’. Then use the fol-

lowing cheats to really go
crazy on the road:

Duke Nukem 3D
To cheat your way through
Duke Nukem 3D, just type in
the following codes during
the game play:

Hitman:
Contracts
Find the file hitmancon-
tracts.ini in the game’s fold-
er.  Open it with a text edi-
tor, and add this line to the
end of the file: ‘EnableCheats
1’. Now during gameplay put
in one of the following
cheats:

Skip the current level

Become invisible

Get weapons, ammo,

armour and health

Get the silencer, scope

and camera zoom

Become invincible

maphole 

poltergeist 

Kfa

Mods

God

Puts you in God Mode

Gives you all weapons, maximum ammo, and makes
you invincible

Gives you lots of cash

Gives you all radar-related items

Gives you lots of catnip

Gives you body armour

Gives you cop clothing

Gives you full health and several (4) medkits

Ghost mode (toggled; enter code again to turn off)

Fly mode (toggled; enter code again to turn off)

Alamode 

IAmSoLame 

JewsForJesus 

SwimWithFishes 

IAmTheOne 

BlockMyAss 

IAmTheLaw 

Healthful 

IFeelFree 

LikeABirdy 

All Levels 

Get Moon Gravity 

Matrix Mode 

Perfect Rails 

Perfect Manuals

Watch_me_xplode  

MOON$HOT 

FBIAGENT 

BELIKEERIC 

FREEWHEELIE

Toggles God Mode

Enables you to walk
through walls

Gives you full ammo on
all the weapons you
have

Gives you all weapons
and full ammo 

God            

Ghost          

AllAmmo     

Loaded 

Flight mode 

All items 

Invincibility 

Invisibility 

Kill enemies

please fly 

please giveall 

please god 

please invisible 

please killall 

No one lives for ever 2 cheats

Tony Hawk’s Pros Skater 4
cheats

Duke Nukem 3D cheats

Postal 2 cheats

Unreal Tournament 2004 cheats

Removes the police officer

Gives you a bat 

Gives you nitrous oxide

Gives you a chain

Disables cheat mode

Kill  cops

BRIBE

K’THUNK!

SPOON!

THWACK!

PLUGH

YES,OCCIFER

Road Rash cheats

Bomb

Be Invincible

Max out health

Gravity

Lethal Charge

Nail Gun Unlocked

Max Force Mode

Boxing Mode

Slow Motion

IOIER 

IOIRULEZ 

IOIHITLEIF 

IOIGRV 

IOILEPOW 

IOINGUN 

IOIPOWER 

IOIHITALI 

IOISLO

Hitman contracts cheats

dnunlock

dnhyper

dnskill#

dncoords

dnitems

dndebug

dninventory

dnweapons

dnmonsters

dnlooksfunnyshade

dncashman

dnstuff

dncornholio

Unlocks doors

Steroids effect

Set skill level

Shows your coordinates

Gives you power-ups

Displays debug info

All power-ups

All weapons and full ammo

Toggles the monsters off

Make monsters pink

Throws money when you hit the use key

All weapons, keys and power-ups

God mode and unlimited jetpack

Game Trainers
A game trainer is a third-party program that allows you to turn
on and off certain qualities that weren’t included in the game.
These can be Terminal Stay Residents (TSRs)—usually for DOS-
based games, or can remain running while your game is in
progress (for Win95-based games). This can range from unlim-
ited lives to unlimited ammo, invulnerability, etc. The trainer
alters the original memory locations to allow you to cheat where
you wouldn’t be able to without it. 
Visit http://www.cheatplanet.com/pctrainers.html to download
trainers for various games.

UPENDRA SINGHAI
upendra_singhai@thinkdigit.com
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Over the years, games have evolved
a lot, offering us a more mature
experience in terms of features,

weapons, save systems, and what not. Yet,
once in a while, it’s fun when scores of
dumb but deadly monsters zero in on you.

The Serious Sam series is considered to
be the pinnacle of this style. You had
hundreds of nasties rushing at you from
all possible directions. Will Rock (WR)
draws inspiration from this seminal game,
and brings back the same experience,
complete with the look and feel of the
original. In certain stages, it even surpass-
es its grand daddy.

It’s got the look!
WR closely emulates Serious Sam. While
gameplay is still more or less the same, 
the graphics have been touched up to look
even better. On closer inspection, it seems
that Saber Interactive apparently wor-
shipped Croteam’s smash hit and decided to
clone it literally. 

The premise of such a game is to pit
one man carrying 10 weapons against
hundreds of monsters, all pouncing on
him at the same time. What matter here
are your reflexes and hand-to-eye co-ordi-
nation. Puzzle-solving and strategising
come a distant second.

What’s the story,
Morning Glory?
This is another area where Saber
wastes more time. You’re Willford
Rockwell, studying archaeology
purely to get close to his girl-
friend, Emma, whose father hap-
pens to be a full-blown professor.
A research trip to Mt Olympus in
Greece leads to the discovery of
the city of the Gods. A bunch of
crazy terrorists  want to resurrect
the Greek Gods and kidnap
Emma to offer her to Zeus as a
bride. The professor gets slain
while rescuing his daughter, and
you accidentally set the Titan Prometheus
free, who infuses you with his power in
your quest for revenge.

Now compare this with Serious Sam,
which had the best story that a game of its
kind should have. It didn’t trouble you by
forcing something you weren’t interested
in anyway. Most of the players would mere-
ly ignore this and go on with the game.
Serious Sam had no story to speak of, and it
was proud of that fact. It was classy, unlike
WR, which tries to act ‘evolved’.

WR emphasizes on puzzles and com-
plex design. You have all those under-
ground passages and tunnels you need to

cross, when instead, you could have
spent all that time fighting monsters out
in the open. Then come the sick jumping
puzzles, where you have to jump from
one platform to another, with the odd
critter merrily sniping away at you. 

Finally, you have monsters that keep
coming back from the dead, hurling axes
at you. It might be interesting for a while,
but each level keeps throwing more and
more of these pests. Saber sadly opts for
quantity rather than quality here.

The last level can, at best, be tortu-
ous. Games like these are not supposed to

have levels that ask you to stop and think
where the hell you currently are. 

Despite all that, WR has its quota of
fun. A nice touch is added by the unusual
weapons, including one that pumps its vic-
tim with acid until it explodes, and a cross-
bow with fire-tipped darts. Among the
weapons, the minigun stands out. It’s fun
and user-friendly, spewing hundreds of
pointed tipped bullets a minute.

The sound effects and background
score are good enough to keep your foot
tapping. The game starts off with the 80s
classic I Wanna Rock by Twisted Sisters. It’s
fun to listen to, but soon gets monotonous.

Go for the Multiplayer...
One area where the game outclasses oth-
ers is in its co-op multiplayer mode. It
even beats Serious Sam hands down in
this department. Compared to this expe-
rience, the single player campaign 
is downright dull by comparison, and a
lot tougher. 

If you’re looking for a great game to
enjoy with a bunch of friends, then your
hunt is over. Will Rock will rock you, 
for sure! 

From SKOAR! magazine

Will Rock
Serious Sam relived, with more graphics, more fun

Genre: Action ■■  Developer: Saber Interactive ■■    Publisher: Ubisoft ■■    Distributor: Sujata Softech ■■  System Requirements: 500 MHz CPU, 128 MB RAM,
GeForce2/ Radeon class card, 750 MB free space, DirectX 9.0 ■■    Price: Rs 299 ■■  Web site: www.will-rock.com
Rating: ★★★✩✩✩✩

The first boss enemy you encounter. There’s plenty more
where that came from

✩✩

These horny buggers are among the most
irritating monsters you’ll encounter in any FPS
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America’s Army: Special Operations v2.0
Entertainment, Shock and Awe...

America’s Army (AA) has one
thing that FPS fans have 
lusted over since the time of

Doom—a good free FPS with multi-
player support. Version 2.0 of AA has
six new maps, a customisable M4, a
new server browser and two new sol-
dier classes—Special Operations and
Indigenous Forces. 

Training is made mandatory
before you can play online. Though
the initial missions are boring, they
can be entertaining at times, and you
need to upload stats to the game’s
Web site and get bragging rights for
your accomplishments.

The graphics and effects are
decent, but nothing extraordinary—just a
few impressive dynamic lighting effects.
The army has successfully breathed a 
blend of realism and fun into the game. 

The game has authentic weapon nois-
es. Minute details, like the soldier’s breath-

ing that affects your aim while sniping, add
to the realism. You can even tell if the mag-
azine shells are hitting hard or soft ground. 

The necessity to connect to the Inter-
net to complete a training level successful-
ly can be irritating. Patching the game is

no easy feat as some patches are
more than 250 MB in size. 

Treasure every flash-bang
and frag grenade, and use 
them wisely. Dynamic lighting
and shadows are also imple-
mented quite well. The weapons
in the game, though realistic,
tend to be too powerful. There’s
nothing like a good M249 SAW
in your hands, firing off several
rounds per second. 

However, the lack of land-
mines leaves something to be
desired. The distinctive maps pro-
vide several ambush points that
can be deceiving, so don’t be sur-

prised if you find jhonny_243 at an ambush
point, waiting for an unsuspecting target.    

America’s Army 2.0 can be an enter-
taining romp and is sure to keep you
engaged for the next few weeks. 

From SKOAR! magazine

Genre: Action ■■  Developer: U.S. Army  ■■  Publisher: U.S. Army ■■  System requirements: 733 MHz CPU, 128 MB RAM, video card with 32 MB VRAM,
600 MB disk space, DirectX 9.0 ■■    Price: Free ■■    Web site: www.americasarmy.com  
Rating: ★★★★✩✩

The crinkles around his eyes are due to all those years 
of looking into scopes

Star Wars Jedi Knight: Jedi Academy
Cool, riveting, and graphics aplenty

Jedi Academy runs on the Quake III
engine. Kudos to Raven Software
for modifying it, allowing it to

generate graphics that none of us
thought possible.    

You play Jaden Korr, a new stu-
dent in the Jedi Academy on Yavin 4,
who’s achieved the impossible—
building a lightsabre without any for-
mal training.   

The game has the normal slew of
FPS weapons like rocket launchers,
mines, railguns and sniper rifles. The
lightsabre has been modified, and
you now get three different sabres—
the standard Single Blade, the Dual
Lightsaber, and the Saber Staff. Force Pow-
ers also add to the coolness of the game.
Rage, Heal, Lightning and Protect are some
of the advanced powers available. 

The graphics are quite nice, while the
lightsabre animations are cool. On the flip
side, lip-synching in the game is terrible.
Weapon sounds lack variety. There is little

change in its soundtrack too.
However, level design is beauti-

ful. The frozen wastelands of Hoth,
the burning deserts of Tatooine, and
the skyscrapers of Corellia are won-
derfully presented. However, Jedi
Academy is plagued by the fatal dis-
ease—Poor AI Syndrome.  

One irritating feature is that you
cannot save the game after finishing
a mission, until you’ve chosen your
new powers and loaded the next
level.  

Multiplayer gaming in Jedi Acad-
emy is a nice experience. Force Speed
no longer slows down everyone else,

but speeds you up instead. All in all, Jedi
Academy is one heck of a cool game and
will keep you riveted for quite a while. 

From SKOAR! magazine

Genre: Action ■■  Developer: Raven Software ■■  Publisher: LucasArts ■■      System requirements: 450 MHz CPU, 128 MB RAM, video card with 32 MB
VRAM, DirectX 9.0 ■■    Web site: www.lucasarts.com/products/jediacademy
Rating: ★★★★

A lightsabre battle in full flow

✩✩
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CollegePro Science is a set of CDs span-
ning five subjects—general chem-

istry, bio-chemistry, molecular cell biol-
ogy, microbiology and genetics. There is
substantial information on almost every
sub-topic within these subjects you can
think of. 

A glossary helps you locate the
meaning of any term or phrase that you
come across while browsing through the
material. A good study aid at the college
level, this is a well-designed, well-laid
out set.

Ease of navigation is probably the
best aspect of this set. You can navigate
by subject, search by keyword, and view
diagrams via hyperlinks. In fact, each CD
is a large network of hyperlinks. You’re
never lost—there are clear paths to get
you back to where you came from—and
there are always related subjects dis-

played to prompt
you to go deeper.

However, don’t
expect this to be the
Encyclopaedia Bri-
tannica of all five
subjects. Despite the
additional informa-
tion across various
areas, the overall
coverage is not too
comprehensive. 

The topics are
dealt with to the
extent of detail that
the average college
student requires.
This marks the set as
meant specifically for
students—if you’re not a student, 
and you’re interested in, say, bio-chem-

istry, you might find the coverage a
little shallow.

This software comes in
handy for a student when it
comes to reviewing matter that
has been covered in class. Pick
up a topic, click, browse, revise.
Much better than rummaging
through books to find that lit-
tle piece of information you are
looking for. And, there will be a
structure to your revision (or
first reading).

One sore point may be
that the software might not
work very well for students
who are accustomed to using

Digests for study as well as revision.
Overall though, CollegePro Science is
definitely worth Rs 1,995.

RAM MOHAN RAO

CollegePro Science
This lecturer delivers

Publisher: Topics Entertainment ■■  System Requirements: Pentium Processor, Windows 95, 12 MB RAM, 4X CD-ROM drive, sound card
Phone: (425)656-3621 ■■  E-mail: info@topics-ent.com ■■  Web site: www.topics-ent.com ■■  Price: Rs 1,350
Rating: ★★★ ✩✩

The cover boasts that the book entails
Internet basics, Web browsing, e-mail

and chat, fun and games, virii and hack-
ers and Web pages. A look inside, howev-
er, throws up a few discrepancies.

A major part of the book is devoted to
a tutorial on setting up a small Web site.
It is quite comprehensive as a hands-on
guide to someone who is not too Internet-
savvy and wants to learn the basics of Web
authoring—probably to set up a small per-
sonal Web site. The book makes good
reading for someone simply interested in
browsing through the lucidly written
guide explaining software like Netscape
Composer and Paint Shop Pro.

The first section of the book deals only
with established names, like Internet
Explorer and Google. There is a sporadic

mention of Netscape, chiefly the e-mail
program that comes bundled with it.
However, the section that is
meant for the Internet
rookie gives a thorough
run through of Win-
dows-based applica-
tions, so the orientation
is with the stuff 
that comes bundled
with Windows. 

On the other hand,
the section on site-
building makes very lit-
tle mention of either
Microsoft Front Page or
Dreamweaver. It talks at
length about Netscape
Composer, but not

Front Page Express, which is probably the
more widely available of the two! 

The book is useful for
elderly people; perhaps for
parents desperate to keep up
with their techno-savvy kids.
It does contain lots of simple,
conversational tips on how to
control and filter offensive
content off the Internet. It
puts the reader on guard over
tackling virii, while furnishing
tips on trading over the Net.
What the book lacks, though, is
depth. The small, shallow sec-
tion on Internet security too,
belies the bold red fonts declar-

ing viruses and hackers on the cover.
SUPROTIP GHOSH

Publisher: Pearson Education (Singapore) Pvt Ltd  ■■  Author: Carla Rose ■■  Distributor: Pearson Education India ■■  Phone: 011-2146067 ■■  E-mail:
info@pearsoned.co.in ■■  Web site: www.samspublishing.com  ■■  Price: Rs 350
Rating: ★★★★✩✩

SAMS Teach Yourself Internet and Web Basics:
All in One
Wading through the Internet

✩✩
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Who likes to work on a Satur-
day? Even the AC does a 5-day
week. Beyond 6:30 pm, not a

cubic metre of air is cooled. A mechani-
cal relic called a fan tries to pacify our
heated bodies, not to mention boiling
tempers. As a result, all the writers here
try all possible ways of scuttling away on
time and disappearing on weekends. But
then the copy desk hates to be left alone
and their “you-better-be-there-or-I'll-
hack-your-article” look more often than
not works in procuring the much-need-
ed company.

But amidst all this grumbling and
bickering, we did stand united over one
thing: fans. They were so few, at times
they would all disappear! Well, so we
decided that we needed to get some...
well, steal some.

We first stole right under the noses of
people, only to be reprimanded and
come back glum-faced. Then we got
defensive. We work the most, we do this
we do that blah blah blah... didn't work.
How would it? After all, those guys, too,
had cancelled their dates for a Saturday
and were boiling in silence! A few sweaty
days of introspection later, we were at it
again. Well, the need of the hour was
survival and that needed a fan. Ethics be
damned. And so we went on rampaging
mercilessly, and quite breathlessly 
as well.  

We didn’t spare a single bay. All of
them were ransacked in the spirit of
Menelaus seeking out Helen of Troy. Bar-
barians would have worshipped us had
they only seen our undaunting persua-
sion. We didn't even spare the bhaigiri-
doing Test Centre. 

“Yeh apun ka fan hai kya?”
Oh yes, it is your fan.
“Lene ka nahi, samjha na...”
Whoever thought of doing that... er,

at least when they are around. The
moment they’re out, their fans ARE ours.
After all, if they aren't submitting arti-
cles on time, they’d better make this
concession!

Recently, we got Mount Vesuvius to
erupt violently when we raided TypeI—
the content services division. And what
a raid that was! We never knew such
sleek fans existed just next door. We
fanned ourselves royally for a week.
Mitali oohed and aahed about it and
Garfield almost killed her with his “How-
dare-you-keep-it-all-to-yourself” look
when the secret was leaked, and the
TypeI guys raided us like a pack of FBI
agents. 

“Oh look, it’s ours.” 
“And how do you know that?” 
“See this red tape, I put it here.”  
But Prashant Narekuli, the Digit

brand manager, would just not give in:
“So what, naam thodi likha hai. Aise kaise
tum log aake fan le ja sakte ho” and
topped it with an arm-twisting look. 

The ‘FBI’ agents were far from
impressed. The fans did get smuggled
back into TypeI, the terrifying look
notwithstanding. This was just too much
to digest.

“Let's shift into the garden” exploded
one of the Digsters, “à la Shantiniketan.” 

“Oh yeah,” cooed in a colleague,

“that way we won't even miss the 
latest gossip!”

“That would be great. Perhaps we
could start an inhouse mag with all 
that stuff!” 

Now, much as we like to make an
issue about everything, Louis D’Mello,
Head of Publications and Web sites,
JDM, always tackles it all with some
resourceful thinking. Perhaps it was this,
or perhaps he was a bit wary of his own
fan disappearing, Louis did the best
thing he could do—within the next few
weeks, tall, lissome, translucent fan
stands began dotting the Digit bay.
While Aparna and Meera helped assem-
ble “their” own fan, the boys were a bit
more generous and set it up for the
entire team. Since then, the Sun has not
been cursed and the swish of a button is
all that’s needed to drive the heat away.

Of course, we miss the fan-hunt
(“Geez, it was so much fun!”). Of course,
we miss the planning and strategy that
went behind each of them (“Aaj TC, kal
NC!”), but what we don’t miss are the
sweaty palms and the discomfort. 

The heated arguments continue. 

Steal to Chill
Fans are hot property on the Digit premises

Mahesh Benkar
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a. HawkEye
b. Eagle Eye 
c. Hawk-I
d. Third Eye

Who created Wikipedia—
the online free encyclopaedia?
a. Larry Sanger and Ben Kovitz
b. Jimmy Wales and Larry Sanger
c. Jimmy Wales and Andre Giere
d. Andre Giere and Bill Gates

Which search engine uses 
the metasearch technology to
crawl other search engines? 
a. Dogpile
b. Longhorn

c. Teoma
d. Google

Ducati is one of the most 
successful bike manufacturers
in Super Bike championship
history. Name the recent
Hollywood blockbuster that
featured one of its bikes, the
Ducati 996.
a. Day After Tomorrow
b. Kill Bill
c. The Matrix Reloaded
d. Kill Bill 2

His summer job was 
recapping tires for a rubber
company for $1.50 an hour.
Later, he went on to work
with IBM and Xerox Corp
before founding a desktop
publishing company. Who is

this and what is his company
known as?
a. John Warnock, Adobe

b. Dr Micheal
Cowpland, Corel

c. John Walker,
AutoDesk

d. Paul Brainerd,
Aldus
Pagemaker

In January 1975, a 
programmer brought a
Popular Mechanics’
advertisement for a
microcomputer kit along with
an idea to his friend's college

dorm room. Their partnership
eventually evolved into the
world's most valuable
company. Name them. 
a. Bill Gates and Paul Allen,

Microsoft
b. Steve Jobs and Steve

Wozinack, Apple
c. Robert Noyce and Gordon

Moore, Intel
d. Bill Hewlett and Dave Packard,

HP 

The very first punched 
cards, before the computer
era, were originally used for…
a. Cash registers
b. Printing presses
c. Weaving looms
d. Punching tickets

Xerox founded the Palo 
Alto Research Center
(PARC), but which
company is best
known for designing
systems which used
concepts developed
there?
a. Sun Microsystems
b. IBM

c. Digital Equipment Co.
d. Digital Co.

The 1981 Pulitzer Prize  
winning book ‘The Soul of a
New Machine’ was written
about the development of which
“super minicomputer” system?
a. DEC’s VAX
b. Data General’s MV/8000
c. IBM’s S/360
d. Bell Labs’ Unix

In 1993, Apple Computers
reached a milestone for…
a. Shipping its 10 millionth Mac
b. Completing a decade in

computer business
c. A tie up with Disney for

animation movies
d. Its highest ever profit of $1.91

billion

In 1981, Wall Street
Journal ran a full page 
advertisement that said,
“Welcome IBM, seriously.”
Which company’s
advertisement was this?
a. Dell
b. Apple
c. CompuServe Inc.
d. Hewlett Packard

Which of the following 
browsers was developed 
using open source software?
a. Opera
b. Mozilla
c. IE
d. Netscape Navigator
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This month’s theme: Sci-Fi
Books and Authors

Across
3. Author of the ‘Foundation’

series
7. '20, 000 _______ Under

The Sea'
9. The colour of clockwork
10. The answer to Life, the

Universe and Everything

Down
1. A sinister doctor with a

penchant for bombs
2. Clarke's enigmatic

spacecraft
4. Protagonist of Orwell's ‘1984’
5. The Warof the Worlds: Earth versus__

6. Author of 'Brave New World'
8. ’Fahrenheit 451’

■ qubit
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In 1989, a trojan disguised as
an AIDS information program
was unleashed on the Web.
When run, it encrypted a user’s
hard drive and demanded pay-
ment for the decryption key

did you know

Got an interesting question? Send

it in with the correct answer to  

quiz@thinkdigit.com

numberette

Powered by

Apple spent $100
million, developing

LISA (Local Integrated

Software Architecture)—

the first PC with a

graphical user interface.

LISA was first sold for

$10,000

1 to 5 Way to go...

6 to 10 Good, if you like
being mediocre 

11 to15 Your next job could
be with us!

QUOTIENT

Quiz
1: a 2: b 3: a
4: d 5: c 6: a

7: a 8: c 9: c
10: b 11: a

12: b       13: b

Crossword
Across: Down:
3 Asimov      1 Strange Love
7 Leagues 2 Rama
9 Orange 4 Winston
10 Fourty 5 Mars

two 6 Huxley
8 Bradbury

Answers

What is the world’s most
advanced humanoid robot—a
Honda project titled Advanced
Step in Innovative Mobility better
known as? 

4

Name this technology: It was launched in 2001 and uses sophisticated
image-processing techniques to process the output of a series of cam-
eras positioned around a sports venue.

a. ASIIM b. ASIMA c. ASIM d. ASIMO
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